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Course Overview

About the Course. Ubuntu is a community developed Linux-based operating system freely available
and suitable for laptops, desktops and servers. This course is based on Ubuntu 8.04 LTS and aims to
train new users of Ubuntu how to use key applications including mainstream office applications, Internet
connectivity and browsing, graphics arts tools, multi-media and music.

Objectives

This course will teach you:

+ The concepts of open source and how they tie in with Ubuntu

+ The benefits of using Ubuntu

* How to customise the look and feel of the Ubuntu desktop

* How to navigate through the file system and search for files

* How to connect to and use the Internet

* How to perform basic word-processing and spreadsheet functions using OpenOffice.org
* How to Install and play games

* How to add, remove and update applications

* How to view, draw, manipulate and scan images

* How to play, edit and organize music and video files

» Where to seek help on Ubuntu from free and commercial sources

* How to create partitions and dual-boot options

Target Audience and Pre-requisites

This course provides both home and office users with hands on training on Ubuntu. No prior knowledge
of Ubuntu is required, although computer literacy is assumed and is a pre-requisite. Ubuntu 8.04 LTS must
be installed on the computer hard disk before starting this course.

The Ubuntu desktop course is designed to be modular. If studied in a classroom in its entirety, it should
be completed within two full days. However, topics and lessons can be selected as required and a day's
content designed to suit the key learning objectives.

Sample material for various exercises is available through the ubuntu-desktop-course-resources package.
The most current package is available through the canonical-training PPA (Personal Package Archive) in
Launchpad: https://launchpad.net/~canonical-training/+archive.

Instructor Notes:

The ubuntu-desktop-course-resource package should be installed on all systems before the course
starts. The sample files are placed in /usr/share/ubuntu-desktop-course. It is recommended to add
a link to the directory on the students desktop.
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Student Responsibilities

+ Students should arrive on time and stay until the session is dismissed. The instructor should be notified
if you expect to arrive late.

« Participation in class discussions is strongly encouraged. Even when some topics are already familiar
to some, sharing relevant experiences can be very helpful to other people.

+ Cell phones and pagers should be placed on silent mode during class.
* Feedback is vital to the improvement of our course development and delivery. All students must
complete the course evaluation form at the end of the last day in order to receive a certificate of

completion.

* Please provide any and all feedback regarding this course to: training@canonical.com.

Ubuntu Session Plan

Session Duration
(in minutes)

DAY 1
Welcome and Course Overview 20
Introducing Ubuntu 60

About Open Source

Free Software Movement, Open Source and Linux

About Ubuntu

Software Repositories and Categories

Key Differences between Ubuntu and Microsoft Windows

Lesson Summary

Review Exercise

Exploring the Ubuntu Desktop 75

Ubuntu Desktop Components

Changing the Default Language

Creating a User Account and Fast User Switching

Adding/Removing Applications

Desktop Effects - Compiz Fusion

Lesson Summary

Lab Exercise

Using the Internet 100

Connecting to and Using the Internet

Browsing the Web
Accessing RSS Feeds
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Sending and Receiving E-mail Messages

Instant Messaging

Making Phone Calls using Softphones

Review Exercise

Lab Exercise

Using OpenOffice Applications

180

Introducing the OpenOffice.org Suite

Using OpenOffice.org Writer

Using OpenOffice.org Calc

Using OpenOffice.org Impress

Using OpenOffice.org Draw

Using OpenOffice.org Math

Additional Applications

Lesson Summary

Review Exercise

Lab Exercise

Ubuntu and Games

40

Installing Ubuntu Games

Playing Ubuntu Games

Playing Other Popular Games

Lesson Summary

Lab Exercise

Session

Duration
(in minutes)
excl.
exercises

DAY 2

Customising the Desktop and Applications

80

Introduction

Customising the Desktop

The 3D Effects

Working with Files Using Nautilus

Adding and removing applications using Add/Remove and Synaptic
Package Manager

Installing a Single Package File

Software Repositories

Adding New Language Settings

Lesson Summary
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Session Duration
(in minutes)
excl.
exercises

DAY 2

Review Exercise

Lab Exercise

Making the Most of Images and Photos 60

Introducing Graphics Applications

The GIMP

Managing Photos with F-Spot

Drawing with Inkscape

Using a Scanner

Lesson Summary

Review Exercise

Lab Exercise

Playing Music and Videos 60

Legal Restrictions

Playing Music Files

Playing and Extracting Audio CDs

Burning Audio CDs

Playing Proprietary Multimedia Formats

Using an iPod

Creating and Editing Audio Files

Using DVDs

Playing Online Media

Editing Videos

Lesson Summary

Review Exercise

Lab Exercise

Ubuntu: Help and Support 60

Introduction

Free support resources

System documentation

Online Documentation

Community Support

Launchpad

The Fridge
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Paid for Commercial Services

Lesson Summary

Review Exercise

Partitioning and Booting - optional 60

What is Partitioning

Creating a Partition

Boot-up Options

Lesson Summary

Review Exercise

Lab Exercise

Course Summary

Instructor Responsibilities

Instructors are:

* Responsible for conducting classes professionally and ensuring that the classroom environment is
conducive to learning; this includes adhering to the schedule for start times, breaks, and lunches.

+ Available during lab sessions to answer questions and assist students in completing the exercises.
» Committed to delivering a positive learning experience for all students.

* Responsible for providing students with a course feedback questionnaire at the end of the course.

Pre-Training Preparation/Checks

+ Familiarise yourself with the student profile and expectations. Some elements of the course may need
to be customised.

* Pre-run and check all student and instructor computers and make sure they are functional and running
well on Ubuntu.

* Ensure you check the classroom set-up guide, test each lab exercise and troubleshoot problems
encountered, if any.

* Go through the Instructor Guide and the presentation slides in detail before getting into the classroom.

+ Students may not be able to answer all the questions based on the content in the presentation slides.
Please ensure to cover the related topics prior to posing the questions to the students.

« It is highly recommended that you teach each topic covered in the training material. However, if you
are running short of time, optional topics are indicated in the Instructor Notes of each lesson.

Instructional Methods

Here are some instructional methods that will be used to teach:

+ Slides and lecture: Slides will be used to explain concepts and also illustrate the step-by-step procedure
to perform each task.
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Demonstrations: Instructor will perform live demonstrations of procedures that may be complicated for
students, before doing a hands-on exercise.

Review questions: Should be interspersed throughout each lesson, to ensure student understanding of
key concepts.

Lab exercises: At regular intervals, students will be performing hands-on lab exercises that replicate
the real life scenarios.

Instructional Tips/Guidelines

Use conversational language that is easy to understand and sounds natural to the students.
Create a comfortable, relaxed environment throughout.

Be prompt with your responses to student queries. If you are not sure about anything, inform them and
get back with your response the next day.

Circulate around the room as students complete the exercise and reach out to students struggling with
the exercise.

Use technology (slides, demos, and guided lab exercises) in the most appropriate ways depending on
the audience profile and their comfort with Ubuntu.

Use presentation slides to stay on topic and avoid getting lost and cover the main points without
forgetting anything. Glance at a specific point and quickly return attention to the students. Avoid reading

out the slide word by word.

To encourage interactivity, use the lab exercises throughout the lesson.

Lecture Components

Each lecture can be divided in the following components.

Introduction

On the first day,

1. Welcome the students and introduce yourself followed by students introducing themselves - name,

professional background, and company, expectations and level of experience with Linux OS.

2. Clearly state the purpose and objectives of the training in general terms.

3. Establish the ground rules for breaks.

Context Setting

Use any/all of the following methods:

Giving out a brief introduction to the topic.
Explaining why the topic is important from learner's perspective.

Providing a link from the previous to the current topic.
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Main Body

You could use any or all of the Instructional methods listed above. However, depending on the student

profile and the complexity of the content piece to be taught, choose any combination of the above

mentioned methods. Using a wide range of teaching styles and methods is also a good instructional practice

as it brings in variety and breaks monotony.

» For complex topics, demonstrate the procedure and then have the students practice the lab exercise. If
the topic is fairly simple, put up the slides illustrating the procedure and have the students perform the
associated lab simultaneously.

+ Explain how and when to use each option on the interface.

Summary

Always summarize key points of the lesson: The lecture can be summarized by:

+ Asking for questions.

+ Asking questions.

» Using the Lesson Summary presentation slide, which highlight the main points.

+ Reiterating how the topic relates with the learner's job.
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Chapter 1. Introducing Ubuntu

Objectives

In this lesson, you will learn:

» The fundamental concepts of open source.

 The link between the Free Software Movement, open source and Linux
* How Ubuntu ties in with open source

* How Ubuntu is developed

+ About Ubuntu versions

+ The key differences between Ubuntu and Microsoft Windows

About Open Source

Instructor Notes:

The focus of this topic is to help students understand the concept of open source, which is the
underlying foundation of Ubuntu. Briefly explain the dictionary meaning of 'open source' in
general and move on to establishing how the open source ideology developed in the context
of Linux. Present this as a story spread over different phases: Free Software Movement, Open
Source Movement initiation and its formal launch. Explain the Ubuntu release schedule, naming
convention and Ubuntu promise in detail.

Ubuntu is a Linux-based open source operating system. The term 'open source' can be defined as a set
of principles and practices that promotes access to the design and production of goods and knowledge.
Open source is generally applied to the source code of software and is available to users with relaxed or
no intellectual property restrictions. This enables users to distribute, create and modify software content,
either individually to meet their specific requirement or collaboratively to improve the software. Both open
source and Linux have transitioned through various phases to reach their present form.

The idea behind openly distributed source code is to encourage the voluntary, collaborative development of
software. Users continuously enhance the software, fix bugs, develop new features and share it with others.

As a result of collaborative software development which involves a large number of programmers, users
receive software that is often better in quality and performance than proprietary alternatives. Users are
encouraged to customise the software to their own personal requirements, which in itself is a huge step
away from the 'one size fits all' philosophy.

Open source projects call on the talents of many people with skills other than programming. Many
projects involve artists, musicians, user-interface designers and documentation authors to create a complete
product.

Free Software Movement, Open Source and
Linux

There is often confusion between open source, free software and Linux. While all three are inter-linked,
there are distinct differences which are made clearer when looking at their evolution.
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The Free Software Movement

In the 1960s, it was typical for software to be distributed freely by companies such as IBM and shared
amongst users. Software was then considered an enabler for the hardware, around which the business
model of these corporations was built. Software was provided with source code that could be improved and
modified; this was therefore the very early seeds of open source software. However, as hardware became
cheaper and profit margins eroded in the 1970s, manufacturers looked to software to provide additional
revenue streams.

In September 1983, Richard Matthew Stallman, former programmer at the MIT Artificial Intelligence
Lab launched the GNU project to create a free UNIX-like operating system (OS). He was concerned with
growth in proprietary software and users' inability to access and modify programmes on their computers.
Developer constraint, as opposed to freedom was prevalent. With the launch of the GNU project, Stallman
started the Free Software Movement and in October 1985, set up the Free Software Foundation.

Stallman pioneered the definition and characteristics of open source software and the concept of copyleft.

He is the main author of several copyleft licenses, including the GNU General Public License (GPL),
which is the most widely used free software license.

Nice to Know:

For more information on Richard Stallman and the GNU project, refer to the following URL:
http://en.wikipedia.org/wiki/Richard_stallman.

By 1991, a number of GNU tools, including the powerful GNU compiler collection (GCC), had been
created. However, a free kernel was not yet available to build a free OS that would use these tools.

The Open Source Movement and Linux

The difference between free software and open source can be defined as the difference between a social
movement (free software) and a development methodology (open source). Linux refers to the kernel, or
the backbones of the open source architecture.

In August 1991, Linus Benedict Torvalds, a Finnish second-year student of computer science at the
University of Helsinki, started working on Minix.
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Figure 1.1. Linus Benedict Torvalds

Nice to Know:

Minix is a UNIX-like OS built with open source code that Prof. Andrew S. Tanenbaum created
with the intention to teach his students the internal processes of an OS.

Linux was initially designed to be a Minix-like operating system that Linus Torvalds could use on his
home computer. By mid-September, Torvalds released the first Linux kernel version 0.01. In 1994, Linux
kernel version 1.0 was released under the GNU GPL. The free kernel and GNU tools provided a fertile
environment for enthusiasts. By staying close to its UNIX roots, Linux provided a Command Line Interface
(CLI) first; the adaptation of the X Window System made a graphical user interface (GUI) available at
a later stage.

Nice to Know:

Linux is not owned by any individual or company, not even Linus Torvalds who started Linux.
However, Torvalds is heavily involved in the main kernel development process and owns the
trademark, Linux.

Linux open source code:

+ Is available and accessible to everyone

» Can be customised according to an individual's requirements and the platforms used
 Can be freely redistributed in its current or a modified form

Initially, Linux was a very technical, hard core open source programming tool. Thousands of developers
contributed to its evolution as it became more user friendly. This has resulted in the launch of hundreds of
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commercial and non-commercial distribution versions, designed for everyday application use which are
now available.

In 1998, Jon "maddog" Hall, Larry Augustin, Eric S. Raymond, Bruce Perens et al formally launched
the Open Source Movement. They promoted open source software exclusively on the basis of technical
excellence.

Figure 1.2. Founders of the Open Source Movement

The open source movement and the dot.com boom of the late 1990s coincided, resulting in the popularity
of Linux and the evolution of many open source friendly companies such as Corel (Corel Linux), Sun
Microsystems (OpenOffice.org) and IBM (OpenAFS). In the early 21st century when the dot.com crash
was at its peak, open source was in a prime position as a viable alternative to expensive proprietary
software. Its momentum has strengthened since with the availability of many easy to use applications.

As such, what started off as an idea became a passion to revolutionise a patent and license intense industry.
With a significantly cheaper return on investment and enhanced usability features, Linux is now rooted as
a viable option for enterprises and home users.

About Ubuntu

Instructor Notes:

The focus of this topic is to make the students understand the origins of Ubuntu, the development
cycle, version releases and the importance of community contributions towards its development.

Ubuntu is a community developed, Linux-based operating system that is perfect for laptops, desktops and
servers. It contains all the applications you need - including a Web browser, presentation, document and
spreadsheet software, instant messaging and much more.

Nice to Know:

Ubuntu is an African word meaning 'Humanity to others', or 'T am what I am because of who
we all are'.

The history of Ubuntu dates back to April 2004 when Mark Shuttleworth formed a group of open source
developers to create a new Linux OS.
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Figure 1.3. Mark Shuttleworth

Based on the principles of time-based releases, a strong Debian foundation, the GNOME desktop, and a
commitment to freedom, this group operated initially under the auspices of http://no-name-yet.com.

In a little over four years, Ubuntu has grown to a community of thousands of members and an estimated
user base of over 8 million (as at June 2007). Canonical is the commercial sponsor of Ubuntu.

Instructor Notes:

If the students are interested to know more about Mark Shuttleworth, present the following content
as a story.

Mark Shuttleworth is an African entrepreneur with a love for technology, innovation, change
and space flight. Shuttleworth studied finance and information technology at the University of
Cape Town and went on to found Thawte, a company specialising in digital certificates and
cryptography. He sold Thawte to the U.S. company VeriSign in 1999 and founded HBD Venture
Capital and the Shuttleworth Foundation. He moved to London in 2001 and began preparing for
the First African in Space mission, training in Star City, Russia and Khazakstan. In April 2002,
he became a space traveller as a member of the cosmonaut crew of Soyuz Mission TM34 to the
International Space Station. In early 2004, he founded the Ubuntu project, which aims to produce
a free, high-quality, user friendly OS available for everybody.

The Ubuntu Promise

Instructor Notes:

Stress on the Ubuntu promise because it holds the very essence of the spirit and success of the
software.

+ Ubuntu will always be free of charge, including enterprise releases and security updates.

+ Ubuntu comes with full commercial support from Canonical and hundreds of companies around the
world.
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+ Ubuntu includes the best translations and accessibility infrastructure that the free software community
has to offer.

+ Ubuntu CDs contain only free software applications; Ubuntu encourages you to use free and open source
software, improve it and pass it on.

Ubuntu Versions

In October 2004, Ubuntu released its first version. A new version of Ubuntu is released every six months
and upgrades to new releases are free of charge. Users are encouraged to upgrade with each new release in
order to enjoy the latest features and applications. Its versions are named using the Y.MM (name) scheme,
where Y indicates the year and MM refers to the month of release. The name in brackets is a code name
given to the version pre-release.

Each release is supported for 18 months; Long Term Support releases (LTS) are supported for 3 years on
the desktop and 5 years on the server.

Figure 1.4. Ubuntu Versions

Ubuntu 11.04
Ubuntu 10.10
10.04.1 10.04.4
Ubuntu 10.04 LTS
Ubuntu 9.10
Ubuntu 9.04
Ubuntu 8.10

8.04.1 8.04.4
Ubuntu 8.04 LTS

- LTS Desktop and Server |~ Standard Release - Point Release [ LTS Server

A brief history of releases:

* Ubuntu 4.10 (Warty Warthog). Ubuntu 4.10 was the first release of Ubuntu in October 2004;
supported until April 2006.
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Nice to Know:

The early testing community of version 4.10 was called the Sounder, named after the collective
noun for warthogs. The Sounder mailing list continues today as an open discussion forum for
the community.

* Ubuntu 5.04 (Hoary Hedgehog). Released in April 2005; supported until October 2006.
* Ubuntu 5.10 (Breezy Badger). Released in October 2005; supported until April 2007.

* Ubuntu 6.06 LTS (Dapper Drake). The first release with Long Term Support (LTS); it was released
in June 2006. Long-term support version refers to guaranteed three years of support on the desktop
and five years on the server. All other releases are provided with 18 month support for desktops and
servers. The extended support period provides reassurance and makes it easier and more practical for
large deployments of Ubuntu. Desktops supported until June 2009; servers supported until June 2011.

* Ubuntu 6.10 (Edgy Eft). Released in October 2006. This version guarantees a robust boot process;
supported until April 2007.

* Ubuntu 7.04 (Feisty Fawn). Released in April 2007. This version introduced significant
improvements to network roaming; supported until October 2008.

* Ubuntu 7.10 (Gutsy Gibbon). Released in October 2007. Key features include spectacular visual
effects by default, fast user switching, printer auto-detection and easier desktop file searching and
tracking; supported until April 2009.

* Ubuntu 8.04 LTS (Hardy Heron). Released in April 2008. Ubuntu 8.04 LTS forms the second Long
Term Support release of Ubuntu. Desktops will be supported until April 2011; servers supported until
April 2013.

e Ubuntu 8.10 (Intrepid Ibex). Released in October 2008. Ubuntu 8.10 includes hundreds of
improvements and full 3G support. This release will be supported until April 2010.

* Ubuntu 9.04 (Jaunty Jackalope). Releasadin April 2009. Ubuntu 9.04 is the latest cutting edge
Ubuntu release, bringing the Eucalyptus Cloud to the Ubuntu community. This release will be supported
until October 2010.

* Ubuntu 9.10 (Karmic Koala). Scheduled for release in October 2009, Ubuntu 9.10 will be the next
Ubuntu release. This release will be supported until April 2011.

Ubuntu Derivatives

Ubuntu is also available in several editions such as Ubuntu, Edubuntu, Kubuntu and Xubuntu. Edubuntu
is Ubuntu customised for the school environment. Kubuntu is an official derivative of Ubuntu based on
the work of the K Desktop project (KDE). KDE is a powerful graphical desktop environment, combining
ease of use and contemporary functionality. Xubuntu is intended for users with less-powerful computers
or those who seek a highly efficient desktop environment on faster systems.

Ubuntu Development and the Community

Ubuntu is a joint collaboration project comprised of Ubuntu community members all around the world.
Since its inception in 2004, thousands of contributors have joined the Ubuntu community. These users
contribute towards Ubuntu development through writing code, advocacy, artwork, translations, testing and
documentation (to name just a few). The development process of Ubuntu is open and transparent to all,
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whether you are a novice Ubuntu user or an experienced Ubuntu developer - everyone is welcome to get
involved with and improve Ubuntu. Canonical also employs developers to contribute to Ubuntu.

How you can get involved. The Ubuntu community is made of many individuals and teams who work
on different aspects of Ubuntu. If you are a developer, you can participate in the core development, write
new applications, package additional software and fix bugs. If you are an artist, you can add value to
the look and feel and functionality of Ubuntu. You can also provide online support, write documentation,
assist with training material, join Web forums and the mailing lists of Ubuntu. There are lots of ways to
get involved!

Developer Zone. The developer zone is comprised of developers who create and package software, fix
bugs and maintain Ubuntu. They are responsible for ensuring that Ubuntu has a wide catalogue of software
and it operates reliably and smoothly. A great way to get started as a packager is to join MOTU - see
https://wiki.ubuntu.com/MOTU/GettingStarted.

Idea Pool. If you have ideas for projects, proposals and enhancements but do not necessarily want to
implement them, you can add the ideas into the idea pool available at https://wiki.ubuntu.com/IdeaPool.

Technical Users. If you have the requisite technical skills, you can contribute to the Ubuntu community
in the following ways:

* Test the pre-release versions of Ubuntu to help find bugs before the final release.

* Report bugs and help the development team analyse them.

+ Triage (edit and categorise) bugs to read, assess and sort them before they can be fixed.
+ Join an e-mail support list or discussion list on the Ubuntu mailing lists.

+ Join Web forums and respond to requests.

+ Join the Ubuntu support and discussion Internet Relay Chat (IRC) channel, which is a form of real-
time Internet chat.

Non-Technical Users. Even if you do not have technical knowledge of Ubuntu, you can help Ubuntu
users through the following projects:

» Artwork and design

+ Translation and localisation

* Writing and updating documentation and training materials
* Advocacy

Ubuntu Desktop Course Development. Part of Canonical's mission is to enable the widest deployment
of Ubuntu on as many computers and servers, in as many corners of the world as possible. Training is
seen as a core enabler for the adoption of Ubuntu and as such courses are designed to certify Ubuntu
professionals, assist partners to deploy Ubuntu and show desktop users (such as yourselves) how to use
and get the most out of it. For more information on Ubuntu course availability and certifications, please
refer to http://www.ubuntu.com/training.

As with software development, the community contributes towards the development and enhancement of
this desktop course. As Ubuntu experts, the community defines the scope and structure of the training by
identifying requirements from the users' perspective; they also assist the Canonical and third-party content
writers in developing content and reviewing it. More information on the Ubuntu Training community effort
can be found at http://wiki.ubuntu.com/Training.
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The entire content development process is in the true spirit of Ubuntu's philosophy and the open source

tradition.

Ubuntu and Microsoft Windows: Key

Differences

Open source differs from the proprietary software model in that it:

* Encourages customisation and variation as opposed to a one size fits many approach.

* Relies on a 'services attached' business model rather than per license and seat basis.

+ Believes that the benefits of collaboration and multi-developer contribution outweigh those of controlled
project work of smaller, paid developer teams.

Table 1.1. Key Attributes

Attribute

Ubuntu

Microsoft Windows

Costs

Free of licensing charges

Charges per user license and/or for a
fixed term

Versions Released

Same version and features for home
and professional users

Six-monthly fully supported free
release

Separate Professional and Home
editions

Less frequent and less visible release
schedule

Can run different flavours of Ubuntu
in parallel

Security * Locked administrative user root » Enables easy access to administrative
user
+ Rarely targeted by malware and
viruses » Regularly targeted by malware and
viruses
Customisation + Easy to design and personalise + Standard OS with limited options to

personalise

Paid for additional applications

Data Storage

Easy to upgrade and downgrade
User data stored in home directory

Easy to migrate and replicate user data
and configuration to another computer

User data saved in multiple locations

Difficult to backup and migrate to
computer

Looking at each element outlined in the table in greater detail:

Associated Costs: The Microsoft Windows OS is proprietary and the overall price increases with added
functionality and applications. The associated price is sometimes a factor of using third party applications
and not just a Microsoft decision. With Ubuntu new release versions and applications are free.

New version releases: There is only one released version of Ubuntu and therefore features available

to home and professional users are the same. The Home and Professional editions of Microsoft Windows
are not the same. For example, Microsoft Windows Professional editions have more security features than
Home editions.
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Ubuntu's 6 monthly release cycle also makes it very easy for users to have access to all the latest
applications. An upgrade from one release to the next is free and fully supported. Microsoft scheduled
releases are less frequent and less visible to the public.

Security aspects: Ubuntu is rarely targeted by malware and viruses. The administrative user root is

locked by default in Ubuntu and only certain tasks are run with administrative privileges. Microsoft
Windows provides an environment where people can access administrative user directly.

Figure 1.5. Ubuntu Security

Customisation: As you will discover throughout this course, Ubuntu is yours to design and personalise.
You can have different flavours of Ubuntu running parallel; for example, you can install the Kubuntu
(KDE) desktop together with Ubuntu (GNOME) and then select the desktop environment you want to use.
More than 17,000 packages are available and easily accessible through the Internet. As a result, you are
not stuck with using one version because it was the first you installed.

Microsoft Windows is a standard OS with some options for customization. While many applications are
available, most are proprietary software which incur a license fee.

Figure 1.6. Desktop Customisation

Data Storage: User data is often located in multiple locations in Microsoft Windows, which can make
backing up and migrating from one computer to another tricky. Ubuntu saves your user information in one
place - the home directory. This makes the migration of data from an old computer to a new one easy, as
well as keeping user specific backup data separate.

10
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Installation

Table 1.2. Installation Differences

Installation Ubuntu Microsoft Windows

OS Installation * Freely downloadable from the Internet
or using a free CD

Purchase required

* OS must be installed on computer
+ Can be used directly from the live-CD | hard drive

Software * Huge variety of applications available Limited selection of software
Installation by default available by default

+ All freely downloadable from the Users can purchase and download
Internet some software online, others can only
be manually installed

* OS Installation: Both Microsoft Windows and Ubuntu come as pre-installed OSs on computers.
However, to install post-purchase, Ubuntu can be freely downloaded from the Internet or a free CD can
be requested. Any Microsoft Windows version will need to be purchased.

Ubuntu comes in live-CD mode which means you can use the OS directly from the CD without installing
it on a host computer. If you like what you see, install it. If you don't, pass it on to a friend. The live-
CD option is also useful for system recovery.

The installation of Microsoft Windows and Ubuntu is easy and conducted by running the installation CD
and booting the computer. Both installations vary in length according to how powerful your computer
is, with an average install taking 20 - 30 minutes.

+ Software Installation: You can add software on Ubuntu by using the Add/Remove Applications and
Synaptic Package Manager. The Add/Remove Applications allows you to search the entire directory of
free applications recommended for Ubuntu and install the ones you want. In Microsoft Windows, each
programme supplies its own installation method. Microsoft Vista has a Digital Locker feature enables
users to purchase software online and download it in a protected manner.

11
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Figure 1.7. Installing Software Applications
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(b Systern Tools .
o oY To perform advanced tasks use the Synaptic package manager.

@ Universal Access

Applications

The table below displays a comparison between Ubuntu and Microsoft Windows applications:

Table 1.3. Application Based Differences

Applications Ubuntu Microsoft Windows

Web browsing and |+ Firefox Web browser by default Internet Explorer Web browser by

E-mail default
* Evolution e-mail client by default

* Outlook e-mail client by default

Word Processing |+ OpenOffice.org suite * WordPad by default

Multimedia ¢ Includes Audio CD Extractor, Brasero, |* Includes Microsoft Windows Media
Rhythmbox, Movie Player and Sound Player 11 (WMP) and Microsoft
Recorder Windows Media Center (WMC)

Image Editing + F-Spot photo manager * Picture Gallery application

and Picture

Management * Gimp for image editing + Paint

Looking at each element outlined in the table in greater detail:
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Introducing Ubuntu

Networking, Web browsing and E-mail. Network setup on both Ubuntu and Microsoft Windows is
easy. Web browsing features are more or less the same on both OSs.

Mozilla Firefox is loaded as the default browser on Ubuntu, and Internet Explorer is the default browser
on Vista. You can also install Firefox on Microsoft Windows.

Evolution is the default e-mail client on Ubuntu. It connects to POP accounts, conventional UNIX
mailboxes and Exchange servers via Outlook Web Access. Evolution also has a built-in Personal
Information Manager (PIM) and a calendaring and appointment system. The Microsoft Windows Mail
application in Vista is a rewritten version of Outlook Express, with a stripped down calendar or appointment
application, Microsoft Windows Calendar. An upgrade to Outlook is suggested if you use the calendar
often or if you have a full PIM. Ubuntu users enjoy the out-of-the-box mail client setup facility.

Figure 1.8. Evolution E-mail Client

File Edit View Folder Message Search Help

a_| ¥ 2 % & 8 B8 @ ‘ :
New Send / Receive Reply Reply to All - Forward Print Delete Junk Mot Junk Cancel
@ Inbox Ltotal Show: | All Messages S Search: [ & subject or Sender conte | | Current Folder | &
= On This Computer Llelel : Erom - | SUF’JE‘t | Date J
& inb I The Evolution Team <evolution@no... Welcome to Evolution! 14 Mar 5:30 PM |
nbox
i3 Deleted Items
& Drafts
0 Junk
& outbox
& sent From: The Evolution Team <evelution@novell.com>

To: Evolution Users <evolution@novell.com>
Subject: Welcome to Evolution!
Dale: 14 Maich 2007 12:00.00 +0000 (17.30 /5T)

= Search Folders

&3 Unmatched

* The Evolution Team is proud to welcome you to Evolution, a complete system (‘\

for managing your communications and personal information.

‘ Mail \ i

——— Getting Started

‘ a Contacts ‘ ©On the left of the Evolution window is the side bar, with shortcuts to all your mail folders. Below that, you will find I
buttons for your calendars, contacts, tasks, mail and memos.

‘ E} Calendars ‘ For a complete guide to using Evolution, select Table of Contents in the Help menu, or press the F1 kay.

‘ [ memos ‘ New Features

T Evolution 2.10 brings you

\ E Tasks ‘ © Integration with gtk-print

e © Customnizable fetching of IMAP headers I~

==

Word Processing: The OpenOffice.org suite is installed on Ubuntu by default and provides many

features of Microsoft Office. Vista comes with WordPad by default; the full version of Microsoft Word (or

Office) for Microsoft Windows, is available at an additional cost.
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Figure 1.9. OpenOffice.org Writer

File Edit View Insert Format Table Tools Window Help x
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the apples with butter or margarine and sprinkle the whiskey/vanilla on tap.

12 .

L

I
age2 /2 Default 100% |INSRT [ STD [HYP [* 3 0.00/0.00 i 6.93 x 4.62

o

Multimedia: Several multimedia programmes are configured by default on Ubuntu, such as Audio
CD Extractor, Brasero Disc Burning, Rhythmbox Music Player, Movie Player and Sound Recorder.
Rhythmbox is the default application for playing audio CDs and organising music and playlists.
Rhythmbox is similiar to Microsoft Windows Media Player. You can use Brasero to author audio CDs.

To play the mp3 format on Ubuntu, you need to install a codec pack. This is because Ubuntu is not
distributed with mp3 codecs due to licensing restrictions. Playback of mp3 files is enabled by default on
some versions of Microsoft Windows.

Vista has two multimedia programmes, Windows Media Player 11 (WMP for short) and Windows Media
Center (WMC for short). WMP is best for playing music, and WMC is useful if you are using the computer
as your core entertainment system. WMP can contain a large music library. With the index search system
of WMP, you can search music numbers by a particular artist or search for specific numbers.

Image Editing and Picture Management: With the Picture Gallery application of Microsoft Vista, you

can upload thousands of images and add tags. You can also organise the images quickly and work on them
easily because you can tag them with one click. F-Spot photo manager organises your personal photos on
Ubuntu. It integrates seamlessly with popular Web based image databases, such as Flickr and Picasa Web.

Ubuntu provides GIMP for image editing which is a powerful Photoshop-like application. Microsoft
Windows Vista provides 'Paint' for basic image editing.
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Figure 1.10. GIMP

& GIMP = [o][x
file Xtns Help

VICE
o)

‘px = H 100% =+ |=Background (2.87 MB)

Lesson Summary

In this lesson, you learned:

+ The fundamental concepts of open source

+ The link between the Free Software Movement, open source and Linux
* How Ubuntu ties in with open source

* How Ubuntu is developed

* The Ubuntu version naming conventions

+ The key differences between Ubuntu and Microsoft Windows

Review Exercise

Instructor Notes:

If you are running short of time, administer this exercise when Exploring the Ubuntu Desktop in
Chapter 2, Exploring the Ubuntu Desktop.

Question: What is meant by the term free software?

Answer: Quoting the Free Software Foundation's 'What is Free Software', the freedoms at the core of
free software are defined as:

* The freedom to run the programme, for any purpose.
* The freedom to study how the programme works and adapt it to your needs.
* The freedom to redistribute copies so you can help others.

* The freedom to improve the programme and release your improvements to the public, so that everyone
benefits.
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Question: What is the Ubuntu promise?

Answer: The Ubuntu promise is:
» Ubuntu will always be free of charge, including enterprise releases and security updates.

+ Ubuntu comes with full commercial support from Canonical and hundreds of companies around the
world.

+ Ubuntu includes the best translations and accessibility infrastructure that the open source community
has to offer.

» Ubuntu CDs contain only open source applications; Ubuntu encourages you to use free and open source
software, improve it and pass it on.

Question: Match the Ubuntu versions with the years in which they were released.

1) 7.04 a) June 2006
2)4.10 b) October 2007
3) 6.06 c) April 2007
4)7.10 d) October 2004
Answer:

1) 7.04 ¢) April 2007
2)4.10 d) October 2004
3) 6.06 a) June 2006
4)7.10 b) October 2007

Question: List 3 ways in which non-technical users can contribute towards the development of Ubuntu.

Answer: The three ways in which non-technical users can contribute towards Ubuntu development are
artwork, translation and localisation and document solutions.

Question: The default web browser on Ubuntu is

Answer: The default web browser on Ubuntu is Mozilla Firefox.

Question: The default e-mail client on Ubuntu is

Answer: The default e-mail client on Ubuntu is Evolution.
Question: What are the advantages of Ubuntu 6 monthly releases?

Answer: Quicker upgrade and availability of new applications, as well as improved functionality.
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Chapter 2. Exploring the Ubuntu
Desktop

Objectives

In this lesson, you will learn:

 The highlights of Ubuntu desktop

* How to change the default language

* How to create a new user account and take advantage of user switching
* To add and remove applications

* How to enable 3D Desktop effects

Instructor Notes:

All the topics in this lesson are mandatory. To familiarise the students with the basic features of
the new desktop, this lesson should primarily be a hands on session.

This section serves as a quick tour of the Ubuntu desktop. The course will go into more detail in later
lessons, but this will give you a taste of what's ahead.

Ubuntu Desktop Components

Instructor Notes:

Highlight the fact that unlike other operating systems, Ubuntu comes with a completely clean
desktop, by default. Users are free to add icons and files on the desktop according to their
preferences.

GNOME is the default desktop environment for Ubuntu. GNOME (GNU Network Object Model
Environment) is an international effort to build a complete desktop environment—the graphical user
interface, which sits on top of a computer operating system—entirely from free software. This goal includes
creating software development frameworks, selecting application software for the desktop and working on
the programmes which manage application launching, file handling and window and task management.
Community members worldwide contribute to the translation and accessibility of the desktop in multiple
languages. (Reference: http://en.wikipedia.org/wiki/GNOME)

Key Desktop Components on Ubuntu. When you start your computer, the first screen displayed on

Ubuntu is the logon screen, where you type your user name and password. The next screen displayed is
the Ubuntu desktop. Ubuntu comes with a completely clean desktop background, free of icons by default.

Instructor Notes:

Ensure that you browse through each element very quickly because more details will be covered
in the subsequent lessons.
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Exploring the Ubuntu Desktop

Figure 2.1. Default Ubuntu Desktop

| Wed Dee 17, 7:19 PM il Wiliam windsor

": Applications Places System &@e

You can arrange icons and files on the desktop to access them quickly. If a CD, hard disk or any other
external device is connected to your computer, Ubuntu automatically displays its icon on the desktop to
allow easy access to the device.

Figure 2.2. Desktop Icons

q Applications  Places System i@e

At the top and bottom of the desktop are two bars, called panels.
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Figure 2.3. Desktop Panels

": Applications Places System i@e

| Wed Dee 17, 7:19 PM il Wiliam windsor

There are three main menus in the left pane of the top panel: Applications, Places and System.

+ Applications: This menu contains all the applications installed on your computer such as games,
music players, Web browsers and e-mail clients.

Figure 2.4. The Application Menu

Applications  Places System C@e
E“b Accessories
[} Games 3
‘fi Graphics 3
@ Internet r
@ office 3

r 4
1 Programming 3

m Sound & Video  »

@ Add/Remove...

+ Places: This menu provides access to your home directory, external devices and network on your
computer.
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Figure 2.5. The Places Menu

-Q Applications  Places System e@o
Ea Home Folder

H Desktop

[E5) Documents

[ Music
[E5) Pictures

[E5 Vvideos

; Computer
(%) cojovD creator
— HP

_| FACTORY_IMAGE

;E Network

t, Connect to Server..,

; Search for Files...

Recent Documents

Note:

The Home directory is created by default for every user and automatically takes the username.
It contains all user-specific files. In a multi-user system, every user stores personal data in a
sub-directory of this directory.

+ System: This menu enables you to change the computer settings. You can also access the Ubuntu
help system and turn off your computer here.

Figure 2.6. The System Menu

-5:,? Applications Places System e@e

g preferences 3

(o0 Administration  »
e

0 Help and Support

e

[ ] About GNOME

-53_ About Ubuntu

E Quit...

By default, there are three shortcut icons next to the menus on the top panel: Mozilla Firefox, Evolution
and Help. You can create additional shortcuts to any applications and place them here for quick access.

Figure 2.7. The Shortcut Icons

43 Applications Places System) W wed Dec 17, 7:23PM [§] g William Windsar

Procedure 2.1. To add a new shortcut icon to the desktop panel:

1. Right-click the blank area of the top panel and click Add to Panel. The Add to Panel dialogue box
appears.
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Figure 2.8. Adding a Shortcut Icon

il Wed Dec 17, 7:27 PM ] william windsor

-ﬁj_ Applications  Places System e@ e

=p Add to Panel...
[ Properties
i@ Delete This Panel

| & New Panel

@ Help
€ About Panels

2.  The Add to Panel dialogue box displays a list of applications available on your computer. Select
an application and click Add to add it to the blank area of the desktop. If you want to launch the
programmes available on the Applications menu, click Application Launcher.

Note:

Alternatively, you can drag an application icon from the Add to Panel dialogue box and drop
the icon on the panel to create a short cut to the application.

Figure 2.9. Adding Application Launchers

E Addito Pane

Find an item to add to the panel: [ ]

....... Custom Application Launcher

® Create a new launcher

~..- Application Launcher..

=] Copy a launcher from the applications menu =
a= Address Book Search

Search for a person in your address book

| Battery Charge Monitor
Lj Maonitor a laptop's remaining power

Brightness Applet
Adjusts Laptop panel brightness

Character Palette
Insert characters

Clipboard Text Encryption
Encrypt, decrypt or sign the clipboard {uses PGP type encryption).

X
Clock
Get the current time and date
(]

" % Connect to Server...

-

@

3. The applications grouped in a category similar to the Applications menu appears. Select an
application from the available list, and click Add.
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Figure 2.10. Selecting Applications

m Addto Panel el I

Find an jtemn to add to the panel: [ ]

b 1 | Accessories
Desktop accessories
b o Games
Games and amusements

Graphics
Graphics applications

Office

P
a2
b 7 Internet
@’ Pragrams for Internet access such as web and email
i[l]_ Office Applications

I'd
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&0
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l &3 Back H =F Add H Eglose
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The icon of the selected application will be displayed on the blank area of the top panel.

Figure 2.11. Adding Application Launchers

[0 Addto Panel [ i3 I

Find an jtem to add to the panel: [ l

b 1 } Accessories
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You can change the location of the newly created shortcut icon by right-clicking it and selecting Move.
Move the icon anywhere on the top panel and left-click the icon to freeze its location.

Figure 2.12. Moving Shortcut Icons

A
Launch

i Properties

= Remowve From Panel

Mowe

Lock To Panel

Next to the blank area on the top panel (where you can create short cuts of the application) is the fast user
switch icon. This icon shows the current user of your computer. You can click the icon to view other users
on the computer and switch to another user.

Note:
You will learn more about fast user switching in the Fast User Switching topic of this lesson.

Figure 2.13. The Fast User Switch Icon

3 Applications  Places system (@] @ H wed Dec 17, 7:53PM [B] f) william windsor

|User Switcher

Charles Windsor

The System tray contains the network and sound icons for quick access to network and sound settings. You
can check the network configuration of the computer and adjust the volume of your computer's speaker.

The current date and time is displayed next to the System tray. If you click the date and time, a calendar
is displayed.

The last icon on the top panel shuts down, restarts, hibernates, locks your computer and places it on standby.

Figure 2.14. Top Panel Icons

i wed Dec 17, 7:35 PM al] William Windsor I

Click to view your appointments and tasks

The first icon on the bottom panel provides quick access to the desktop. If multiple windows are open
on your desktop and you would like to minimise all of them together, click this icon. Clicking again will
display your windows in their original state, before you minimised them.
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Figure 2.15. Show the Desktop

&l ]

Next to the icon used to minimise the windows is a blank area in which the list of open application windows
appears, similar to the taskbar in Windows. When you open an application, it's listed on this area for easy
access, as shown in the bottom panel of the following screen:

Figure 2.16. Open Applications

@ - [Documents - File Br... | =5 [Chess]

The next icon, workspace, enables you to split the windows that are open on your desktop into multiple
workspaces. You can then navigate among the workspaces by pressing and holding down the CTRL+ALT
keys, and then pressing either the left or the right arrow key. This reduces the clutter on your desktop and
eases navigation between windows.

For example, you might have the Firefox window, an OpenOffice application, a search window and a
calculator window open on the desktop.

Figure 2.17. The Workspace Icon

-14 Applications Places System @2 @ i wed Dec 17, 7:38 PM [§]  gl] William Windsor
Welcome to Ubuntu B.04 LTS! - Mozilla Firefox \;l\l/

Eﬂle Edit View History Bookmarks Tools Help

=) - & ol e, | Calcaator =)o)
Calculator Edit View Help

[ Most Visited ~ @ Getting Started Latest

Bksp CE clr =
e e I ]
Googl : : : : Ubuntu S

200 et Ubuntu Support

cogle J L 2 2 . tumped by a problem? Find out how to g¢
Welcome to Ubuntu 8.04 | [ o . - + | pe

The Ubuntu project is built on the ideas enshri Activated expression mode with operato... buntu Merchandise

that software should be lable free of charge: w=——lake your friends jealous! Show off the lat,
usable by people in their local language, and that pecple should have the Ubuntu gear.

freedom to customize and alter their software in whatever way they need.

Get Involved with Ubuntu
{‘ Ubuntu is also a community with limitliess
opportunities to join in.

Getting Help with Ubuntu:

There are many ways to get help with Ubuntu.
;  Ubuntu Forums

Access Ubunlu's guides and documentation by selecting "Help” from your L Get help, learn what's new and join the
System menu. You can also find help from the official Ubuntu documentation discussions
website and the community contributed documentation.

g

Done

1) [@ welcome to Ubuntu ... ][l calculator & [Tracker Search Tool]

You can move the Firefox window to a separate workspace by pressing and holding down the CTRL+ALT
+SHIFT keys and then pressing the left or the right arrow key. Two workspaces will be displayed in the
bottom-right corner of the desktop - one workspace with the Firefox window and the original workspace
with the other windows.
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Figure 2.18. Switching Workspaces
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Get Involved with Ubuntu
Geﬂing Help with Ubuntu: #‘ Ubuntu is also a community with limitless
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There are many ways to get help with Ubuntu.
i Ubuntu Forums
Access Ubuntu's guides and documentation by selecting "Help" from your Get help, learn what's new and join the
Syslem menu. You can also find help from the official Ubuntu documentation discussions
website and the community contributed documentation. -
4] D)
Done
e
@ @ welcome to Ubuntu ... o4 ﬂ@]

Now, you have two separate workspaces. Notice that the Firefox window has shifted to the original
workspace. So, depending on the task you perform, you can split the windows into different workspaces.

Figure 2.19. Splitting Windows into Workspaces

Q Applications Places Systemn e@e & Wed Dec 17, 7:40 PM @ ] William Windsor

Tracker Search Tool

= Calculator 1 i3

Calculater Edit View Help

(s ) e Jer J (=]
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[ | e |
(I | e [

Activated expression mode with operato...

@ B calculator B Tracker Search Tool O @]

By default, Ubuntu provides two workspaces. If you want to split the windows into more workspaces,
you have to add the workspace to the desktop by right-clicking the workspace icon and then clicking
Preferences. The Workspace Switcher Preferences dialogue box appears.
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Figure 2.20. Creating New Workspaces

| Preferences
@ Help

(£ Get Help Online...
‘1 Translate This Application...
! Report a Problem

€ About

= Remowve From Panel

v Lock To Panel

BN G

In the Workspace Switcher Preferences dialogue box, type or select the number of workspaces from the
Number of workspaces list and click Close.

Figure 2.21. Workspace Switcher Preferences

lall " WoTKspace SWitcher Pref: ==

Workspaces

Columns:
s (1

The specified number of workspaces will be displayed in the bottom-right corner of the desktop.

The last icon in the bottom panel is the Waste basket. It contains the files you deleted from your computer.
Right-click the icon and click Open to open the Trash window.
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Figure 2.22. The Waste Basket Icon and Menu
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You can delete an item permanently from the computer by pressing the DELETE key.

Note:

Alternatively, you can right-click the item and click Delete from Trash to permanently delete
it from the computer.

If you want to restore the deleted item to the desktop, drag that item to the desktop from the Trash window.

Figure 2.23. Deleting Items from Trash
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Changing the Default Language

Ubuntu supports more than 100 languages. You can set the default language of your computer either during
the installation of Ubuntu or at a later stage.

To change the default language during the installation, select the required language when prompted.
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Procedure 2.2. To change the default language at a later stage:

2.

3.

On the System menu, point to Administration and click Language Support. The system prompts
support if updates are available for your selected language.

you to install language

Figure 2.24. Configuring Language Support
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38 Windows Wireless Drivers

Click Install to continu

e. On completing the updates, the Language Support dialogue box opens.

Figure 2.25. Installing Language Support Updates
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(=]

In the Language Support dialogue box, from the Supported Languages section, select the check

box for the language you want to use for support functions in Ubuntu.
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Figure 2.26. Installing Default Language Support
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Click Apply and then click OK. Ubuntu downloads and installs the necessary packages on your
computer. The language you selected will now appear in the Default Language box.

Select the language that you want set as default, and click OK.

For the changes to take effect, log off and then log on again.
Nice to Know:
You can change the language as many times as you would like and this can depend on your

location. For example, changing the language to Russian may be a nice touch when presenting
in Russia during a business trip.

Creating a User Account and Fast User
Switching

Instructor Notes:

Advise students that to understand the concept of fast user switching, they need to have more
than one user account on their computer. Walk the students through creating a new user on their
computer, and then move on to the concept of fast user switching.

You may have multiple users who want to access your system. In this case, there is a risk of data being
manipulated or corrupted by other users. To prevent this from happening, you can create user accounts for
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each individual who wants to use your computer, giving each user an individual account with personalised
user settings. For example, it is useful to give children their own accounts on the computer to prevent then
from changing your settings or accessing unsuitable files and applications..

Procedure 2.3. To create a new user account on Ubuntu:

1. On the System menu, point to Administration and click Users and Groups. The User settings
dialogue box appears.

Figure 2.27. Adding/Removing Users
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2. Inthe User settings dialogue box, click Add User to add a new user account on your computer. The
New user account dialogue box opens.

Figure 2.28. Adding a User

Users setrings

Name Login name Home di [ .Jl]z. Add User ]
. root root jroot ‘

! charleswindsor charleswindsor /home/c ‘

3. Specify the user accounts' basic settings, contact information and password information in the New
user account dialogue box.

a. Type the name with which you want to log on to your computer in the Username box.
b. Type your full name in the Real name box.
c.  Select your user type from the Profile box.

d. Type your office location in the Office location box.
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4.

e. Type your work phone number in the Work phone box.

f.  Type your home phone number in the Home phone box.

g. Type the password for your user account in the User password box.

Note:

This information is for record keeping only, and other users cannot view it.

Click Close to save the settings.

Figure 2.29. Configuring New User Account

NEW USETN dCCour

Account ‘ User Privileges } Advanced \

Basic Settings

Username: [charleswindsor ]

Beal name: [Charles Windsar ]

Profile: [Desl-ctop user = ]

Contact Information

Office location: [ ]

Work phone: [ ]

Home phone: [ ]

Password

® Set password by hand

User password: [.....l.l ]

Confirmation: [.....'l. ]

() Generate random password

Password set to:

| ogancel

(&=

A new user account will be displayed in the User settings dialogue box. This dialogue box displays
the new user's full name and login name. It also tells you the location of the new user account created.
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Figure 2.30. The New User Account
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Now, if you click the fast user switch icon, there will be two users displayed and the current user logged
on to the computer will be marked.

Figure 2.31. Switching Users

QApplicatiuns. Places System @@e

i wed Dec 17, 7:53 PM il William windsor

- Belinfuser Switcher,

': Charles Windsor

(=)

] L]

This feature prevents you from logging off and logging on all the time to switch users. It allows multiple
users to switch quickly while staying logged on. By simply clicking the fast user switching icon, a list of
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the user names appears. Select the user name and you will be directed to the logon screen. Type the user
name and password, and you will be on a desktop of the new user. When you switch to another user, the
previous user screen is locked by default, so the other person cannot make any profile changes.

Adding/Removing Applications

Instructor Notes:

Advise students that you will cover this topic in detail while teaching the Customising Ubuntu
and Applications lesson of this course. This topic is just an introduction.

Tell the students that you will cover this topic in detail while teaching the Customising the
Desktop and Application lesson of this course. This topic is just an introduction.

Use the Add/Remove applications when you need to:

+ Use software not provided as a default application on Ubuntu.

+ Try an alternative application to the one already installed

Ubuntu contains pre-loaded software that you can easily install on your computer when required. You

can install this software by using the Add/Remove application or the Synaptic Package Manager utility of
Ubuntu. To access the Add/Remove application, on the Applications menu, click Add/Remove.

Figure 2.32. Launching Add/Remove Applications
iEApplicatinns Places System @@e

[l Accessories

@4 Wed Dec 17, 7:54 PM Ei] dif] William windsor

[ Games

A Graphics
o) Internst
iﬁ" office 3
o Programming

B0 sound & video  »

@ Add/Remove...

Install and remove applications

To access Synaptic Package Manager, on the System menu, point to Administration and click Synaptic
Package Manager.
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Figure 2.33. Launching Synaptic Package Manager
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Synaptic offers an advanced way of installing packages. If you do not find a software programme in the
Add/Remove tool, you can search for it in Synaptic. It searches all software in the available repositories
on Ubuntu.

Desktop Effects - Compiz Fusion

Instructor Notes:

Advise students that to view desktop effects, computers must have a 3D-enabled graphic card.

Compiz Fusion is a 3D window manager that makes use of 3D accelerated graphics cards found today
on many desktops and laptops. It provides a number of visual effects that makes the Linux desktop more
powerful and intuitive, as well as easier and more fun to use. For example, you can place workspaces on
a cube, which enables you to move from one workspace to another easily.

Compiz Fusion is enabled by default on Ubuntu 8.04 LTS with appropriate graphics cards. It enables the

3D desktop visual effects that improve the usability and visual appeal of the system. You really have to
see and play with this application to appreciate the benefits.

Procedure 2.4. To view the visual effects on Ubuntu:

1. On the System menu, point to Preferences and click Appearance. The Appearance Preferences
dialogue box appears.
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Figure 2.34. Opening the Appearance Preferences Dialogue Box
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2. Inthe Appearance Preferences dialogue box, there are three pre-configured levels of special effects
settings: No effects, Normal effects and Extra effects. You can select any one of them:

Figure 2.35. Configuring Visual Effects

il Appearance Preferences

Theme } Background I Fonts } Interface | Visual Effects |

None: Provides a simple

O @ desktop environment without

any effects.

Normal: Provides improved usability and
[C] \ good balance between attractiveness and
moderate performance requirements.

Extra: Provides more assthetically pleasing set
@]
of effects. Requires faster graphics card.

If you want a simple desktop without any special effects, select None. If you want a desktop with a balance
of attractiveness and average performance, select Normal. If you want various desktop effects, such as
wobbly windows, desktop cube and many more, select Extra. For example, while you are waiting for an
update to complete or an e-mail client to import e-mail messages, you can turn on the Wobbly effect. The
windows will start dancing and displaying the 3D effects. Play with it a little, it's fun!
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Lesson Summary

In this lesson, you learned that:
+ Ubuntu utilises the GNOME desktop by default

* You can set the default language of your computer either during the installation of Ubuntu or at a later
stage

+ Fast user switching enables you to share your computer with other users without sharing your files

* You can install software by using the Add/Remove application or the Synaptic Package Manager utility
of Ubuntu

* Compiz Fusion is enabled by default on Ubuntu 8.04 LTS and provides fun, 3D desktop visual effects

Review Exercise

Question: At the top and bottom of the desktop, you have two bars, called

Answer: At the top and bottom of the desktop, you have two bars, called panels.
Question: Which are the three shortcut icons already present on the top panel?
Answer: Mozilla Firefox, Evolution e-mail client and Ubuntu help.

Question: What is fast user switching?

Answer: Fast user switching is a feature that avoids you having to log off and log on all the time to
switch users. It enables multiple users to switch quickly while staying

Lab Exercise

Exercise: You have bank-related information on your computer and want to block others' access to it.
Your friend wants to use your computer for some time. To handle this situation, create a new user account
for your friend and use the fast user switch feature.

1. On the System menu, point to Administration and click Users and Groups. The User settings
dialogue box opens.

2. In the User settings dialogue box, click Add User. The New user account dialogue box appears.
3. In the dialogue box, specify the following information:
1. Type charles in the Username box.
2. Select Desktop user from the Profile box.
a. Type charles windsor in the Real name box.
b. Type England in the Office location box.
c. Type 111111 in the Work phone box.

d. Type 99999 in the Home phone box.
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e. Type password@1 in the User password box.

f.  Click Close to save the settings.
4. Click the fast user switch icon on the top panel. Click charles. The logon screen appears.
5. Type charles in the Username box and password@1 in the Password box.
6. Your friend can now work on this desktop.

Your friend cannot access your user account because the computer will ask for your password to log on
to the account. So, your personal data is safe.
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Objectives

In this lesson, you will learn to:

+ Connect to the Internet

* Browse the Web

* Use an RSS newsreader

* Send and receive e-mail messages
 Use various tools for instant messaging

* Make phone calls using Softphones

Instructor Notes:

It is recommended to cover all the topics in this lesson. However, if you are running short on time,
you can omit the following optional topics: Using Dial-up, Alternative E-mail Client.

Connecting to and Using the Internet

The Internet is used by millions of people daily for work and entertainment. Searching for information all
over the world, corresponding with friends and relatives, participating in discussion forums, reading the
news, playing games, has never been easier... or more accessible.

The means of connecting to the Internet is not always a choice and depends greatly on where you live and/
or work and the surrounding infrastructure. The pre-requisites to connect to the Internet are an Internet
Service Provider (ISP) subscription and a functional Internet connection in your area. Configuring the
Internet connection requires minimal involvement from you. Ubuntu supports most connection types. This
lesson will cover: Broadband (cable or ASDL), dial-up and direct access through Local Area Network
(LAN).

Broadband connections are fast and reliable connections that users subscribe to for a monthly fee.
Broadband companies offer packages with different speed specifications and bandwidth limits. If you
travel and need Internet access, you can purchase a wireless Internet connection. If your computer does
not have one pre-installed, you will need to install a wireless card. This connection is similar to a satellite
connection, where data is transmitted through the airwaves.

Dial-up access uses the same lines as your phone connection, except that the parties at the two ends are
computers. This is a slow and cheap connection that uses a phone line to connect to a local server. Your
computer dials a phone number that is provided by your ISP and connects to the server. Consequently, you
cannot make phone calls while you are connected to the Internet. This is the oldest and slowest means of
connecting; carrying out many functions using this mode can be very tedious and frustrating.

Network Manager

The Network Manager on Ubuntu is a simple to use and powerful utility to stay connected with wired
and wireless adapters. It is located on the top menubar at the outer right corner. A left-click will reveal
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if your computer is already connected to a wired or wireless network. In case of a wireless network that
is protected by a password, a dialogue will appear and ask for the password. The password can then be
stored in your keyring, where it will automatically be used when needed. However, you may be asked for
your keyring password if you have to log out.

Figure 3.1. Network Manager
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Connect to Other Wireless Network...

Create New Wireless Network...

Connect to 802.1X Protected Wired Network...

Manual configuration...

You can also right-click on Network Manager to enable and disable wireless and wired connections. The
connection information allows access to the network parameters currently used.

Figure 3.2. Network Manager Connection

| Sat Dec 20, 4:15pm [B] @  william indsor

+ Enable Networking
+ Enable Wireless

@ Connection Information
|5 Edit Wireless Metworks. ..

© About

If Network Manager does not automatically configure your network connections, you can fall back to
manually configuring them.

Using a Cable Connection

Procedure 3.1. To connect to the Internet using a cable connection:

1. On the System menu, point to Administration and click Network. The Network Settings dialogue
box will be displayed.
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4.

Figure 3.3. Accessing Network Settings
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Click on the Unlock button and enter your Administrator's password.

On the Connections page, select the connection to use. Click Properties. The eth0 Properties

dialogue box will be displayed.

Figure 3.4. Network Settings
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Clear the Enable roaming mode check box to enable the connection.
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Note:

Most broadband providers will use Dynamic Host Control Protocol (DHCP) to provide you

with an IP address. If a Static IP address is required, it will be provided by your network
administrator. The following steps are for setting up a static IP address.

a. Inthe Configuration box, select the Static IP address option.
b. Type the IP address of your computer in the IP address box.
c.  Type the subnetwork (subnet) mask of your computer's IP address in the Subnet mask box.
Note:
A subnet mask divides a network of IP addresses into groups, which facilitates routing
of data.
d.

Type the IP address of your ISP in the Gateway address box.

Note:

A gateway is a device that connects a user to the Internet. It is provided by the ISP.

Figure 3.5. eth0 Properties
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EEY

=
thlon: __ ) :l

[ Enable roaming mode

s

ogancel "‘ﬂ oK l

5. Click OK to complete the configuration for the cable connection.
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If your internet provider uses DHCP (Dynamic Host Connection Protocol) you simply need to select
Automatic Configuration (DHCP) from the Configuration drop down menu.

Figure 3.6. Network Settings
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Now, you can connect to the Internet by using the cable.

Using a Wireless Card

Ubuntu automatically detects support for various wireless cards.

Procedure 3.2. To determine whether Ubuntu supports the wireless card on your

computer:

1.

On the System menu, point to Administration and then click Network. The Network Settings

dialogue box will be displayed.

If the wireless card on your computer is listed, you can use the same procedure as listed in the Using

Cable Connection section to connect to the Internet.
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Figure 3.7. Choosing a Wireless Connection
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Alternatively, left-click on Network Manager and discover any detected wireless networks in range.

Nice to Know:

To view the complete list of wireless cards that work with Ubuntu, refer to: https://
help.ubuntu.com/community/WifiDocs/WirelessCardsSupported.

Some wireless cards are not listed on the Ubuntu Web site because open source drivers for these are not
available. Therefore, these cards do not work automatically with Ubuntu. If your wireless network card
does not have an open source driver, you can make it work by using ndiswrapper.

Using Ndiswrapper with a Wireless Card. Ndiswrapper is a Linux module that allows Ubuntu to
use Microsoft Windows drivers for wireless cards. The utility to configure ndiswrapper can be installed

comfortably via Add/Remove Applications. The Windows Wireless Drivers setup programme can be
found in System Administration.

Using a Dial-up Connection

A dial-up connection uses a modem to connect to the Internet. You can use the ScanModem tool to
identify the type of modem. This tool recognises the type of modem-whether it is a Peripheral Component
Interconnect (PCI) or a Universal Serial Bus (USB) modem.

Nice to Know:

To download the ScanModem tool, refer to: https://help.ubuntu.com/community/
DialupModemHowto/ScanModem.

Procedure 3.3. To use a dial-up connection:

1. Download, configure and install your modem's driver. If an open source driver is not available, contact
your vendor for other options.

Note:

To download the open source driver, refer to www.modemdriver.com.
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2.

Configure the dial-up connection to your ISP:

d.

On the System menu, point to Administration and click Network. The Network Settings
dialogue box will be displayed.

In the Network Settings dialogue box, select Modem connection and click Properties. The
pppO0 Properties dialogue box will be displayed.

Figure 3.8. Network Settings
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In the ppp0 Properties dialogue box, select the Enable this connection check box to activate
the connection.

Specify your ISP's information and your account information, which you can obtain form your
ISP.

Type the phone number in the Phone number and the dial prefix in the Dial prefix box, which
the modem uses to connect to the server. Type your dial-up account name in the Username box
and the password in the Password box. The user name is the one that is registered with your ISP.

Specify the modem setting on the Modem tabbed page. Click the Modem tab. Type or select the
modem port in the Modem port box. Select the dial type from the Dial type box. You can select
the types of phone dial used in the Dial type box. Dial type depends on your phone company
and may be Tones or Pulses. If you do not know which dial type to choose, contact your phone
company. Irrespective of the dial type, the modem will make some noise while connecting to
the ISP server. You can set the volume of this noise by selecting the appropriate volume options
from the Volume box-it is recommended that you select Off or Low.

Specify the connection settings. Click the Options tab and select the Set modem as default
route to Internet check box to specify the dial-up modem as the default Internet connection.
If you use a laptop on a local area network (LAN), clear the Set modem as default route to
Internet check box. Select this option only if you use a dial-up connection.

As part of modem connection settings, you need to assign a host name to an IP node to identify
it as a TCP/IP host. You can select your ISP server for this name resolution of hosts, which maps
a host name to an IP address successfully. For this, select the Use the Internet service provider
nameservers check box.

If the Internet connection breaks, your modem will automatically try reconnecting to the Internet
if the Retry if the connection breaks or fails to start check box is selected.
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g. Click OK to complete the dial-up configuration.

Figure 3.9. pppo Properties
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Now, you can connect to the Internet using a dial-up connection.

Instructor Notes:

If students need to connect to the Internet with the modem integrated into a mobile phone or
configure Point-to-Point (PPP) dial-up through a Bluetooth-compatible mobile phone, refer to:
https://help.ubuntu.com/community/BluetoothDialup.

To connect to the Internet through a mobile phone over a USB cable, refer to: https://
help.ubuntu.com/community/CableDialup.

Browsing the Web

Mozilla Firefox is the default web browser on Ubuntu. It is open sourced, developed by the Mozilla
Corporation and many external contributors and is fully compatible with Ubuntu. To open a Firefox Web
browser, on the Applications menu, point to Internet and click Firefox Web Browser.
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Figure 3.10. Launching Firefox Web Browser
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Firefox includes two powerful features that make your online experience more productive - an integrated
search system and bookmarking.

Instructor Notes:

Ask students to open this browser and try performing a search.

Integrated Search. This feature enables you to search for and find any information. The Search bar
comes pre-loaded with search engines for Google, Yahoo!, Amazon, eBay, Answers.com and Creative
Commons. You can enter a search term in the Search bar and receive immediate answers from the search
engine you choose. You can select a new search engine from the Search bar menu at any time and add
search engines from favourite Web sites.
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Figure 3.11. Available Search Engines
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Search Suggestions. To further ease your search-related tasks, some search engines such as Google,
Yahoo and Answers.com in Firefox, suggest search terms. Begin typing into the Search bar and a list of
suggestions will appear.

For example, if you type king in the Search bar, a list of suggestions to complete your search keyword
is displayed. So instead of typing the complete term, you can select the required term from the list. This
makes the search easy and quick.

The following graphic shows a list of suggestions, when you start typing in the Search bar:
Figure 3.12. List of Suggestions
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Bookmarks. If you come across an interesting Web site over the Internet and would like to keep it for
future reference, without trying to remember the URL, create a bookmark. The next time you are online,
simply click the link to go to that Web page. You can view Web feeds such as news and blog headlines
in the bookmarks toolbar or menu. A Web feed or feed is an XML Web page that contains a list of links
to other Web pages. You can quickly review the latest headlines from your favourite sites and click to go
directly to chapters of interest.
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Note:

A Bookmark in Firefox, similar to favourites in Internet Explorer, is a useful browser feature.

Procedure 3.4. To create a bookmark in Firefox:
1. Open the Firefox Web browser. On the Bookmarks menu, click on Bookmark this page.

2. The Bookmarks dialog box will appear. Select a location to save the new bookmark and add any tags
(keywords).

3. Click Done to save your bookmark.

To sort your bookmarks and create new folders, or categories, select Organize Bookmarks from the
Bookmarks menu.

Using an RSS feed reader

News feeds allow you to see when a Web site has added new content. You can get the latest headlines as
soon as it is published without having to visit the website. These news feeds are known as RSS or Really
Simple Syndication.

Liferea Newsreader

Instructor Notes:

While teaching, demonstrate how to access Liferea.

Liferea is an online RSS feed reader. It is a fast, easy-to-use and easy-to-install news accumulator for
GTK/GNOME.

Note:

You can install Liferea on Ubuntu using the Synaptic Package Manager by following the
procedure described in Using Alternative E-Mail Client section.

The Web sites that offer RSS feeds display an RSS feed symbol next to its URL.
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Figure 3.13. Identifying RSS Feed Providing Web Sites
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Accessing Liferea

Note:

You have to search the Web site that offers RSS feeds to access Liferea. Look through the complete
list of newsgroups on your server to search for the group that interests you.

Procedure 3.5. To access Liferea:

1. Open the Web page that offers RSS feeds.
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Figure 3.14. Opening RSS Feed Web Page
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2. On this Web page, search for the link that offers RSS feed. Click the link and save the URL of that
link. This URL will be the feed.

Figure 3.15. Searching the Link
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3. Open Liferea. On the Applications menu, point to Internet and click Liferea Feed Reader.
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Figure 3.16. Launching Liferea Feed Reader
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To subscribe to the feed, right-click anywhere on the left-pane of the Liferea window, point to New
and click New Subscription. The New Subscription dialogue box will be displayed.
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Figure 3.17. Subscribing to RSS Feeds
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" Mark All As Read
Mew * New Subscription... en Source
W Delete MNew Folder...
[ Properties... Mew Segarch Falder...
JA TuxMob... | New source...
E3 Unread (254) ‘g L MNew News Bin...

== 254 unread

In the New Subscription dialogue box, paste the URL, which is the feed, and click OK. You will
see a new feed in the Liferea window.

Figure 3.18. Entering Feed Source

5

Feed Source

Enter a website location to use feed autodiscovery
orin case you know it the exact feed location.

[http:ereds.feedburner.comfubuntu-fridge l

l Advanced... l i (‘ﬂQK ]

l ogancel

The following graphic shows the new feed in Liferea.
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Figure 3.19. Viewing New Feeds

&
il

LiTeres

Subscriptions  Feed

b

=~ &5 International...
=~ &) Open Sou...
< Planet ...
3 The Ub...
€ art.gno...
‘€ Gnome...
% GNOME...
D GrokLa...
[€ Linux.c...
M The Fri...
= mozilla...
[.d Newsfo...
€ Planet ...
#» Slashd...
A TuxMob...

ltern View Tools

@ &

Mew Subscription... Mext Unread ltem Mark As Read Update All Search All Feeds...

Date
Wed 08:54 PM
Wed 08:43 PM
S5un 04:05 PM
Dec 11 02:13 PM
Dec 07 09:38 PM
Nov 30 04:31 PM
[&] Now 25 04:43 PM

Feed: The Fridge - Mews for Human Beings

Search Help

¢ Y )

«  Headline
Ubuntu Global Bug Jam 20-22 ...
Ubuntu on Amazon EC2 Beta ...
Ubuntu Weekly Newsletter #1...
4000 Attendees at French Tea...
Ubuntu Weekly Newsletter #1...
Ubuntu Weekly Newsletter #1...

Ubuntu Free Culture Showcas... |17

Source: http:ffeeds feedburner.com/ubuntu-fridge

== "The Fridge - News for Human Beings" updated...

264 unread (10 new)

Procedure 3.6. The key features of Liferea are as follows:

1. Liferea Feed Reader has multiple RSS subscriptions by default.

2. If you do not want a chapter to be deleted after some time, you can flag it and tag it as an important

item.

3. You can use the search function to search through the downloaded items to quickly access the

information needed.

4.  You can also use an online search engine to search for additional news.

Instructor Notes:

The change in feeds properties is required if it needs HTTP authentication or other feed specific

options.

Sending and Receiving E-Mail Messages

Evolution is the default e-mail client for Ubuntu. It combines mail, calendar and tasks in one powerful

application.
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Using Evolution Mail

Instructor Notes:

The focus of this section is to configure Evolution e-mail client with Post Office Protocol (POP) as
the sending server. If the students want to learn more, they can refer to: https://help.ubuntu.com/
community/EmailClients.

Procedure 3.7. To configure the Evolution e-mail client on Ubuntu:

1. On the Applications menu, point to Internet and click Evelution Mail.

Figure 3.20. Launching Evolution Mail

-----

|§_,_¥ Accessories »
[x}) Games v
_‘i Graphics »
@- Internet » @ Ekiga Softphone
@l office v Q Evolution Mail

’ Pragramming 3 e Firefox Web Browser

ﬁ Sound & Video  » D Liferea Feed Reader
a Mozilla Thunderbird Mail/News

@. Add/Remove...
ﬁ Pidgin Internet Messenger

@ Remote Desktop Viewer
% Terminal Server Client

@ Transmission BitTorrent Client

Nice to Know:

The .evolution directory is created in the home directory when you run Evolution for the
first time. It saves its local data in this directory. Then, it opens a first-run assistant to help
you set up the e-mail accounts. User specific settings for evolution are also stored in .gconf/
apps/evolution.

The Evolution Setup Assistant is displayed and guides you through various steps to enable Evolution
to connect to your e-mail accounts and import files from other applications. Click Forward.
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Figure 3.21. Configuring New E-mail Account

EVoIUtion SetupiASSiStant =

‘Welcome to Evelution. The next few screens will allow
Evolution to connect to your e-mail accounts, and to import
files from other applications.

Please click the "Forward" button to continue.

I ogancel

[ Back l l ﬂEorward‘

Evolution offers an integrated backup system. If you migrate your Evolution data from one system to
another, use this dialogue. On the Restore from backup page, you can restore the backup files such
as, e-mails, memos, address book, personal files and many more from your older version of Evolution.

Figure 3.22. Restoring Evolution

EVolat o SeripASE stant

Restore from backup

You can restore Evolution from your backup. It can restore all the Mails, Calendars, Tasks, Memos, Centacts.
It also restores all your personal settings, mail filters etc.

[[] Restore Evolution from the backup file

Please select an Evolution Archive to restore: (None) |

I ogancel ] [ &a Back l l ﬁEorward‘
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3. Onthe Identity page, type your full name in the Full Name box and your e-mail address in the E-mail
Address box. This is the e-mail address that your ISP provides. Your Evolution account is configured
with this information. Click Forward.

Figure 3.23. Setting up Account Identity

& EVOIUtion Setup ASSISTant:

(=
B3

Please enter your name and email address below. The
"gptional® fields below do not need to be filled in,
unless you wish to include this infermation in email
you send.

Required Information

Full Mame: Iwillwam windsor ]

Email Address; Iwwindsorll@gma\\.com ]

Optional Information

™ Make this my default account

Reply-To: l ]

Organization: [ ]

[ ogancel

I &a Back l IQEurward]

Note:

You can skip the information in the Optional Information section. You are required to type
the information in the Reply-To and Organisation boxes, only if you want to include this in
the e-mail messages you send. In Reply-To box, you can type your name, favourite quotes
or any other information and, in the Organisation box, type any name such as that of your
organisation, school or college.

4. On the Receiving E-mail page, in the Server Type box select the type of server your ISP provides.
Evolution is compatible with numerous server types, but POP is commonly used to receive e-mail
messages.
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Figure 3.24. Selecting Server Type for Receiving E-Mail

®

=3

o

&

& wolition Setup Assistan =
Receiving E-mail
Please select among the following options
Server Jype: lNone =
Description:
[ ogancel ] [ ¢aBack ] i & Forward I
Note:

If you do not know the server information, you should contact your system administrator
or ISP.

Select POP from the Server Type box to connect to and download mail from POP servers. The
Receiving E-mail page will further prompt you for the configuration information.

Note:

For more information about server types, refer to: https://help.ubuntu.com/community/
EmailClients.

Type the receiving e-mail server name in the Server box and your account user name in the

Username box. This is not your login name to your PC but your login name to your ISP's e-
mail account.

In the Security section, you can select Encryption or No encryption in the Use Secure

Connection box. Encryption makes the message unreadable by anyone other than the intended
recipient.

Select Password in the Authentication Type box or click Check for Supported Types to have
Evolution check for supported authentication types. The crossed out authentication types are not
supported. Generally, the password is the way you authenticate with the server.
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Note:

Contact your system administrator or ISP to know about the authentication type
supported.

e. Click Forward.

Figure 3.25. Providing POP Server Information

Evolotion Setup ASSIStant

Please select among the following opticns

Server Type: [POP : l

Description:  For connecting to and dewnloading mail from POP servers.

Configuration

severt | |

Username; [wwmdsorll ]

Security

Use Secure Connection: | No encryption | ¥

Authentication Type

Password : l l Check for Supported Types l

[ Remember password

l ogancel

l & Back l| Forward

On the Receiving Options page , select the following options, if required:

a. To automatically check e-mail messages after a particular interval of time, select Automatically
check for new mail every check box. Specify the duration of the interval in the minutes list.

b. In the Message storage section, select Leave message on server check box , if you want to
leave a message on the server.

c. Select Disable support for all POP3 extensions check box, if you want to disable POP3.

d. Click Forward.
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Figure 3.26. Specifying Mail Checking and Storage Options

& EVOIUTi oN SeLUPYASS| Stant =

Receiving Options

Checking for New Mail

] Automatically check for new mail every a minutes

Message storage

[] Leave messages on server

] Delete after day(s)

[] Disable support for all POP3 extensions

I ogancel [ & Back l l ﬂEorwardI

6. On the Sending E-mail page, specify the information according to the way you want to send e-mail
messages. Select the outbound mail server in the Server Type box.

a. There are two methods you can use to send e-mail messages, SMTP and Programmes Send
Mails. SMTP is the common method that is used to send e-mail messages. Select SMTP as your

outbound mail server type in the Server Type box.

b.  Specify the outbound server configuration:
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Figure 3.27. Providing SMTP Server Information

EVOIOLion SeLUp ASSIStant

Please enter information about the way you
will send mail. if you are not sure, ask your
system administrator or Internet Service
Provider.

-

Server Jype: | SMTP =

Description:  For delivering mail by connecting to a
remote mailhub using SMTP.

Server Configuration

Server:

Server requires authentication

Security

Use Secure Connection: | No encryption ¥

Authentication

Type: [PLA\N .

[Chgck for Supported Types

Username: [wwindsorll

[] Remember password

[ ogancel l I = Back ] | Eon .'1I'-|‘

i.  Type the host address in the Server box. This is the address of the outbound server that
your ISP provides.

ii. Specify how you want the server to authenticate. Select Server requires authentication
check box, if your server requires authentication. You will be asked to select your
authentication type in the Type box. You can also click Check for Supported Types to
have evolution check for supported types.

iii. Type the evolution account user name in the Username box.

iv. Select Remember Password check box, if you want evolution to remember your password.
Then, click Forward. The Account Management page is displayed.

7. It is possible for Evolution to access multiple e-mail providers. To differentiate between them, you
can give each e-mail provider a name. Type a name for this configuration or your account in the Name
box. You can type any name you prefer as this is only for your reference. Then, click Forward.
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Figure 3.28. Providing Account Information

- ot cot Rt =
Evolution SeLuprASsIstant ]

Account Management

Please enter a descriptive name for this account in the

space below.
This name will be used for display purposes only.

Account Information
Type the name by which you would like to refer to this account.
For example: "work" or "Personal"

Name: |Work

l ¢aBack l [ﬁﬁorward]

I ogance\

8. On the Timezone page, select the time zone you are in, either on the map or from the Selection list.
Click Forward.
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Figure 3.29. Specifying Timezone

Use the right mouse butten to zoom out.

¥

Time Zones

Use the left mouse button to zoom in on an area of the map and select a time zone.

Selection

Europe/London

[ ogance\

[ &= Back l | ﬂEorward‘

9.

Figure 3.30. Evolution

Configuration is done. Click Apply to save your settings. The Evolution window will be displayed.

Toolbar: Quickly access the most

used features in each component Message List: List of e-mail

messages received

Menu bar: Access many
evolution features

file Edit View Folder Message Search Help

Search Tool: Search your e-mail
messages, contacts, calendars and
tasks easily

= On This C

B, @ =] 5 & ® O /3
New Send / Receive Reply  ReplytoAll Forward Print ete junk  Notjunk  Cancel
& Inbox Ltotal Show: [ All Messages 5 / searchi[[ & subject or sender cont i [ current Folder

> Inbox

i@ Deleted items
Folder list: List of available

& Drafts
folders for each account

[~ Search Folders
&5 Unmatched

Status bar: View the

From Subject Date
The Evolution Tearm <evolution@no... Welcome to Evolution! 14 Mar 5:30 PM

From: The Evolution Team
To: Evolution Users <evolution@novell.com>
Subject: Welcome to Evolution!
Date: 14 March 2007 12:00:00 +0000 (17:30 IST)

progress of a task

Mail

4 contacts
[5] calendars
[ Memos
&) Tesks

il

Preview pane: View the content of

> The Evolution Team is proud to welcome you to Eveolution, a complete system {"

for managing your communications and personal information. L

Getting Started
On the left of the Evolution window is the side bar, with shortcuts to all your mail folders. Below that, you will find
buttens for yeur calerdars, contacts, tasks, mail and memos.

For a complete guide to using Evolution, select Table of Contents in the Help menu, or press the F1 key.

New Features
Evolution 2.10 brings you
© Integration with gtk-print
O Customizable fetching of IMAP headers

e-mail that are
in the e-mail messages list
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Note:

For more information on how to use the Evolution e-mail client, refer to: https://
help.ubuntu.com/8.04/internet/C/email.html.

Using an Alternative E-Mail Client

In addition to Evolution, you can use many other e-mail clients, such as Mozilla Thunderbird, Balsa and
Pine. If you have been using the Mozilla Suite, you may prefer to use Thunderbird which is very similar. Try
them both and see which you prefer. Mozilla Thunderbird is an e-mail application developed by Mozilla
Foundation. It is a free, cross-platform e-mail and news application.

Nice to Know:

Mozilla Suite is a cohesive collection of integrated Internet applications, including a Web browser,
e-mail and newsgroup client, Internet Relay Chat (IRC) chat client, address book organizer and
Web page creation utility.

The Thunderbird e-mail application is available in the Universe repository and can be installed on your
computer from the Synaptic Package Manager.

Procedure 3.8. To install Thunderbird on Ubuntu, perform the following steps:

1. Onthe System menu, point to Administration and select Synaptic Package Manager. The Synaptic
Package Manager window will be displayed.

Figure 3.31. Launching Synaptic Package Manager

-‘{j Applications Places Systemn & 9 )il Sat Dec 20, 4:48 PM |
% Preferences »

(oy Administration " RJ.S Authorizations

@ Help and ﬁ Hardware Drivers
Help and Support

Tl

[4
Q About Ubuntu

Quit...

[ . j Hardware Testing
ou

W Language Support
@ Login Window
% Netwark

"1 Network Tools

™8 Partition Editor

HJ Printing

s Services

@ Software Sources

@ Synaptic Package Manager
]_ﬂ Systermn Log Install, remove and upgrade software packages

Systern Monitor
@ Time and Date

% Update Manager

2. Inthe Synaptic Package Manager dialogue box, you can select the package you need. The left pane
lists the categories, and the right pane lists the packages. You can search for the package by clicking
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Search and specifying its name. If you do not know the name of the package, select the category
in the left pane to filter the list of packages. You can then select the check box next to the required

package in the right pane.

Nice to Know:

If you want to view the installed and uninstalled packages, click Status. To know the source
repository of the package, click Origin. Click Custom Filters if you want to know whether
a package is broken or can be upgraded.

Click Search. The Find dialogue box opens. Type the name of the package, Thunderbird, in the
Search field and click Search. The Mozilla Thunderbird package displays in the right pane of the

Synaptic Package Manager window.

Figure 3.32. Searching Thunderbird

Communicaticn (unive S15resolution

b
File Edit Package Settings Help
Reload  Mark All Upgrades
All s Package
Amateur Radio (univer O 2veard
Base System L0 3270-common
Base System irestrict | 3dchess
Base System (univers O  adigits
Communicaticn O 498
Communicaticn (mult O  stunnel
O

Cross Platform —_
Cross Platform (multiv —
Cross Platform (univer
Development

Development [multive
Development [restrict

Development [univers

Dhn s s b i ko

E——
P —

Search Results

Synaptic Package Manager

&

Search

Installed Version

Latest Version Size
0.5-1ubuntu3
3.3.4p6-33

0.8.1-12
(&5

[%e Rind|

Search: [Thunderb rd

|-

Look in: | Description and Name | 3 |

:|

Description

A little perl script to convert an addre| |

Common files for IBM 3270 emulators
3D chess for X11

A guess-the-number game, aka Bulls
Packet Capture and Interception for S
TCP proxy for non-IPvé applications

resolution madification toal for Intel g

Mo package is selected.

|. ogancel [L;-‘gearchl ‘

23132 packages listed, 1158 installed, 0 broken. 0 to installjupgrade, 0 to remove

[E] [ # synaptic Package Ma... |

(4]

Note:

To return to the list of categories after searching the packages using Search, click Sections.

Select the Mark for Installation check box to install the package.
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Figure 3.33. Marking Thunderbird for Installation

Synaphic Package Manager,

File Edit Package Settings Help

< ) e}

Reload  Mark All Upgrades Prepertics Scarch

All S Package Installed versien | Latest \Wersion Size Description e

e [0 lightning-extension-locale-pl 0.5-0ubuntuz Polish language package for lightning|—
[0  mail-notification 4.1.dfsg.1-2ubuntu: mail notification in system tray =
[0 mozila-imagezoom 0.3-lubuntul Mozilla context menu optien to zoom
[+ mnzilla-thundsrhired 2.0.0.64+nobinonly-t Transition package for mozilla-thunde
i 0.7.3-2ubuntuz2 BiDirectional support for Icadove
[ Mark for InsLallation 2.0.0.64+nobinonly-t Transition package for mozilla-thunde
i 2:0.95.0-0ubuntud Transitional package for enigmail =

I [v]

underbird rename 2
zilla-thunderbird

[ Properties

1 nece the thunderbird

package has been installed.

i

Sections
Status
Origin

Custom Alters

Search Results

|61 packages listed, 1158 installed, 0 broken, 0 to installiupgrade, 0 to remove ]

The package that you choose to install may depend on other packages. In this case, you are notified
about the dependencies. To continue making the changes required to resolve the dependencies, click
Mark.

To confirm that you want to make the marked changes, click Apply.

Figure 3.34. Confirming Changes

Apply the following changes?
This is your last opportunity to look through the list

of marked changes before they are applied.

P To be installed

summary

2 new packages will be installed

32.9 MB of extra space will be used
11.0 MB hawve to be downloaded

] Download package files only

l ogancel

[Gan)
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The Summary dialogue box opens, prompting you for a final check before making the marked
changes. Click Apply to continue with the changes.

This completes the procedure of installing Thunderbird by using Synaptic Package Manager. To
access Thunderbird, on the Applications menu, point to Internet and click Mezilla Thunderbird
Mail/News.

This displays the Thunderbird window.
Figure 3.35. Launching Mozilla Thunderbird Mail/News

QApplications Places Systeme 9

[iyy Accessories 3
(v} Games ,
‘4"1 Graphics 3
@ Internet 'I @ Ekiga Softphone

@ Office 3 Q Evolution Mail
;:" Programming 3 & Firefox Web Browser
ﬁ Sound & Video *» D Liferea Feed Reader

Q Mozilla Thunderbird MailfMews
- —

Readrite Mail/News with Mozilla Thunderbird

@ Add/Remove...

ﬁ Pidgin Internet Messenger

@ Remote Desktop Viewer

% Terminal Server Client

@ Transmission BitTorrent Client
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Figure 3.36. Thunderbird Window

Inbox forwwindson i l@gmailxeom = hunderbird

File Edit View Go Message Calendar Tools Help
ff: < / o . = - 0. 3‘( ‘ b
Get Mail Write  Address Book Today Pane | Feply  Reply all Forward | Tag Delete  Junl Print Bacl
All Folders o Hil g I Subject |ﬁ| Sender IM | Date '|ﬂ
# Ed Local Folders
E 57 Gmail - wwindsorll
=7 Inbox
~f] Trash
-
Welcome to Thunderbird!f
Mozilla’s Thunderbird email 5
application is more powerful than
ever. It’s now even easier to
organize, secure and customize your
mail. -
| Experience the difference. Thunderbird is
ta developed and supported by Mozilla, a
Mail Calendar ) ) -
global cormmunity working together to B
|,,| | Unread: 0 | Total: 0

Features of Thunderbird. Thunderbird features many enhancements to help you better manage your
inbox, send emails and organise your correspondence.

Some of its key features are:

* Stop Junk Mail. If you are tired of spam and annoying advertising in your Inbox, Mozilla
Thunderbird provides effective tools for detecting junk mail. These tools analyse your e-mail message
and identify those that are most likely to be junk. Your junk mail can be automatically deleted or placed
in a specific folder.
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Figure 3.37. Stopping Junk Mail

File Edit Wiew Go Message Tools Help

+*

r;.f_:
Get Mail

Write  Address Boo!
All Folders v ||'B

1= 4 Local Folders
= Inbox
~ Unsent
1 Deleted

&

Address Book Ctrl+2 »
Add-ons X 6J P

- [ #2_ Subject or Sender ]

elete Not]unk Print

Message Filters... | L] | Date < ‘ EF-“

|5& | Sender
Bun Filters on Folder - fy 11:22
Run Junk Mail Cantrols on Folder

Delete Mail Marked as Junk in Folder

Import..

Error Console

Thunderbird thinks this message is junk.

= Subject: hello :-)

Procedure 3.9. To activate the junk mail filters in Thunderbird:

1. Onthe Tools menu, click Junk Mail Controls. The Junk Mail Controls window will be displayed.

2. Click the Adaptive
click OK

Filter tab. Select the Enable adaptive junk mail detection check box and

+ Customise your mail. You have three column views to access you e-mail messages: Classic, Wide

and Vertical view.

Figure 3.38. Customising the E-mail View

File Edit Wiew Go Message Tools Help

- Toclbars
- |
Get Mail el
Fold
All Folde _ F2€"®
=3 Locall  Sort by
&7 Inb¢  Threads
A+ Lnsg
/ Dre Headers

1 Del Message Body As
« Display Attachme

Text Size

Character Fneoding »

Message Source

Message Security

o I T B | g
* Classic View b
b O Wide View

y O Vertical View

» |  Message Pane F8

nts Inline

Ctrl+uU
Info
= Subject: hello :-)

* Built-in Spell Checker. To check for correct spelling, click Spell on the toolbar.
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Figure 3.39. Spell Checker

7 CopOEeT EEE

File Edit View Insert Format Options Tools Help

50 %, 4.8 K,

Send | Contacts Spell Attach  Security Save

From: l - Work Account =
T To: | 2= charleswindsor@hotmail.com

Subject: [H”

[BodyText = I\/ar\ab\erdth = !_ ATA B I U = i€ =

Hello Charles!
How aer yuo?

* Security. Thunderbird provides enhanced security features, which is equivalent to enterprise and
government-grade security. It offers built-in support for Secure/Multipurpose Internet Mail Extensions
(S/MIME) secure e-mail message.

+ Extensions. Extensions are powerful tools to help you build a mail client that meets your specific
needs. Mozilla Thunderbird has several features, such as quick search, a smart address book, advanced
message filtering and more.

* News Reader. Mozilla Thunderbird makes it easier to subscribe to your favourite newsgroups,
downloading headers and messages and offline support.

69



Using the Internet

Figure 3.40. Thunderbird as a Newsgroup

<) {eCountWizara| ==

New Account Setup

In order to receive messages, you first need to set up a Mail or
MNewsgroup account.

This Wizard will collect the information necessary to set up a Mail or
Newsgroup account. If you do not know the information requested,
please contact your System Administrator or Internet Service
Provider,

Select the type of account you would like to set up:

() Email account

) Unix Mailspeal (Movemail)
() RSS News & Blogs

) Gmail

® Newsgroup account

[conct | [ noe |

* Themes. As with most elements on Ubuntu, you can personalise the themes to change the look and
feel of Mozilla Thunderbird. A theme can change the toolbar icons or the complete appearance of an
application.

* Cross-Platform Support. Thunderbird is used on various platforms, such as Ubuntu, Microsoft
Windows, Mac OS X and Unix-based operating systems.

Instant Messaging

E-mail message is not expected to be real-time, which means you can respond to it when time allows.
But when 'Tmmediacy’ is required, instant messaging (IM) is the way to go. Using IM over the Internet
can bring down costs of long distance phone calls when you want to stay in contact with friends. While
in office, if you want an answer to a simple question, IM facilitates quick and easy communication and
reduces the amount of e-mail messages sent and received in a day. IM also enables you to view a person
using Web-cams or talk over the Internet for free.

The default instant messenger client on Ubuntu is Pidgin, a cross-platform instant messenger that supports
various popular IM network protocols. Using Pidgin, you can communicate with people who use America
Online (AOL) Instant Messenger (AIM/ICQ), Gadu-Gadu, GroupWise, IRC, Jabber, MSN, Napster and
Yahoo. It allows you to list all your friends in one window. Pidgin users can log on to multiple accounts on
multiple IM networks simultaneously. This means that you can chat with friends on AIM, talk to a friend
on Yahoo Messenger, and sit in an IRC channel, all at the same time. Pidgin supports many features of
the various networks, such as file transfer, away messages, typing notification, and MSN window closing
notification. A few popular features are Buddy Pounces, which give the ability to notify you, send a
message, play a sound or run a programme when a specific buddy goes away, signs online or returns from
idle.
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Procedure 3.10. To connect to an existing e-mail account using the Pidgin instant
messenger, perform the following steps:

1. On the Applications menu, point to Internet and click Pidgin Internet Messenger. The Accounts
dialogue box with a welcome message will be displayed.

Figure 3.41. Launching Pidgin Internet Messenger

-(:“App\ications Places Systeme o

E:i’ Accessories 3

[+} Games »

‘Ji Graphics »

@ Internet 3 @ Ekiga Softphone
L@ office 3 9 Ewvolution Mail

f' Programming 3 6 Firefox Web Browser
ﬁ Sound & Video » D Liferea Feed Reader
a Mozilla Thunderbird mMailNews

@. AddfRremove...

@ Pidgin Internet Messenger

@ Remote Desktop Viewer Send instant messages over multiple protocols
=

% Terminal Server Client

@ Transmission BitTorrent Client

2. Click Add to configure your any existing e-mail account on Pidgin. The Add Account dialogue box
will be displayed.

Figure 3.42. Adding a New IM Account

Welcome to Pidgin!

You have no IM accounts configured. To start connecting with
Pidgin press the Add button below and configure your first
account. If you want Pidgin to connect to multiple IM
accounts, press Add again to configure them all.

You can come back to this window to add, edit, or remove
accounts from Accounts=Add/Edit in the Buddy List window

3. Inthe Add Account dialogue box, select the protocol, which is your e-mail account server name from
the Protocol box. The protocol is the name of the server you want to use for chat. Type your selected
protocol's e-mail ID in the Screen name box and the corresponding password. Type your nick name
that you would like to be known by while chatting in the Local alias box. Click Save to create the
account. The Accounts window will be displayed.
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Figure 3.43. Providing Basic Account Information

= Add Account ==

Basic | Advanced

Login Options

Screen name: [windsor

Protocol:

Server: [irc.ubuntu.com

Password: [

Local alias: [

[] Remember password

l Qcancel l l | “save l

4. You can see the newly created account with a check mark indicating that it is active in the Accounts
window. Click Close.

Figure 3.44. Viewing Added Accounts

23 ACCOUTLS | 53 I

Enabled Screen Mame Protocal

] wwindsor@irc.ubuntu.com @ IRC

| =k Add || odify || ol Delete H Eglose

Note:

If you want to add another e-mail account, click Add in the Accounts window and perform
steps 1-4.

5. Now, click the Pidgin icon on the top panel of the desktop to view the Buddy List window for your
current account.
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Figure 3.45. Viewing Buddy List

Buddy st el =l

Buddies Accounts Tools Help

() Available - l “
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6. To start using Pidgin, on the Buddies menu, click New Instant Message. The New Instant Message
window will be displayed.

Figure 3.46. New Instant Message

Buddies @Accounts Tools Help

[ Mew instant Massage... Ctri+M

) Get User info... Ctri+|
View User Log... Chrl+L
Shew b
Sort Buddses ¥

4F Add Buddy.. ctri+B

qk Add Group...

&l Quit Ctrl+gQ

() Available - m

7. To interact with other users, type the screen name or alias of the person you would like to chat with
in the Name box and click OK. An IM window will be displayed.

Figure 3.47. Specifying Buddy Name

(= NEWInstant MeESSage ==

P \? Please enter the screen name or alias of
[fole the person you would like to IM.

MName: [charlesz l

logancel I @QK l

8. You can use the box at the bottom of the window to type your messages and press Enter to send them.
This is how you can start your conversation.
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Figure 3.48. IM Window

- chariesw, == =]

Conversation Options Send To

& charlesw

@lFont | 2k nsert (=) smile!

Nice to Know:

You can change the appearance of Pidgin by adding additional features, such as changing its
graphical interface and theme to it. The packages required to do this are Pidgin-guifications,
Pidgin-libnotify and Pidgin-themes. You can install these packages from Synaptic Package
Manager by following the procedure listed in the Using Alternative E-Mail Client section.

Making Phone Calls Using Softphones

A softphone is a software programme that is used to make telephone calls over the Internet using a computer
instead of using a regular phone. Your service provider may offer computer-to-computer calls for free,
but PC-to-phone and phone-to-PC calls usually are charged. You need to have the same communication
protocol and use a common audio codec to communicate with another person. The audio codec defines
how voice is translated into digital signals. Examples of SIP softphones are Ekiga, SIP Express Router
and many more.

You use a softphone with a headset connected to the computer or with a USB phone. The features of
softphone include all standard telephony features, such as mute, flash, hold and transfer. It also includes
new features, such as presence, video, wideband audio and many more. The softphone requirements to
make voice calls over the Internet are a computer with a microphone and speaker, a headset or USB phone,
Internet connectivity and an account with an Internet telephony service provider.

Nice to Know:

Skype, Google Talk and Vonage are Internet telephony service providers whose software you
would need to install on your computer. But these three providers are not interoperable, and you
cannot place a direct call between them.

The configuration of Ekiga is described below.
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Using Ekiga

Ekiga is an open source softphone application for Ubuntu. It is a free Voice over IP (VoIP) and video
conferencing application. VoIP routes voice conversations over the Internet or through any other IP-based
network. You can use Ekiga to call, send instant messages and be contacted by other Ekiga users.

The First Time Configuration Assistant helps you configure Ekiga. It appears automatically when you

open Ekiga for the first time.

Procedure 3.11. To configure Ekiga on Ubuntu:

1.

2.

On the Applications menu, point to Internet and click Ekiga. The Configuration Assistant page

will be displayed. Click Forward.

Figure 3.49. Launching Ekiga Softphone

-GApplications Places Systeme 9

|§_,_¥ Accessories 3

[v} Games 3

“i Graphics 3
"\4:} Internet 3 @ Ekiga Softphone
[y office 3 @ Evolution Mail

l Programming 3 e Firefox Web Browser

ﬁ Sound & Video  » D Liferea Feed Reader

Talk to people overthe Internet

a Mozilla Thunderbird Mail/News

@. Add/Rermove...
@ Pidgin Internet Messenger

@ Remote Desktop Wiewer
% Terminal Server Client

@ Transmission BitTorrent Client

On the Personal Information page, type your full name in the Please enter your first name and
your surname box. The name that you specify is used for display purposes when you connect to

other audio or video applications. Click Forward.

76



Using the Internet

4.

Figure 3.50. Specifying Display Name

Eirstihime Conhguration Assistant

Please enter your first name and your surname:

[Wi\liam Windsor ]

Your first name and surname will be used when connecting
to other VoIP and videoconferencing software.

l ogamcel ] l & Back l [ﬁﬁorward]

On the ekiga.net Account page, type your Ekiga's account user name and password that you use to
log in to your existing Ekiga account. You will get this detail from the ekiga.net free SIP service.
Click Forward.

Figure 3.51. Specifying ekiga.net Account Username and Password

HIrstHime Conhguration Assistant

Please enter your username:

[wwindsor ]

Please enter your password:

(eesecsed J

The username and password are used to login to your existing
account at the ekiga.net free SIP service. If you do not have
an ekiga.net SIP address yet, you may first create an account
below. This will provide a SIP address that allows people to call
you.

You may skip this step if you use an alternative SIP service, or
if you would prefer ta specify the login details later.

Get an ekiga.net SIP account

[ | do not want to sign up for the ekiga.net free service

[ Ocancel l [ & Back l [ﬁﬁorward]

Note:

If you do not have an SIP account, you can click the link Get an ekiga.net SIP account on
the page to create an SIP account on ekiga.net.

On the Connection Type page, select the type of Internet connection you are using on your computer
from the Please choose your connection type box. This connection type determines the best quality
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settings that Ekiga will use during calls. If you do not know the connection type, contact your system
administrator. Click Forward. You can change these settings later.

Figure 3.52. Selecting Connection Type

Eirstihimme ConhigurationAssistant:

Connection Type - page 4/10

Please choose your connection type:

ar

I TLILAN

The connection type determines the best quality settings
that Ekiga will use during calls. You can later change the
settings individually in the preferences window.

l Qcancel l l &= Back l i =) Forward |

On the NAT Type page, click Detect NAT Type. It informs you which Network Address Translation
(NAT) type was detected and automatically configures Ekiga to transparently cross your router. So,
NAT avoids all the problems associated with reserving IP addresses. Click Forward.

Figure 3.53. Selecting NAT Type

Eirstihimme ConhigurationAssistant:

NAT Type - page 5/10

Click here to detect your NAT Typea:

[ Detect NAT Type |

The NAT type detection will help you to
configure your NAT router to be able to call with
Ekiga.

l Qcancel l l &= Back l [ QEorwardl

Note:

To learn  more about  NAT, refer  to: http://en.wikipedia.org/wiki/
Network_address_translation.
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On the Audio Manager page, select the audio manager, which is the plug-in, according to the
sound card of your computer. The audio manager is a plug-in that manages your audio device and is
dependant on the operating system on your computer. Though it is recommended to use ALSA, you
should check with your your system administrator to identify the appropriate audio manager for the
audio device that you want to use. Then, click Forward.

Figure 3.54. Selecting Audio Manager

Hrstaimer Conti guration ASSi stant:

Audio Manager - page 6/10

Please choose your audio manager:

ar

I ALSA

The audio manager is the plugin that will manage your
audio devices. ALSA is probably the best choice it it's
available.

l Qcancel l l &= Back l i =) Forward |

Ekiga requires audio output and input devices to play and record sound files. The audio output device
is used to play audio and audio input device to record your voice. So, on the Audio Devices page,
select the audio output and input devices. For example, headset or speakers are the output device and
your microphone the audio input device. Now, click Test Settings to check the functionality of audio
devices and the click Forward.

Figure 3.55. Selecting Audio Devices

Hrstaimer Conti guration ASSi stant:

Audio Devices - page 7/10

Please choose the audio output device:

ar

IHDA Intel

The audio output device is the device managed by
the audio manager that will be used to play audio.

Please choose the audio input device:

l Default B

The audio input device is the device managed by
the audio manager that will be used to record your
voice.

Test Settings

l ogancel l l &= Back l i =) Forward |
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On the Video Manager page, select the video manager, which is the plug-in used to manage your
video devices. You can select Video4Linux to manage Webcams or AVC / DC for Firewire cameras.
Click Forward.

Figure 3.56. Selecting Video Manager

Eirstihimme ConhigurationAssistant:

Video Manager - page 8/10

Please choose your video manager:

I\ML v

The video manager is the plugin that will
manage your video devices, VideodLinux is the
most commen choice if you own a webcam.

l Qcancel l l &= Back l i =) Forward |

On the Video Devices page, select the video input device from the Please choose the video input
device box. The video input device is the device managed by the video manager that will be used
to capture video. If you do not want to do video conferencing or if you do not have a video device,
you may skip this page.

Click Test Settings to ensure that your video device works with Ekiga. Click Forward.

Figure 3.57. Selecting Video Devices

Eirstihimme ConhigurationAssistant:

Video Devices - page 9/10

Please choose the video input device:

INo device found =

The video input device is the device managed by
the video manager that will be used to capture
video.

l Qcancel l l &= Back l i =) Forward |
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10. The configuration of Ekiga is now complete. This window displays a configuration summary of the
settings you have selected. You can verify your settings here. If you want to make any modification,
navigate to the required page by using Back and Next and make appropriate changes. Click Apply
to save the configuration.

Figure 3.58. Account Configuration Summary

Eirstihimme ConhigurationAssistant:

Configuration complete - page 10/10

You have now finished the Ekiga configuration. All of the
settings can be changed in the Ekiga preferences. Enjoy!

Configuration summary:

Username: charles windsor
Connection type: TL/LAN

Audio manager: ALSA

Audio player: HDA Intel

Audio recorder: Default

Video manager: V4L

Video input: Mo device found
SIP URL: sip:charlesw@ekiga.net

l ogancel

I 4a Back I [&épply ]

The Configuration Assistant will close.

Note:

Afterinstalling Ekiga, if you want to modify any configuration, you can run the configuration
assistant again by Preferences on the Edit menu in the Ekiga window.

Nice to Know:

For more information on Ekiga, refer to http://www.ekiga.org.

The Ekiga window will be displayed. It is the default softphone application available on Ubuntu.
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Figure 3.59. Ekiga Window
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Registration failed: Forbidden

Making Calls Using Ekiga

From Computer to Computer

From Computer to Regular Phones

From Real Phones to Computer

Note:

Using Ekiga, you can call anyone who is registered to the public SIP
provider and uses SIP software or hardware. You can use the online
address book of Ekiga to find the SIP addresses of other Ekiga users.
It is of course possible to call non-Ekiga users, registered to any
public SIP provider. To make calls, type the URL address of the
user you wish to call in the sip: : input box and click the connect
icon on the right of the text box. With the default setup, you can
simply type sip:foo to call user foo@ekiga.net.

You can use Ekiga with multiple ISPs. There is a charge for this
service so you will need to create an account with the provider
first. After the account is created, you will receive a login and a
password by e-mail. Simply enter them in the Ekiga dialogue box,
select Use PC-To-Phone service and you are ready to call regular
phones using Ekiga. With the default setup, you can simply use
sip:00911129535955 to call the real phone number 003210444555,
00 is the international dialling code, 91 is the country code and
1129535955 is the number to call.

You can also use Ekiga to receive incoming calls from regular
phones. For this, you have to login to PC-To-Phone account and
purchase a phone number. Ekiga then rings, when people call you
at that phone number.

To learn more about making phone calls by using Ekiga, refer to http://www.ekiga.org/index.php?

rub=3.
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Skype

Skype is another softphone that can be used on Ubuntu to make calls over the Internet. The source code
of Skype is proprietary, but the software is free to use. Your calls go through distributed servers and
not through a central server. To accomplish this, Skype uses a decentralized peer-to-peer technologies
and its own proprietary communication protocol. Skype uses encrypted communication, which means all
communications are encrypted from end-to-end so that others cannot listen in. We will not go into detail
over Skype communication here.

Lesson Summary

In this lesson, you learned that:
* You can connect a computer to the Internet using cable, wireless and dial-up connections.

* Mozilla Firefox is an open source, powerful and secure Web browser. It is available for free and is the
default browser on Ubuntu.

+ Firefox includes two powerful features that make your online experience better and more productive -
integrated search system and bookmarking.

+ Liferea is an RSS feed reader, which offers useful features to manage your newsgroup subscription.
+ Evolution is the default e-mail client for Ubuntu.

* Mozilla Thunderbird is the e-mail application developed by Mozilla Foundation. It is a free, cross-
platform e-mail and news client.

* The default instant messenger client on Ubuntu is Pidgin. It is a cross-platform instant messenger that
supports multiple popular IM network protocols.

 Ekiga is the default open source softphone application for Ubuntu.

Review Exercise

Question: What are the three main ways to connect to the Internet?

Answer: The three main ways to connect to the Internet are through cable, wireless and dial-up
connections.

Question: Which tool is used to identify a modem on Ubuntu?

Answer: The ScanModem tool is used to identify a modem on Ubuntu.

Question: Why do you require a bookmark in Firefox?

Answer: Mozilla Firefox uses a bookmark for quick access to saved Web addresses.
Question: What is a feed?

Answer: A feed is an XML Web page that contains a list of links to other Web pages.

Question: Match the following:

1) Evolution a) Web browser
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2) Firefox b) Mail client
3) Ekiga ¢) Instant messenger
4) Pidgin d) Phone calls

Answer: 1-b, 2-a, 3-d and 4-c

Question: You can get an SIP address from

Answer: You can get an SIP address from http://www.ekiga.net.

Question: The source code of Skype software is , but the software is
to use.

Answer: The source code of Skype software is proprietary, but the software is free to use.
Question: Which of the following is an RSS feed reader?A. EkigaB. LifereaC. PanD. Skype
Answer: B. Liferea

Question: Which of the following is proprietary software?A. SkypeB. EkigaC. LifereaD. Firefox

Answer: A. Skype

Lab Exercise

Exercise 1. You use Liferea as a newsreader on your computer. Recently, you met a friend who informed
you about a Web site that offers RSS feeds, http://www.lifehacker.com. Now, you want to configure Liferea
for the latest updates from this Web site.

1. Open the following Web site http://www.lifehacker.com. This site offers RSS feeds.

2. In the left pane, under syndication, click Full content (with ads). Save the URL in the Address bar
of Mozilla Firefox. This URL, http://feeds.gawker.com/lifehacker/full, is the feed.

3. Open Liferea.

4. Right-click in the left pane, point to New and click New Subscription. The New Subscription dialogue
box is displayed.

5. In the New Subscription dialogue box, type the saved URL http://feeds.gawker.com/lifehacker/full
and click OK.

Exercise 2. You want to chat with your friend, who uses Google talk (gtalk). Configure Pidgin to chat
using gtalk.

1. On the Applications menu, point to Internet and click Pidgin Internet Messenger.
2. On the Accounts menu, click Add/Edit. The Accounts window is displayed.
3. In the Accounts window, click Add. The Add Account window is displayed.

4. In the Add Account window, select xmpp from the Protocol box, type your gtalk e-mail id in the
Screen name box, your account password in the Password box and your nickname in the Local alias
box. Click Save.

5. You are now connected to the gtalk server.
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Chapter 4. Using OpenOffice
Applications

Objectives

In this lesson, you will learn how to:

 Perform basic word-processing functions using OpenOffice.org Writer.

» Perform basic spreadsheet functions using OpenOffice.org Calc.
 Create and view multimedia presentations using OpenOffice.org Impress.
* Perform basic drawing operations using OpenOffice.org Draw.

+ Create and edit formulae using OpenOffice.org Math.

Instructor Notes:

It is recommended to cover all the topics in this lesson. However, if you are running short on time
you can omit the following optional topics:

* OpenOffice.org Draw
* OpenOffice.org Math

Students, who are familiar with office applications, may want further exposure to these
applications. However, ensure to conclude the lesson within the permitted time span.

Introducing the OpenOffice.org Suite

OpenOffice.org is the default office application suite provided with Ubuntu. This is a free, open source
office software suite that comprises all the features normally expected in an office suite. It is not just a
collection of separate software programmes; it has been designed as a complete office package, in which
all applications have a similar look and feel and common tools.

The OpenOffice.org suite is available in more than 30 languages and can run on many operating systems,
including Linux, Microsoft Windows, Solaris and Mac OS X. It is also compatible with all other major
office suites, including Microsoft Office, which makes it easy for you to create, open, save and exchange
documents with friends and colleagues in Microsoft Office formats.

Another key feature of the OpenOffice.org suite is that all the applications save in the OpenDocument
format, which is the new international standard for office documents. This Extensible Markup Language
(XML) based format enables you to access your data from any OpenDocument-compliant software.

Nice to Know:

For more information on the history and development of OpenOffice.org, please visit http://
en.wikipedia.org/wiki/Openoffice.org.

The OpenOffice.org software suite includes the following applications to help you handle your work
effectively:
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* OpenOffice.org Writer
* OpenOffice.org Calc

* OpenOffice.org Impress
* OpenOffice.org Base

* OpenOffice.org Draw

* OpenOffice.org Math

To access the OpenOffice.org suite:

* On the Applications menu, point to Office and then click the OpenOffice.org application you want.

Figure 4.1. Accessing OpenOffice.org

-G Applications Places System e@o

E:b AcCcessories b

(v} Games v
‘_".'j_-_ Graphics b
r;._:). Internet b
Lﬁ Office b @ Evolution Mail and Calendar
f Programming * OpenOffice.org Presentation
w Sound & Video  » m OpenOffice.org Spreadshest

: M OpenOffice.org Word Processor
@. Add/Remove...

OpenOffice.org Writer

Writer is the word processor of the OpenOffice.org suite. It provides powerful functions and tools to do
anything from writing a small letter to creating an entire book that contains charts, graphics, images, tables
and an index. Complex desktop publishing tasks, such as creating multicolumn newsletters and brochures
are also on hand.

OpenOffice.org Calc

Calc is a powerful spreadsheet that contains all the tools necessary to calculate, analyse, summarise and
present data in the form of reports or charts. It has a wide range of advanced functions such as entering
complex formulae, pulling in external data and performing statistical analyses.
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OpenOffice.org Impress

Impress is a presentation programme designed to create effective multimedia presentations. It provides
a range of tools to create presentations with 2D and 3D graphics, clip art, graphics, special effects and
animations.

OpenOffice.org Base

Base is a database programme used to store contact and account information, create and modify tables,
forms, queries and reports. Accessing data stored in a wide variety of database file formats is also
available. Base will not be covered in detail in this course. For more information on base, please refer to
www.openoffice.org/product/base.html

OpenOffice.org Draw

Draw is a vector graphics editor that provides tools to create anything from simple graphics to dynamic
3D illustrations and special effects.

OpenOffice.org Math

You can use Math for creating and editing mathematical equations by using a graphic user interface or
by directly typing the formula into the equation editor. The formula created in this manner can then be
inserted into other OpenOffice.org programmes, such as Writer, Calc and Impress.

Note:

Using a new OS and especially a new office application suite is not as daunting to pick up as you
may think. With OpenOffice, most of the operations are very intuitive. Think of a new suite as
moving to a new house; all your old cutlery, plates and dishes are in your kitchen cupboards, you
just need to get used to the new kitchen arrangement!

Using OpenOffice.org Writer
Key Features of OpenOffice.org Writer

You may already be familiar with many of the features of this application so only a few of them are included
here.

Writing. OpenOffice.org Writer offers a variety of useful features to help you create basic text
documents as well as long and complex or multi-part documents that may include components such as
bibliographies, reference tables and indexes. Some of these features are:

+ Spellchecker: The spellchecker feature facilitates error-free writing by enabling you to check your
entire document, including the header, footer, index entries and footnotes, for spelling errors. It even
allows you to identify a misspelled word from a specific selection of the document, lists suggested words
for replacing the misspelled word and provides you the option to add a new word to the existing user
dictionary.

* Thesaurus: The thesaurus helps you enhance the quality of your writing and make it more effective by
allowing you to find a more appropriate synonym for a selected word.
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* Autocorrect: Autocorrect is a software function that enables you to reduce your typing effort
by automatically correcting common spelling and typing errors. This feature also allows you to
automatically apply correct formatting to the text or insert special characters by recognizing particular
character usage.

* Hyphenation: You can use the hyphenation feature to insert hyphens in words that are too long to fit
at the end of a line. It searches the entire document and suggests hyphenation that you can either accept
or reject.

* Mail merge: The Mail merge feature allows you to create multiple personalised form letters, labels,
envelopes, faxes and e-mail messages by using a form letter template and an address database.

Designing and Structuring. OpenOffice.org enables you to design and structure your text document
by using an assortment of features, including:

+ Style and Formatting window: The Style and Formatting window is one of the common features
available in the OpenOffice. org package that can be used consistently in all the applications included in
the package. You can use this window to create, assign and modify styles for paragraphs, lists, individual
characters, frames and pages.

+ Navigator: Provides you with an outline view of the entire document and allows you to quickly navigate
inside the document. You can also use Navigator to track the objects and elements that are already
inserted and to insert new elements into the document.

+ Indexes and Tables: Enable you to insert an index, a table of contents or a bibliography reference in
your text document. You can also customise the inserted tables and indexes by defining their structure
and appearance.

Desktop Publishing. The following features can help you create professionally styled documents, such
as brochures, invitations and newsletters:

+ Text Frames: Acts as a container for text and graphics and can be placed anywhere in a document. You
can also use these frames to apply a multi-column layout to your document and render a professional

look and style to it.

* Graphics: Allows you to insert a graphic object into your text document from a gallery, a file or any
other OpenOffice.org application.

+ Tables: OpenOffice.org Writer also enables you to create or insert a table into a text document.
Drawing. The drawing functions make it easy for you to create many types of drawings and graphics
directly in your text document. You can use the Drawing bar to add various shapes, lines, text and callouts

to a current document.

Drag and Drop. This unique feature allows you to drag objects from one location to another in the same
document, from one OpenOffice document to another and from the Gallery to your OpenOffice document.

The Help Function. This is a complete reference for your Writer.

Performing Basic Word-Processing Tasks

You can perform a number of word-processing tasks, such as writing, editing, formatting, reviewing and
printing documents, using OpenOffice.org Writer. The word processor also allows you to use various
templates, apply different styles to your document, control your page layout and insert, edit and create
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graphics inside your text document. Instructions to perform some of the basic word-processing tasks in

Writer are described in the following sections.

Entering and Formatting Text. OpenOffice.org Writer is primarily used for writing and formatting
text. You can enter text using your keyboard and then apply a variety of formats to the text, as per the

document's requirements.

Procedure 4.1. You can use the following steps to enter and format text using

OpenOffice.org Writer:

On the Applications menu, point to Office and then click Openoffice.org Word Processor. A blank

text document opens.
Figure 4.2. Launching Writer
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R® |
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.{1} Internet 4
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ﬁ Sound & Video » m OpenOffice.org Spreadsheet

_ M OpenOffice.org Word Processor
@. Add/Remove...

Depending on what you want to do, you can either create a letter, memo, note or an entire novel from
scratch, or you may start with a predefined template or sample that is suitable for your requirements.

To access the templates and samples, on the File menu, point to New and then click Templates
and Documents. Alternatively, you can press SHIFT+CTRL+N. The Templates and Documents

dialogue box opens.
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Figure 4.3. Accessing Templates and Documents
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You can view the various categories of available templates in the middle column of the Templates and
Documents dialogue box. If you want to use a template to create your document, you can double-click
a category. This will display the various templates associated with that category. Select a template of

your choice and then start working on it.

However, you may also decide to work with the default blank document. To continue working with
the blank document, exit the Templates and Documents dialogue box by clicking Clese in the top-

right corner of the dialogue box.

Figure 4.4. Accessing Templates
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Instructor Notes:

If students need to know more about using samples and templates, you can tell them how to
use various wizards, available under the File menu, to create user-defined templates, such
as faxes and letters. These templates can later be used to create further documents.

4.  After you have created the document, you can use the various formatting features provided in Writer

to change the text display or emphasise specific areas in your document. You can use the following
options available on the Formatting toolbar to perform some of the most common formatting tasks.

Figure 4.5. The Formatting Toolbar
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5. You can use the Style and Formatting window to perform a complete document makeover.

To open the Style and Formatting window, on the Format menu, click Style and Formatting. The
Style and Formatting window appears.
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Figure 4.6. Accessing Style and Formatting Window
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6. You can use this window to select and modify the existing style or create a new style. Clicking one
of the icons below the title bar of the Style and Foermatting window will display a list of styles in
a particular category, such as a list or a paragraph.

Figure 4.7. The Style and Formatting Icons
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7. By default, when you open the Style and Formatting window, the Paragraph Style icon is selected.
All the styles listed in this category are displayed in the Style and Formatting window. You can start
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restyling individual parts of the current document by selecting specific parts of the document and
applying an existing style by double-clicking that style.

Figure 4.8. Applying a Style
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8. However, if you want to modify an existing style, you can simply right-click that style and select
Modify. This displays a new pop-up window. You can redefine almost all aspects of the selected style
using the various options available under the different tabs.

Modify the specifications of the selected style, and click OK to apply the changes.

Figure 4.9. Modifying a Style
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9. Double-click the modified style to reflect the changes in the selected text.
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Figure 4.10. Applying the Modified Style
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10. You can customize all other parts of the document in the same way.

Instructor Notes:

If the students want to know more about the various formatting options available, you can

give them the following information:

OpenOffice.org provides several ways to apply styles. These are:

In addition, describe the procedure to create a new style and add it to the Style and Formatting

Using the Styles and Formatting window.

Using Fill Format mode.

Using the Apply Style list on the Formatting bar.

Assigning styles to shortcut keys.

Using AutoFormat.

window.

Procedure 4.2. Inserting Tables

To insert a table in a text document, position the cursor where you want the table to appear and then follow

the procedure described below:

1. On the Table menu, point to Insert and then click Table. The Insert Table dialogue box opens.
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Figure 4.11. Inserting a Table
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You can use the various options present in the dialogue box to specify some of the table properties.

Figure 4.12. Specifying Table Properties
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Nice to Know:

To directly insert a table with the default properties, click the Table icon on the Standard
toolbar and select the table size in the graphic that appears. To create the table, click the cell
that you want to be on the last row of the last column.

Specify the table properties and click OK. The table is inserted at the specified location in your text
document. By default, Writer creates a table as wide as the page margins, with all the rows having the
same height and all the columns having the same width. To adjust the column and rows and customise
the table further, right-click the table and select Table from the short-cut menu. The Table Format
dialogue box opens.

Now you can use this dialogue box to define finer specifications for the table such as alignment,
column width, text flow, borders and background.

Define the table specifications as per your requirements and preferences, and click OK to apply the
changes.
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Figure 4.13. Customising the Table Format
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The defined specifications are applied to the table. To arrange the data within one of the table cells
into another table, you can create nested tables. Writer permits you to create as many layers of nested
tables as you want.

To create a nested table, click the cell in which you want the nested table to appear, then follow the
procedure for inserting a new table. A nested table appears in the specified cell within the larger table.

Figure 4.14. Creating a Nested Table
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5. You can now define the finer specifications of the nested table using the Table Format dialogue box
and then populate the table with data.

Figure 4.15. The Nested Table
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Inserting Images. OpenOffice.org allows you to import images of various file formats, including the
most common file types such as JPEG, PNG, BMP and GIF. Images can be inserted from a file, the
OpenOffice.org Gallery, a scanner, the Internet, or a graphics programme.

Procedure 4.3. To insert an image into your text document from a file:

1. Position the cursor at the location in the document where you want the picture to be inserted. On the
Insert menu, point to Picture and then click From File. The Insert Picture dialogue box opens.

2. Toinsert the file, navigate to the desired file and select it. You can select the Preview check box at the
bottom of the Insert Picture dialogue box to preview the selected image in a pane and verify whether
you have selected the correct image. Click Open to insert the image in your document.
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Figure 4.16. Inserting Image
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Instructor Notes:

Explain the following:

Selecting the Link check box creates a link of the selected file inside your text document,
instead of saving a copy of the image in your document. As a result, though you'll be able
to view the image in the document, when the image is saved, the document will contain
only a reference to that image but not the image itself. Linking an image has the following
advantages and disadvantages:

* It reduces the size of your document when it is saved because the image is not included
in it.
* You can edit or modify the image separately without making any changes in the document

and can view the modified image the next time you open the document.

» When you wish to send the document to someone, you need to send both the document and
the image otherwise, the receiver will not be able to view the linked image.

The image is inserted at the specified location in your document. If the image does not fit perfectly
into your document, you should resize it.

To resize the image while maintaining its proportions, select the image and then press and hold the
SHIFT key. When you select an image, some square points (known as "handles") appear along its
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perimeter. While holding down the SHIFT key, click and drag one of the handles on the image to
modify its size.

Figure 4.17. Resizing the Inserted Image
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Instructor Notes:

Explain the difference between a scaled and an unscaled resize, and emphasise the
advantages of the scaled resize performed above.

After you have resized the image, you need to position the image appropriately in the document.
You can arrange and align images using the tools on the Frame toolbar, which appears below the
Standard toolbar when you select a graphic for the first time.

Alternatively, you can right-click the image and then select from the available options, such as
Arrange, Wrap or Ancher, on the short-cut menu.
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Figure 4.18. Positioning the Inserted Image
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5. After you have selected appropriate positioning options for the image, you may obtain a result similar
to the following screenshot.

Figure 4.19. The Inserted Image
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Procedure 4.4. Printing Documents

1. Onthe File menu, click Print. The Print dialogue box opens. You can use this dialogue box to specify
the printer to be used (in case you have more than one printer installed on your system), the pages
to be printed, and the number of copies to be printed. You can also click the Properties button in
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the Print dialogue box to define the properties of the printer, such as orientation, the paper tray to
be used and the paper size to be printed.

To define printer options for the current document, click the Options button in the Print dialogue box.

Figure 4.20. Printing a Document
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2. The Printer Options dialogue box enables you to select specific sections from the current document
for printing. For example, to save toner or ink, you may not want to print the background and the
graphics in the document. You can specify these details under the Content section by selecting or
clearing the appropriate check boxes.

Similarly, you can define the required printing options in the Pages and Notes section. After
specifying the details, click OK to save your settings.

Figure 4.21. Defining Printer Options
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3. You can now start printing the document by clicking OK on the Print dialogue box.

Note:

Making changes in the Printer Options dialogue box will only apply to the current document
and not change your default settings permanently.
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Instructor Notes:

If the students want to know about the procedure to select the default print options, provide
them the following information:

To select the default print options, On the Tools menu, click Options.
* The OpenOffice.org - Print dialogue box opens.
* In the left navigation panel, expand OpenOffice.org Writer and then select Print.

* Select the required options and click OK to apply the changes to the default print settings.

Procedure 4.5. Saving Documents

You can save your Writer document in the same way as you save any other document. To save a new text
document:

1. On the File menu, click Save As. The Save dialogue box opens.

Figure 4.22. Saving the Document
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2. Navigate to the directory where you want to save the file, enter the file name and click Save to save
the file at the desired location.

OpenOffice.org also allows you to save your document in a number of other file formats, including
Microsoft Word, Rich Text, Star Writer and as an HTML document. This enables you to share your
documents with other people who use other office applications, such as Office.

If you would like to save your current document as a Word file, select the appropriate type of Word
format from the drop-down menu at the bottom of the dialogue box. Then, click Save to save the
file as a Word document.
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Figure 4.23. Saving in Word Format
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Using OpenOffice.org Calc

Calc is the spreadsheet component of the OpenOffice.org office software suite. The comprehensive range
of advanced functions included in Calc helps professionals accomplish complex tasks. At the same time,
Calc is user-friendly, which makes it easier for new users. This topic will familiarise you with its key
features and teach you how to perform some basic spreadsheet functions.

Similar to all other applications in the OpenOffice.org suite, Calc allows you to save spreadsheets in OASIS
OpenDocument (ODF) format. This XML-based format enables you to access your spreadsheets from any
OpenDocument-compliant software. In addition, Calc allows you to save spreadsheets directly as Portable
Document Format (PDF) files without using any additional software.

Key Features of OpenOffice.org Calc

Calc is a fully featured office application that includes all the advanced analysis, charting and decision-
making features that you expect from a high-end spreadsheet. Some of the key features of OpenOffice.org
Calc are:

+ Calculation: OpenOffice.org Calc provides you with over 300 functions for financial, logical,
statistical, mathematical and banking operations. This enables you to create formulae to perform
complex calculations on your data. In addition, Calc provides you with Function wizard that guides you
interactively through the creation of formulae.

Another feature of OpenOffice.org Calc is that it allows you to create natural language formulae using
words such as sales - costs.

* Scenario Manager: Allows you to perform 'what-if' analyses and view the result of changes made
to any factor of the calculation. For example, when performing a loan calculation, you can change the
period of the loan and can view the resulting calculations for the loan-repayment amount or the interest
rate.

+ Data Pilot: Enables you to compare, combine and arrange large amounts of data. It helps you pull
in raw data from corporate databases, cross-tabulate, summarise and convert the data into meaningful
information. You can use Data Pilot to create interactive tables, which allows the data to be frequently
arranged, rearranged or summarised according to different points of view.
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* Dynamic Charts: As the name suggests, these charts update automatically as the data in the
spreadsheet changes.

* Opening and Saving Microsoft Files: Calc allows you to use your old Microsoft spreadsheets and

save your work in Microsoft Excel or a variety of other formats. This facilitates the easy sharing of data
with others using Microsoft or similar applications.

Performing Basic Spreadsheet Tasks

Similar to any other spreadsheet application, Calc is used to process numerical information or text in
tabular form. It is primarily used for tabulating numerical figures. It also allows you to sort and manipulate
data, apply arithmetic, mathematic and statistical functions to data sets and represent the datasets in charts
or graphical forms. The following sections describe the instructions to perform some basic spreadsheet
tasks in Calc.

Procedure 4.6. Formatting Tables and Cells
To format tables and cells in a Calc spreadsheet:

1.  On the Applications menu, point to Office and then click OpenOffice.org Spreadsheet to open a
Calc spreadsheet. A new Calc window opens.

Figure 4.24. Launching Calc
Q Applications  Places System e@e

|§_,¥ Accessories 3

[«} Games »
“i Graphics 3
Q_, Internet 3
Lﬁ Office 3 Q Evolution Mail and Calendar
’ Programming 3 Openoffice.org Presentation

ﬁ Sound & Video » E OpenOffice.org Spreadshest

M Openoffice.org Word Processor

Perform calculation, analyze information
and manage lists in spreadshests. >

o) Add/Remove...

2. Some of the key components of the main Calc window are described below:
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Figure 4.25. The Calc Window
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| 9 |
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12
13
14 Sheet tabs
15
16
17 | =
e Shebtl {Sheetz / Sheets 1[4 D
Sheet1/3 Default 100% STD Sum=0

The Name box contains the cell and the row number, called the cell reference, of the current or
active cell.

The active cell indicates the selected cell currently in use.

The Function wizard opens the Function Wizard dialogue box.

* The Sum button allows you to calculate the sum of the numbers in the cells that are above the
current cell.

* Clicking the Function button inserts an equals sign into the current cell as well as in the input line,
making it ready to accept a formula.

* The sheet tabs at the bottom of the sheet indicate the number of worksheets present in the current
spreadsheet. By default, a new spreadsheet includes three worksheets.

After you have entered the required data in the spreadsheet, you can apply different formatting styles
to it by selecting from the wide range of options available in Calc. To apply desired formatting to a
selected range of cells, on the Format menu, click Cells. The Format Cells dialogue box opens.
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Figure 4.26. Formatting Cells
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@ l& Untitledl - opencffic... ﬂ:ﬂ@ U

4.  You can use the various options available under the Font, Font Effects and Alignment tabs to specify
various formatting attributes for the selected text. Similarly, for assigning formatting attributes to
numbers, you can select from a number of pre-defined formats available on the Numbers tab page
or define a new one based on your preferences.

The Format Cells dialogue box also provides you with options to add smart borders and vibrant
backgrounds to your spreadsheet. It also allows you to select a background colour, from a spectrum

of colours, for your otherwise bland and dull spreadsheet.

Define the specifications and click OK to apply the formatting effects.

Figure 4.27. Defining Formatting Attributes

INumbers IFont| Font Effects ] Alignment } Barders' Background | Cell Protection } I

Font Typeface Size
[Verdana | [Cursiva ] 11 |
URW Chancery L |  Normal 10
URW Gothic L Cursiva 10.5
URW Palladio L Negreta 11
Vemana2000 Negreta cursiva 12
Yerdana 13
Webdings 14

b 15

Language

Name Gender Age School

The same font will be used on both your printer and your screen.

I OK I[ Cancel ][ Help ][ Reset ]

5. After you have selected formatting attributes for the selected cell range, you may get a result similar
to this one.

106



Using OpenOffice Applications

Figure 4.28. The Formatted Spreadsheet

s =, httea=op i el e = 3
Eile Edit View Insert Format Tools Data Window Help X
x b - = = " Az L »
8-S HNEB&A T «TCH- 26 & @gi:in @ 2 B0
»
B8 (Al o - & 4 A ALK v S GR [ -
[123 -] fo X = |
A 1 B Tcl p 1 E F G H [ I ] | K L E
1 [Name Gender Age School Favourite Subject
2 |Peter Male 17 AHS Science
3 |JCasey Female 16 BHS Fine Arts
4 NFred Male 17 CHS Science
5 JRalph Male 15 BHS Fine Arts
6 [Sue Female 16 CHS English
7_JPat Male 17 BHS English
8 [Magan Male 13 BHS Fine Arts
9 [Mike Male 16 BHS Fine Arts
10 |{Harold Male 18 AHS Maths
11 jHenry Male 15 AHS Science
12 |Dan Male 17 BHS Science
13 JKerry Female 16 CHS English =
14 [|Louis Male 13 BHS Maths
15 |lJeff Male 18 CHS Fine Arts
16 [Melissa Female 17 BHS Maths
17 |Heather Female 13 BHS Science
18 JHayden Female 16 AHS English
19 |Bach Male 16 AHS Maths
20
21
22
= —
24
25
26
27 =
28 | x|
' Sheetl /Sheet2 [Sheet3 [N ]

I
G / m @ V[T @2 B-O-¥%- D AR a,

Sheet1/3 Default 100% STD Sum=0

Calc provides you with another useful feature, called Autoformat, which enables you to create
attractive and professional table designs without undergoing the time-consuming process of selecting
cell groups and assigning different formats to them. The Autoformat feature allows you to quickly
apply preset formats to an entire sheet or a selected cell range. To apply Autoformat to a sheet or
selected cell range, on the Format menu, click Autoformat.

Figure 4.29. Using Autoformat
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7. This displays the AutoFormat dialogue box. To assign a pre-set format to the selected cells, select
one from the Format list and then click OK to apply the selected format to the selection.

Figure 4.30. Selecting a Format

[ SO |

i
Default B
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Black 1
Black 2 N
Blue Help
[Brown
Currency
Currency 3D B
Currency Lavender
Currency Turguoise E More ¥
(e a1

8. The format of your choice is immediately applied to the selection, and you get an attractive and fully
formatted table with very little effort.

Figure 4.31. The Formatted Table

File Edit View Insert Format Tools Data Window Help x
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& (il FEo [ A 44 A I DN~ o) A- ]

F G H I 1 [ 1 [ K L M [<
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Entering Values and Formulas. A formula is a spreadsheet function, complete with arguments, entered
in a cell. All formulae begin with an equal sign and may contain number, text and, in some cases, other data
such as format details. The formulae may also contain arithmetic operators, logic operators or function
starts.

Table 4.1. Calc Formulae

Formulae Description

=SUM(A1:All) Calculates the sum of the cells A1:A11
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=EFFECTIVE(5%;12) Calculates the effective interest for 5% annual nominal interest with
12 payments a year
=B1*B2 Displays the result of the multiplication of B1 and B2

=C4-SUM(C10:C14)

Calculates C4 minus the sum of cells C10 to C14

The quickest way to enter a formula is to type the formula either in the cell where you want the result to
display or in the Input Line on the Formula bar. You can also use the Function wizard, which helps you
interactively create formulae.

Procedure 4.7. To enter a formula using the Function wizard:

1. Inyour spreadsheet, select the cell where you want the formula to be inserted. To allow the Function
wizard to guide you through the creation and application of a formula, on the Formula bar, click
Function Wizard. This opens the Function Wizard dialogue box.

Figure 4.32. Launching Function Wizard
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2. You can see the entire range of functions listed in the Functions list box. You can also select one
category from the Category drop-down list to display the functions listed under that category. Find the
desired function from the Functions list, and click to select it. You notice that the Function Wizard
dialogue box provides you some information about the selected function to guide you through your
selection. After selecting the function, click Next to proceed with the task of entering a formula.
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Figure 4.33. Selecting a Function

Functions | Structure Function result
Category

[A" x AVERAGE( number 1; number 2; ... )

AVERAGE

Function

AMORDEGRC
AMORLINC Returns the average of a sample.
AND
ARABIC [
AREAS
ASC
ASIN
ASINH
ATAN
ATANZ
ATANH Formula Result W
AVEDEV

[AVERAGE = -
AVERAGEA

D

[«

0 amay Help ][ Cancel Next >> ] E oK

Now, you need to specify the numbers to which you want to apply the formula. To select the numbers,
you need to go back to the worksheet.

Click the Shrink button to shrink this dialogue box and return to the worksheet.

Figure 4.34. Shrinking the Function Wizard Dialogue Box

iy d

Functions | Structure AVERAGE Function result [#DIv/0!
Category Retums the average of a sample.
lStatisticaI = ]
Bt number 1{required)
AVEDEV [=] Numbe( 1. number 2:...are 1 to 30 numeric arguments representing a
AVERAGE opulation sample.
AVERAGEA
: B N —
BETADIST

Y S [ —

BETAINV
CHIDIST
CHiY mumbera (&[]
CHITEST
CONFIDENCE Formula Result [#Div/o!
CORREL —
COUNT =AVERAGE( ) =
COUNTA
COVAR =

Dy T T T

The Function Wizard dialogue box shrinks to allow you to view the worksheet. To select the cell

range, hold down the SHIFT key and use the mouse to select the cell range containing the desired
numbers.

After selecting the cells, you can go back to the Function wizard by clicking the Maximize button.
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Figure 4.35. Selecting the Cell Range
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5. The cell reference for the selected cell range automatically appears in the number 1 box and the
applied formula, complete with arguments, appears in the Formula box at the bottom of the dialogue
box. To complete the task of entering a formula, click OK.

Figure 4.36. Applying the Formula
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6. The solution appears in the cell where you had applied the formula.
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Figure 4.37. Final Output
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Inserting Charts. You can present your data in the form of charts or graphs to compare your data
series visually and view trends in the data. Calc offers you a number of ways to represent spreadsheet
data graphically.

Procedure 4.8. To insert a chart in your spreadsheet:

1.  Open a spreadsheet containing data and row and column headings, and select the data to be included
in the chart. Then, on the Insert menu, select Chart. The Chart Wizard dialogue box appears.

Figure 4.38. Launching the Chart Wizard
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Instructor Notes:

Advise students about the alternate way to insert a chart using the Insert Chart icon from
the Standard toolbar.

On the first page of the Chart wizard, you can select the chart type and preview the chart output.
Calc allows you to select from a wide range of 2D and 3D charts. You may decide to follow the rest
of the instructions of the Chart Wizard by clicking Next or you can click Finish to insert a chart in
your document.

Figure 4.39. Selecting the Chart Type

Steps Choose a chart type

FLIN |

TeoTTal

2. Data Range
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4. Chart Elements .
] 3D Look |Simple

[& Net

' Stock

il Column and Line B
Cylinder
Cone
Pyramid

[ Next >> } | FEinish | [ Cancel ]

The chart is inserted at the specified location in your spreadsheet. You can now move and resize the
chart and edit it further to suit your requirements.
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Figure 4.40. The Inserted Chart
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Exporting Spreadsheets to PDF. Like the other OpenOffice.org applications, you can export your
spreadsheets from Calc as PDF files. With OpenOffice.org you do not need any additional third party
software to convert your documents into PDF format.

Procedure 4.9. To export your spreadsheet as a PDF:

1. On the File menu, click Export as PDF. The Export dialogue box appears.
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Figure 4.41. Exporting Spreadsheet as PDF
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2. The four tabbed pages in this dialogue box allow you to define options, such as the pages to be
included in the PDF, the type of compression to be used and the level of security to be assigned to the
file. After defining these specifications, click Export to continue.

Figure 4.42. Defining PDF Options
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3. Provide a file name for your spreadsheet and navigate to the directory where you want to save it.
Click Save to export the spreadsheet as a PDF file.
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Figure 4.43. Saving as PDF
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Nice to Know:

To discover an Easter Egg tucked away in Calc, click within any of the cells of your
spreadsheet, type = GAME(" StarWars") and start playing right away.

4.  Your spreadsheet is now displayed as a PDF file.

Figure 4.44. The PDF file
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Using OpenOffice.org Impress

Impress is a fully featured presentation tool of the OpenOffice.org office software suite. It enables you to
create effective multimedia presentations by creating 2D and 3D clip art and images. It also allows you to
create special effects and animations by using high-impact drawing tools.

OpenOffice.org Impress is similar to Microsoft PowerPoint in its functionality. In addition to making it easy

for you to create PDF files from presentations, Impress lets you export the presentations into ShockWave
Flash (SWF) files. This enables you to run the output on any computer that has a Flash player installed.

Key Features of OpenOffice.org Impress

Some of the many useful features of Impress are:
Creating Vector Graphics: Impress comes bundled with various drawing tools that allow you to create
vector graphics from within the application. You can also export vector graphics to bitmap pictures and,

inversely, convert bitmap pictures into vector graphics.

Creating Slides: Choose from ready-to-use templates or use the drawing and diagram tools to jazz up
your slides. Master view adds the elements that you want to appear on all slides of your presentation.

Further, Impress users have the option to install the Open ClipArt library, which contains a huge selection
of images for free use.

Animations and effects help add spice to your presentations. You can render stunning 2D and 3D effects
to your text using Fontwork, which lets you create life-like 3D images easily.

Publishing Presentations: Impress allows you to publish presentations as handouts, export them into
PDF files, convert them into SWF files and publish them as HTML documents. This enables you to access
your presentation from a variety of platforms.

Saving Presentation in Other Formats: Similar to other OpenOffice.Org applications, Impress saves

your work in the international OpenDocument format. It also allows you to save your work in other formats
such as PowerPoint.

Creating Multi-Media Presentations

Procedure 4.10. Creating, Viewing and Printing a Presentation
To create and view presentations using OpenOffice.org Impress:

1.  On the Applications menu, point to Office and then click OpenOffice.org Presentation.
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Figure 4.45. Launching Impress
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W Office
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2. The Presentation Wizard dialogue box appears. The Presentation wizard allows you to define the
basic structure of a presentation in three brief steps. You can either continue defining the specifications
as guided by the Presentation Wizard or immediately create a new blank presentation by clicking
Create.

Figure 4.46. Using the Presentation Wizard

=) Presentation Wizard x
==
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@ Empty presentation
() Erom template

() Open existing presentation

Preview
[ Don't show this wizard again

Help ] [ Cancel I | | [ Next >> ] I Create

Nice to Know:

To be able to preview the slide template, slide design and slide transition effects, leave the
Preview check box selected.

3. This figure shows the main Impress window with an empty presentation. From the Task pane on the
left, you can select a layout for your current slide.
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Figure 4.47. The Impress Window
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Enter the required text in the provided text boxes to create the first slide. To make your presentation
more attractive and professional looking, you can either change the background and format the font
size and colour for each slide or simply select a pre-defined template from the Master Pages panel.

Click Master Pages to open the Master Pages panel.

Figure 4.48. Opening the Master Pages Panel
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A number of templates are available on the Master Pages panel. Select the template of your choice
to apply a whole new look to your presentation. You can enhance the look of the presentation further
by adding various elements, such as objects, pictures and animated images, from the Insert menu.
Alternatively, you can start adding new slides to the presentation.
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7.

You can add a new slide by clicking the Slide button
Slide on the Insert menu.

Figure 4.49. Selecting a Slide Template

on the Standard toolbar. Alternatively, click

I ed 1 -~ 0Openo grorg

File Edit View Insert Format Tools Slide Show Window Help

H-@Ee B &

A9 -& g7 T

Wind Enargy

x

Slide Sorter

INormaI | Outline

Notes ] Handout

Tasks

-« Master Pages

2] poocm [3] (mmBlack 2| 3 [Colour 1 |Bues 3| O

View -

Wind Energy

slide 1 |
Al I \ [
R~ — T -L-=-0- - F- &
4+ -0.53/3.81 : 0.00 x0.00 25% | *

.i.i
;
[v]

I Layouts
» Custom Animation
p Slide Transition

K- D2 W]

Slide1/1

prs-strategy

The inserted slide is also formatted as the first slide because that is the layout you selected last.
According to the requirements of your presentation, you can select a new format from the Layout

pane. The new layout has two columns, one for text

and the other for images. This allows you to

display text along with an associated image on the same slide. Enter the textual content in the provided
text boxes, then double-click the house icon to insert a graphic in the provided placeholder.

Figure 4.50. Selecting a Slide Layout
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In the Insert Picture dialogue box, select the desired image and click Open to insert it into your slide.
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Figure 4.51. Inserting Picture in a Slide
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Notice that the inserted picture is automatically resized to fit into the provided space. You can also
insert an image by selecting Picture from the Insert menu. A picture inserted in this way is not
automatically resized, but you can move and resize it as needed. You can insert new slides in a similar
fashion.

Now, you are ready to display your presentation as a slide show. To configure the basic slide show

setting, select Slide Show Settings from the Slide Show menu.

Figure 4.52. Setting up a Slide Show
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The Slide Show dialogue box helps you define the basic settings for your slide show. In the Range
section, you can specify the slides to be included in the presentation and their order of display. In the
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10.

11.

12.

Type section, you can define how to display the slides. Similarly, the Options section allows you to
define various other settings for your presentation.

After selecting the desired options, click OK to apply the settings.

Figure 4.53. Configuring the Slide Show Settings
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To start the slide show select Slide Show from the Slide Show menu or press F5.

Figure 4.54. Starting the Slide Show
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The presentation can be viewed as a running slide show. When you reach the last slide of the
presentation, you are prompted to exit the presentation by clicking once. However, you can exit a
slide show at any point of time by pressing ESC.

You can choose to print your slides with notes, as an outline, with page numbers, with date and time
and so on. To do this, select Print from the File menu.
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Figure 4.55. Printing the Presentation
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13. You can use the Print dialogue box to further define printer settings or accept the default settings,
and click OK to start printing your presentation.

Figure 4.56. Defining Printer Settings
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Procedure 4.11. Animating Objects and 3D Objects
To create a presentation with 3D effects and animations:

1. Open a new presentation in which you want to use 3D graphics and animations, and select a suitable
template from the Master pages panel. Now, you can start adding elements to your presentation to
spice it up. Begin with placing the title of your presentation on the first slide.

To create an eye-catching display for the title text, you can use one of the many wonderful text tools
available in Impress. One of these is Fontwork, which enables you to create special 3D effects to
your text. To start using Fontwork, on the Drawing toolbar, click the Fontwork Gallery button. The
Fontwork Gallery window appears.
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Figure 4.57. Opening Fontwork Gallery
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2. Select the style in which you want the title text to be displayed, and click OK.

Figure 4.58. Selecting a Fontwork Style
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3. The text Fontwork, in the selected style, appears on the slide as an object. To display the title text
in place of the Fontwork object, double-click the object and type the title text in place of the black
Fontwork that appears over the object. Click outside the object's selected area to exit the Fontwork
edit mode.
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4.

Figure 4.59. Editing the Fontwork Object
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You can go ahead and do the same on the other slides too by inserting 3D images and animating them.

Figure 4.60. The 3D Text
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You can insert 3D graphic objects in your presentation from the 3D-Objects toolbar. By default, this
toolbar is not displayed on the Drawing toolbar. To display the 3D-Objects toolbar, on the View menu,
point to Toolbars and then click 3D-Objects.

Figure 4.61. Inserting 3D Graphics
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Nice to Know:

You can also display the 3D-Objects toolbar by clicking the small arrow at the end of the
Drawing toolbar and selecting it from the Visible Buttons list.

The 3D-Objects toolbar appears as a floating toolbar. If you do not like floating toolbars, you can

place it on one of the existing toolbars. To dock the 3D-Objects toolbar, drag the title bar of the
toolbar to the desired location and release the mouse button.

Figure 4.62. The 3D-Objects Toolbar
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The 3D-Objects toolbar is now attached to the Line and Filling toolbar. You can pick up objects
from this toolbar and insert them into your slides. To insert a 3D Object on your current slide, click
the desired object on the 3 D-Objects toolbar. Then, move your mouse to the point where you want
to insert the object. You can see a plus sign in place of the mouse tip. Holding down the left mouse
button, drag the mouse to insert the object on the slide. The selected 3D object appears on the slide.
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Figure 4.63. Inserting a 3D Object
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You can change the proportion and size of the object by holding the green handles that appear around
it. Impress also provides you tools to apply a number of 3D effects on the object to modify its look
and feel as per your requirements. To apply 3D effects on the inserted graphic, right-click the object.
On the short-cut menu, click 3D Effects. The 3D Effects dialogue box opens.

Figure 4.64. Applying 3D Effects
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9.  You can use the options available under the different buttons in this dialogue box to define the look
and feel of the inserted object. Click the Illumination button to fine- tune the illumination effect
on the object. You can select the appropriate options from the drop-down lists to render the desired
illumination effect to the object. Alternatively, you can simply drag the white dot in the graphic at the
bottom of the dialogue box and move it to get the desired effect.

10. After specifying the desired options, click the Assign icon on the top right of the dialogue box to
apply the effects on the selected object. Click Close to exit the 3D Effects dialogue box.

Figure 4.65. Defining 3D Effects
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Instructor Notes:

If you have enough time, you can also demonstrate the procedure of converting 2D objects
into 3D objects and applying the finer 3D effects to it.

11. Notice that with a couple of mouse clicks, the 3D object takes on a completely new look. In a similar
fashion, you can add many more 3D and 2D elements to your presentation and apply various 3D
effects to jazz it up. Impress also offers some animation functionality to help you bring life to your
presentations. To display the animation options available in Impress, on the Slide Show menu, click
Custom Animation.

The Custom Animations panel now appears on the right edge of the presentation window.
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Figure 4.66. Applying Custom Animation
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12. To apply an animation effect on an individual element in your slide, select that element and click the
Add button on the Custom Animation panel. The Custom Animation dialogue box opens.
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Figure 4.67. Animating Objects
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13. You can now apply various animations to the selected object, define the entrance and exit animation
for it and chart a motion path for the object. Similarly, you can specify animation effects for other
elements on the slides.

After defining all the desired settings for the object, click OK to apply the animation effects.

Figure 4.68. Customising Animation Effects
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14. The specified animations can be viewed at the bottom of the Custom Animations panel. You can
now view the animation effects in a slide show. Click the Slide Show button to view the presentation

as a slide show.
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Figure 4.69. Launching a Slide Show
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15. Your presentation runs as a spectacular and lively slide show.

Figure 4.70. The spectacular Slide Show
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Exporting a Presentation. As stated earlier, another useful feature associated with Impress is that it has
the built-in capacity to export presentations directly into several other file formats. As a result, Impress

allows you to export your slide shows directly as Flash (SWF) files.

Procedure 4.12. To export your presentation as an SWF file:

1. On the File menu, click Export. This opens the Export dialogue box.

Figure 4.71. Exporting a Presentation
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2. Here, you need to specify a file name in the Name field and navigate to the directory where you want
to export the file. To export the presentation as a Flash file, select Macromedia Flash (SWF) (.swf)
from the file type drop-down list and click Save. The file is exported to the indicated location. You

can now view the presentation as a Flash file.
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Figure 4.72. Exporting Presentation as a Flash File
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Using OpenOffice.org Draw

Draw is a vector graphics drawing tool that enables you to create simple and complex drawings and export
them in a number of common image formats. Draw also allows you to insert tables, charts, formulas and
other items created in OpenOffice.org programmes into your drawings.

Note:

Graphics that are created using a vector graphics drawing tool do not blur when resized.

Draw is integrated with the OpenOffice.org suite, making it easy toexchange of graphics with other
components of the suite. For example, if you create an image in Draw, reusing it in Writer is as simple as
copying and pasting the image. A subset of the functions in Draw are also available in Writer and Impress,
so you do not have to switch back and forth between them and Draw to perform basic image manipulations.

Key Features of OpenOffice.org Draw

Note:

Vector drawing software follows a common notation for referring to all shapes, whether simple
lines, rectangles or more complicated shapes, as objects.

Draw provides extensive functionality that integrates more functions than the majority of drawing tools
available in office suites. Some of the key features of Draw are:

* Vector Graphics Creation. : You can create vector graphics in Draw by using the lines and curves
defined by mathematical vectors. Vectors describe lines, ellipses and polygons according to their

geometry.

* 3D Objects Creation. : In Draw, you can create simple 3D objects, such as cubes, spheres and
cylinders, and modify the light source of the objects.
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* Grids and Guides: You can align objects in your drawing by using grids and guides as visual cues.
You can also snap an object to a grid line, a guide or to the edge of another object.

+ Connecting Objects to Show Relationships: You can attach objects to each other using special lines
called connectors to show the relationship between those objects. Connectors attach to glue points on
drawing objects and remain attached when those objects move. These are useful for creating things like
organisation charts and technical diagrams.

+ Displaying Dimensions: You can use dimension lines to calculate and display linear dimensions in
technical diagrams, which often show the dimensions of the objects in the drawing.

* Gallery: You can insert and use images, animations, sounds and other items from the OpenOffice.org
gallery in your drawings as well as in other OpenOffice.org programmes.

* Graphic File Formats: Export your creation to many common graphic file formats, such as BMP,
GIF, JPG and PNG.

Performing Basic Drawing Operations

Procedure 4.13. To launch OpenOffice.org Draw:
1. On the Applications menu, select Graphics and then OpenOffice.org Drawing.

The main components of the Draw window are shown in the following graphic:
Figure 4.73. The Draw Window
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2. The drawings are created in the drawing area, which is surrounded by the following toolbars:

* The Menu bar lists the main menus available in Draw. It includes options to manage, edit and view
the format of your drawings.

* The Function bar displays icons to perform tasks such as Open, Save, Copy, Cut and Paste.
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* The Line and Filling bar includes specific drawing tools to modify the appearance of a selected
object such as line style, colour and thickness; fill style and colour.

+ The Drawing toolbar is the most important toolbar in Draw. It contains all the necessary functions
for drawing various geometric and freehand shapes. Creating basic shapes in Draw requires the
extensive use of this toolbar. However, you have to further edit, combine and manipulate them to
create complex objects.

You can vary the number and position of the visible tools to make the interface look a bit different.
To add or remove a toolbar from the Draw window:

On the View menu, point to Toolbars. The Toolbar list displays the toolbars available, with a check
mark next to the toolbars that are displayed. To remove a toolbar from the Draw window, clear the
corresponding check mark and click the toolbar without a check mark to add it to the window.

Procedure 4.14. Creating Objects

To create an object by using the Drawing toolbar:

1.

Click a specific object button such as Rectangle or Ellipse on the Drawing toolbar, and place the
mouse cursor at the point in the drawing area where you want the object to start.

Press the left button on the mouse, drag the cursor to where you want the object to end and release
the button. The object appears in the Drawing area.

Instructor Notes:

The Drawing toolbar is not discussed in detail because you use its options to draw only basic
shapes. For novice users, demonstrate the creation of a few objects, such as square, rectangle
and connector. Visit http://documentation.openoffice.org/ for more details on OpenOfice.org
products.

Selecting Objects. Before making any changes to an object, you need to select the object. Draw provides
the following options to select an object:

Direct Selection: Click the object to select it.

Selection by Framing: On the Drawing toolbar, click the Select button and drag a large rectangle around
the object to select it. This option is useful for selecting multiple objects in the drawing area.

Note:

You have to enclose the object(s) completely in the rectangle to select them.

Figure 4.74. Selecting by Framing

]
.

+ Selecting hidden objects: To select an object that is covered by another object, press Alt key and click

the object you want to select.
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Note:

To be able to select a hidden object, you must know the position of that object relative to the
objects on top.

Editing Objects. When creating objects, you may have to edit them or change their properties to get
the desired output. However, you may not always find that flexibility in the default software settings. For
example, you cannot change the shape of the square to a rectangle or rotate the square on its own axis by
using the default Drawing toolbar. To perform these tasks, Draw provides various other options with the
required flexibility, such as:

Note:

All the options covered in the subsequent sections apply to a selected object or a group of objects.
You can identify a selected object from any other by the small, coloured square or circle around
the object. These squares or circles are called handles and form a rectangular frame that is just
big enough to contain the object.

Procedure 4.15. Modifying Object Size

1. Inthe Drawing area, select the created object by clicking it. Handles appear on the object.

Figure 4.75. Selecting an Object

2. Place the mouse cursor over one of the handles. When the cursor becomes a double-headed arrow,
drag the cursor in the direction of the arrow to modify the size of the object. If you choose a corner
handle, you will resize the object along two axes at the same time. If you use a side handle, the objects
will only be resized along one axis. The outline of the resulting new object appears as a dotted line.

3. Release the mouse button when the object is sized correctly. The dotted line disappears, and the
resized object appears.

Figure 4.76. Modifying the Object
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Arranging Objects. If the document you are working on includes many overlapping objects, editing of
individual objects (which may or may not be visible) might pose a challenge. Fortunately, Draw provides
a way to rearrange objects without affecting their layout.

Procedure 4.16. To change the arrangement of objects:

1. In the drawing area, right-click the object you want to rearrange, point to Arrange and select the
appropriate option from the Arrange list.

Figure 4.77. Rearranging the Object
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2. If you select the Send Backward option, the output is as shown in the following graphic:

Figure 4.78. Object Sent Backwards

[]

Instructor Notes:

If time permits, ask the students to explore the other options in the Arrange list. In addition,
explain which option to use under what circumstances. Specifically discuss the Behind
Object option and the difference between the output from the Send to Back and Behind
Object options. This is a low-priority activity.

Duplicating Objects. Often, you may need to create multiple objects of the same shape and size. In
Draw, you can duplicate or make multiple copies of an object. The copies can be identical or differ in size,
colour, orientation and location.
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Procedure 4.17. To create multiple copies of an object:

1. Click the object to be copied, click Edit and select the Duplicate option. The Duplicate dialogue
box opens.

2. Specify the appropriate values in the Duplicate dialogue box, and click OK to display the output in
the drawing area.

Figure 4.79. Duplicating Objects
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Grouping and Combining Objects. When creating or editing an object, the object might be displaced
from its original position. This change in location disturbs the relative position of the object to the others in
the drawing. This could be critical where accuracy, in terms of position, is important such as in architectural
drawings. Using Draw, you can combine drawing objects in two distinct ways, grouping and combining.

Grouping Objects. Grouping objects is like putting them into a container, where the objects are grouped
with each other but retain their individual identities. You can move the group as one entity and apply
changes to all the enclosed objects. A group can always be undone, and the objects that constitute the
group can always be manipulated separately.

Procedure 4.18. To group objects:

1. Inthe Drawing area, select all the objects you want to include in the group. Right click any selected
object, and then select the Group option.

2. Click any object in the group; handles appear around the entire group instead of around an object.
You can now modify the entire group, without applying effects to objects individually. To resize a group:

* Place the mouse cursor over one of the handles. When the cursor becomes a double-headed arrow, drag
the cursor to increase or decrease the size of the objects in the group. All the objects in the group are
resized equally.

Procedure 4.19. You can also edit a single object in the group without breaking it.
To edit individual objects in a group:

1. Double-click an object in the group. You can now enter the group and work on individual objects.

2. Click the object you want to edit; the handles appear around that object. In this mode, you can edit,
add or delete this object.
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To re-instate the group after modifying the object, double-click anywhere outside the selection frame.

Note:

You can group objects of all shapes and sizes. You can group objects in 2D, 3D or a combination
of both. However, you can combine only overlapping 2D objects.

Combining Objects. Combining drawing objects is similar to grouping, except that combining creates

a permanent fusion of objects, leading to the formation of a new object. The original objects are no longer
available as individual entities, and you cannot enter the group to edit the individual objects. When you
combine the objects, the group takes on the properties of the lower-most object in the arrangement.

Procedure 4.20. To combine objects:

1.

In the drawing area, select multiple 2D objects.

Note:

The lower-most object in the following graphic is the blue object.

Figure 4.80. Combining Objects

Right-click any of the objects in the selection and click the Combine option in the list. Where the
objects overlap, the overlapping zone is either filled or empty, depending on the number of overlaps.
When the number of overlaps is even, you get an empty space. When the number of overlaps is odd,
you get a filled area.

Figure 4.81. The Overlapping Zone

After you have combined the objects, you can select the combined objects as an entity. However, you
will not be able to select the empty area in the object.

To split the objects:

+ In the Drawing area, right-click the combination created in the previous procedure and select the Split

option from the list.
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Figure 4.82. Splitting Objects

Note that the objects return to their original status. However, the properties of the objects have now
changed as per the last object in the arrangement.

Editing Colours and Textures. When creating a drawing, you may need to work with objects of variable
colours and textures in the same drawing area. You can customise the area fill of an object by using the
Line and Fill toolbar.

Note:

The OpenOffice.org term for the inside of an object is area fill. The area fill of an object can be

of uniform colour, a gradient or an image.

Procedure 4.21. Editing a Colour Fill

To edit the colour fill of an object:

1.

2.

In the drawing area, select the object you want to edit and click the Area button on the Line and Fill

toolbar. The Area dialogue box opens.

Figure 4.83. Editing a Colour Fill
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The Area dialogue box provides the option to change the existing colour fill of the object. Click the
Colours tab, select a colour listed under the Table category and click OK to apply the change.

140



Using OpenOffice Applications

3.

Figure 4.84. Selecting a Colour Fill
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The Table category lists the standard colours or the colours that are used most often. However, if you
need a colour or shade that is not available in the list, go ahead and create it! To define a custom colour:

a. Click the standard colour closest to your needs, and specify the RGB ratio to change its tone
and hue.

Note:

Draw provides you two options to define a colour. You can specify the colour in the
RGB or CMYK ratio. For CMYK, click RGB and then select CMYK from the options.

b. If you want to add a new custom colour to the available list, type its name in the Name box,
specify the RGB ratio and click Add. The standard list under the Table category displays the
new colour.

141



Using OpenOffice Applications

Nice to Know:

Every colour is specified by a combination of the three primary colours, Red, Green
and Blue, hence the notation RGB.

c¢. Click OK to apply the change.

Figure 4.85. The Customised Colour Fill

Editing a Gradient Fill. A gradient is a smooth transition between two different colours or shades of
the same colour, which you can apply to a drawing object. To edit the gradient fill of an object:

In the Drawing area, select the object you want to edit and click the Area button on the Line and Fill
toolbar. The Area dialogue box opens.

Click the Gradients tab, select a gradient from the gradient list and click OK to apply the change to the
object.

Figure 4.86. Editing a Gradient Fill

Instructor Notes:

Mention that by using the Area dialogue box, students can also add or modify the other
properties of objects such as using a shadow on an object, increasing or decreasing transparency,
crosshatching the object or adding their own bitmap images as the area fill of the object.

Editing Text. Draw provides you the following options to insert text in the Drawing area:

+ The Text tool on the Drawing toolbar: You can create a text frame anywhere in the drawing area, and
you can work with this text box like you do with any other object.

+ Callouts next to the object: You can use this when you want to relate the text to the object. Click the
Callouts tool on the Drawing toolbar.

+ Text superimposed on a drawing object: Double-click the object. A text box opens. Type the necessary
text in it.

The following graphic displays various options for inserting text relevant to an object in the Drawing area:
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Figure 4.87. Editing Text in the Drawing Area

Callout related to

. . the star
Star written using

the Text Tool

Visual Effects. Apart from offering the basic drawing tools, Draw provides scope for you to add some
visual effects to your drawings.

Cross-Fading. The cross-fading feature in Draw transforms one shape into another. The result is a new
group of objects, including the start and end objects and the intermediate shapes.

Procedure 4.22. To cross-fade:
1. Create two objects of different shapes in the drawing area and select them.

Figure 4.88. Applying Visual Effects

2. On the Edit menu, click the Cross-fading option to display the Cross-fading dialogue box.

3. Inthe Cross-fading dialogue box, select the number of incremental objects between the ends. Retain
the default selection for smoother transition, and click OK to display the result in the drawing area.

Figure 4.89. Cross-Faded Objects

Note:

You can vary the order of the objects by changing their arrangement in the drawing area.
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Instructor Notes:

Draw provides many more features and tools. For more information on the detailed
features of Draw and other OpenOffice.org applications, refer the students to http:/
documentation.openoffice.org/.

Using OpenOffice.org Math

Math is the equation writer component of OpenOffice.org office software suite. It contains a number
of functions, operators and formatting assistants to help you create properly formatted equations and
formulae. These formulae can then be imported for display in any other OpenOffice.org applications.

Key Features of OpenOffice.org Math

Some of the important features and capabilities of Math are discussed in the following section:

Creating a Formula: Math offers you the convenience of creating formulae as objects within your
document. You can invoke Math from inside a document whenever you need to insert a formula or
equation into the document. With Math, you have a large selection of pre-defined symbols and functions
at your disposal for creating, editing and formatting a formulae.

Typing a Formula Directly: If you are familiar with the Math markup language, you can also type
an equation directly in your document and then invoke Math to convert the markup into a formatted
formula.

Creating a Formula in the Commands Window: While you make entries in the commands window,
you can simultaneously view the results in the document.

Creating Individual Symbols: Why not create or own symbols and import new characters from
other fonts? You can add the new symbols in the basic math catalogue or create a new catalogue for
the new symbols.

Creating Formulae in Context: Math provides you the ease of working with the context menus,

which can be displayed at a right mouse-click. These context menus contain all commands that are found
on the Selection window. Moreover, you can insert these into the document with just a mouse click.

Note:

Math is only used to create properly formatted equations in its symbolic form. It cannot be used
for calculation purposes.

Creating and Editing Formulae

Though Math can be used with all the OpenOffice.org applications, it is primarily used as an equation
editor with text documents.

Procedure 4.23. To be able to use Math when working with Writer perform the
following steps:

1.

Position the cursor on the document where you want to insert the formula. On the Insert menu, point
to Object and then click Formula.
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Figure 4.90. Launching Math
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2. This invokes Math from inside the Writer window. Notice that the equation editor appears at the
bottom of the document window. You can now access all the Math tools from inside the Writer
window. A placeholder box appears besides the text where the equation is to be entered.

The simplest method to enter an equation in your document is to use the Selection window. By default,
the Selection window is not displayed. To display the Selection window, on the View menu, click
Selection.

Figure 4.91. Displaying the Selection Window
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3. The Selection window appears as a floating toolbar. Notice that the Selection window is divided into
two halves. The upper half contains the symbol categories, and the lower half displays the symbols
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available in the selected category. You can now start inserting the equation by selecting the symbols
from the Selection window.

To insert a symbol, such as "a/b" select the appropriate category from the upper half and click the
appropriate symbol from the lower half of the Selection window.

Figure 4.92. Using the Selection Window
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You will notice that when you select the symbol on the Selection window, the markup for the selected
symbol appears in the equation editor. Simultaneously, some grey boxes appear in the main text body.

The <?> symbols appearing in the equation editor are placeholders where you need to enter the actual
text or symbol associated with your formula.
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7.

Figure 4.93. Inserting Symbols
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As you enter the required text or symbol into the placeholders, the grey boxes are simultaneously
updated with the equation. You can enter the rest of the equation in the same fashion.

Once you enter the complete equation using the Selection window, the equation appears as an object

in your document window and you can view the complete markup for the equation in the equation
editor. Exit the formula editor by clicking anywhere on the document body.

Figure 4.94. The Inserted Equation
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Once the formula is inserted in your document, you may want to modify it further. To edit a formula
right-click once on it and select Edit from the short-cut menu.
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Figure 4.95. Editing Equation
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Now you can insert new symbols into your formula or delete ones you no longer need.

Figure 4.96. Inserting New Symbols
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Though Greek characters are widely used in mathematical formulae, especially geometric formulae,
these characters are not available in either the Selection window or the Context menu.

You can enter Greek characters by typing the markup language for them in the equation editor.
Alternatively, you can use the Catalog window. To display the Catalog window, on the Tools menu,
click Catalog.
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Figure 4.97. Launching the Catalogue Window
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The Symbols dialogue box is displayed. Before selecting a character, ensure that Greek is selected
under the Symbol set drop-down window. Select the required Greek character from the Symbols
window and click Insert.

Figure 4.98. Inserting Greek Symbols
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The character is inserted into your document and the markup is displayed in the equation editor. You
can continue entering formulas into your document following the same procedure. Once you have
entered all the required formulae, your document may appear like this:
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Figure 4.99. Final Equations
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Additional Applications

GnuCash Accounting

GnuCash is an application that helps you track home or small business finances. Instead of tracking all
your expenses on paper, you can use GnuCash to ensure that you don't lose any information at the end
of the month. All details of income and expenditure can be managed with this utility. Using GnuCash, a
small business can track its customers as well as its vendors by entering their details. You can also create
a monthly profit/loss report for your business.

GnuCash can store and manage the details of all your bank accounts in one place. GnuCash is based on
double-entry bookkeeping (the sort that trained, professional accountants use) to ensure balanced accounts

and accurate reports.

GnuCash is easy to use and can be tailored as per your needs.
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Figure 4.100. The GnuCash Accounting Application
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Key Features of the GnuCash Application. Using GnuCash is like filling your personal finance
information in a register but in a more organised way. The following features make GnuCash a very useful,
powerful, yet flexible software programme:

+ Easy-to-Use Interface: The interface of GnuCash is as simple to use as keeping records on a piece of
paper. It also has a Quick-Fill feature, which means that as soon as you type a few characters, GnuCash
scans its list and completes the entry automatically. If you use an entry on a regular basis, you don't
need to type it every time.

* Double Entry System: Following the principles of double-entry accounting, in GnuCash each
transaction has to be mentioned in two places -- debit in one account and credit in another. This means
that the difference between income and expenses exactly equals the sum of all assets and equity. This
will help you verify that you have entered the details of the income and expenses accurately, which, in
turn, will also help you track all expenses.

* Reports: You can generate a vast range of reports using GnuCash. Home users can generate a Budget
report, which will give them a clear view of the income and expenses for the month. You can also
generate a Tax report for calculating tax based on tax-related income and expenses. A vast range of
Business reports, such as Customer and Vendor reports, can also be generated. Another report that can
be generated is the Assets and Liabilities report, which includes the balance sheet.

¢ Multi-Currency Transaction Handling: You need not worry about transactions in different currencies;
GnuCash automatically handles currency conversions. In addition, GnuCash provides menus and pop-
up windows in different languages.

* The Reconcile Window: GnuCash provides the Reconcile window, which contains the balances of all
your accounts. As a result, you don't have to check the balances in various registers. Using this window,
you can easily validate bank statements.

+ Split Transactions: The split transaction feature allows you to split a transaction into multiple amounts
and categories. For example, you purchase a few things, which can be divided into different categories,
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from a store. Here, the main transaction is the amount spent on the purchase of these items, and the split
transaction consists of the entries of all the items on the split transaction editor screen. You can re-check
the main transaction at any time by simply displaying the split transaction entries.

HBCI Support: GnuCash also supports the German Home Banking Computer Information (HBCI)
protocol. This feature is useful for German users who need not enter the details of their bank account
manually. They can directly perform online bank account transfers, download bank statements and make
direct debits.

Scheduled Transactions: Users can schedule transactions in GnuCash as per their requirements, and
they can also set a reminder for the transactions. This feature does not require you to remember which
transaction needs to run at what time. The software will automatically keep track of the transaction and
run the transaction at the scheduled time. You can also re-schedule the transactions, when required.

Transaction Finder: The Transaction Finder dialogue box helps you locate even the smallest
transaction. You can enter the relevant fields in the Transaction Finder window, and GnuCash will find
the transaction for you. For example, you want to identify all expenses above a certain amount this
month. GnuCash will be able to identify these transactions. You need to mention the transaction as
greater than and the amount in the amount field.

New User Manual and Help: GnuCash provides a new Tutorial and Concepts guide to give an overview
of the accounting principles to new users. This helps the users apply the principles effectively and gives
them the exact procedure of each task.

Lesson Summary

In this lesson, you learned that:

OpenOffice.org is the default office application suite provided with Ubuntu.
The OpenOffice.org sofware suite contains five applications to help you handle your work effectively.

Writer forms the word processor component of the OpenOffice.org office software suite and contains
all the features that you expect from a modern, fully equipped word processor.

Calc forms the spreadsheet component of the OpenOffice.org office software suite and offers a whole
range of advanced functions to help accomplish complex tasks.

Impress is a fully featured presentation tool included in the OpenOffice.org office software suite.
Math is the equation writer component of OpenOffice.org office software suite.

GnuCash is extremely useful application software for managing your home and/or small business
finances.

Review Exercise

Question: List the applications included in the OpenOffice.org office software suite.

Answer: The applications included in the OpenOffice.org office software suite are:

OpenOffice.org Writer

OpenOffice.org Calc
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* OpenOffice.org Impress
* OpenOffice.org Draw
* OpenOffice.org Base
+ OpenOffice.org Math

Question: The applications in OpenOffice.org save files in which format, by default?a) SWFb) PDFc)
ODF

Answer: c) OpenDocument Format (ODF)

Question: Name the equation editor component of the OpenOffice.org software suite.
Answer: OpenOffice.org Math.

Question: Which software feature help you create multiple personalised form letters?

Answer: The Mail merge feature in Writer allows you to create multiple personalised form letters,
labels, envelopes, faxes, e-mail messages by using a form letter template and an address database.

Question: Which software feature in available OpenOffice.org helps you navigate inside your
document?

Answer: The Navigator feature available in OpenOffice.org provides you an outline view of your entire
document and allows you to quickly navigate inside your document.

Question: Name the feature in the Openoffice.org software suite that allows you to perform a complete
document makeover?

Answer: The Style and Formatting window.

Question: Do you require any additional software to convert a OpenOffice.org document into a PDF
file?

Answer: The OpenOffice.org software suite allows you to save your document directly as a Portable
Document Format (PDF) file without the use of any additional expensive software.

Question: Name the software tool that guide you through the creation of a formula in OpenOffice.org
Calc.

Answer: The Function Wizard

Question: Math allows you to type your formula directly into the document if you are familiar with
the ?

Answer: Math markup language

Question: Name the feature available in OpenOffice.org Impress that allows you to create textwith
stunning 3D effects?

Answer: The Fontwork Gallery

Question: Which feature of GnuCash helps you look for a transaction using a Query window?1. Split
transaction2. Scheduled transaction3. Transaction finder4. Reconcile window

Answer: 3. Transaction finder
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Lab Exercise

Exercise 1: Performing BasicWord Processing Tasks Using Writer. As an employee in an interior
decorating company, you have been asked to prepare an chapter on interior decoration that would feature
in the company's e-newlsetter. You have been quite upbeat about the assignment as it would showcase
your abilities to the fore. However, you will have to prepare the chapter in the most aesthetically pleasing
manner as possible. You plan to include lots of text, equally supported by some graphics and tables all
aligned to live up to the highly aesthetic sensibilities of the company employees.

To complete your assignment, you need to perform the following tasks:
* Create and format a text document

+ Insert tables in the document

* insert images in the document

« Save the document

Procedure 4.24. To create and format a text document:

1.  On the Applications menu, point to Office and then click OpenOffice.org Word Processor.

2.  Enter the required text in the blank document.

3. On the Format menu, click Style and Formatting to display the Style and Formatting window.

4. On the Style and Formatting window, click a style category to reveal the various styles under that
category.

5.  Select the text on which you want to apply the style and formatting.

6. Double-click the desired style displayed in the Style and Formatting window to apply it on the
selected text.

7. Repeat the same procedure to apply different styles and formatting for different components of the
document.

You have created and formatted your document according to your requirements.

Procedure 4.25. To insert tables in the document:

1. Position the cursor at the appropriate location in the document where you want to insert the table.
2. On the Table menu, point to Insert and then click Table

3.  Specify the table properties and click OK.

4. To display the Table Format dialogue box, right-click the inserted table and select Table from the
short-cut menu.

5. Define the table specifications per your requirements and preferences in the Table Format dialogue
box and click OK to apply the changes.

You have successfully inserted tables in your text document. You can now populate the tables with
the required data.
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Procedure 4.26. To insert images in the document:

1. Position the cursor at the appropriate location in the document where you want the picture to be
inserted.

2. On the Insert menu, point to Picture, then click From File.

3. In the Insert Picture dialogue box, navigate to the desired file, select the file and then, click Open.
4. To resize the inserted image, select the image, then press and hold the SHIFT key.

5. Holding down the SHIFT key, click and drag one of the handles on the image to modify its size.

6. To arrange and align the image properly, right-click the image, then select from the available options
on the short-cut menu.

7. Define the appropriate positioning options for the image.

8. The image is now inserted properly into your text document.

Procedure 4.27. To save the document:
1. On the File menu click Save As.
2. In the Save dialogue box, Navigate to the directory where you want to save the file.
3.  Enter the file name in the Name field.
4. Specify the file type by selecting from the drop-down menu at the bottom of the dialogue box.
5. Click Save to save the file.
You have successfully saved your document at the desired location.

Exercise 2: Performing Basic Spreadsheet Tasks Using Calc. As the accounts manager for your
company, you are assigned with the task of preparing the quarterly accounts report for the company. You
have been suddenly burdened with the task of collating a huge amount of data, analyzing the data to
derive the required reports, present the data before the management and generate the reports in PDF format
for documentation and future reference. In order to accomplish this feat, you shall have to perform the
following tasks:

+ Entering and format the data in a spreadsheet
+ Apply formulas and functions on the data

* Present the data graphically

» Generate the report in PDF format

To enter and format the data in a spreadsheet:

* On the Applications menu, point to Office and then click OpenOffice.org Spreadsheet to open a Calc
spreadsheet.

 Enter the required data in the spreadsheet.

 To apply desired formatting to a selected range of cells, on the Format menu, click Cells.
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The Format Cells dialogue box is displayed. Use the various options available under the Font, Font
Effects and Alignment tabs to specify various formatting attributes for the selected text.

Click Ok to apply the formatting effects.
To apply Autoformat to a sheet or selected cell range, on the Format menu, click Autoformat.

To assign a preset format to the selected cells, select one from the Format list and then click OK to
apply the selected format on the selection.

You have successfully entered your data in a spreadsheet and applied the desired formatting to it.

To apply formulas and functions on the data:

Select the cell in your spreadsheet where you want the formula to be inserted.

To create and apply a formula or function with the help of Function Wizard, click Function Wizard
on the Formula Bar.

Select the desired function category from the Category drop-down list to display the functions listed
under that specific category.

Find the desired function from the Functions list and click it once to select it.
Click Next to proceed with the task of entering a formula.

To specify the cell range on which you want to apply the formula, click the Shrink button. This shrinks
the FunctionWizard dialogue box and you are returned to the main spreadsheet window.

Select the cell range containing the desired data.
After selecting the cells, go back to the Function Wizard by clicking the Maximize button.
To complete the task of entering a formula, click OK.

You have successfully applied a formula on the data. The solution appears in the cell where you had
applied the formula.

To present your data graphically:

On the Insert menu, select Chart.

Define the data range, the labels and the target sheet where the chart would be displayed
Click Next to continue.

Select the chart type and click Next to continue with the procedure of inserting charts.
Specify a variant for the selected graph type and click Next to continue

Specify the main title for your chart and title and labels for the axes. After specifying the required
information, click Create.

A chart is inserted at the specified location in your spreadsheet. You have successfully displayed your
data in the form of a chart.

To generate a PDF file of the report:

On the File menu, click Export as PDF.
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+ Enter a file name in the Name field on the Export dialogue box

+ Navigate to the directory where you want to save the file.

+ Click Save to continue.

+ Define the desired options on the PDF Options dialogue box, then click OK.
You have successfully exported your spreadsheet as a PDF file.

Exercise 3: Creating Multimedia Presentation Using Impress. In your job profile as a trainer in an
architecture firm, you are required to develop a presentation on architectural designs and plans, which shall
be used as training material for the new joins. You want your training material to effectively demonstrate
all the dimensional details of your architectural designs, which may include floor plans, elevations and
siteplans. You would also like to infuse some life into your presentation by adding animations wherever
required. Finally, you want to convert the presentation into a Flash file for easy future reference.

To accomplish the task, you will need to:

+ Create a presentation with the required text and images

* Add 3D graphics and animations in the presentation

+ Configure and perform a slide show

« Export the presentation as a Flash file

To create a presentation with the required text and images:

* On the Applications menu, point to Office and then click OpenOffice.org Presentation.

* The Presentation Wizard dialogue box appears. To create a new blank presentation, retain the default
selection and click Next.

+ Select the slide design and output medium for the presentation and click Next.
* Define the transition effect to be applied on the slides and click Create to proceed.
+ Select a layout for your current slide from the Task pane on the left.

+ Enter the required text in the provided textboxes to create the first slide, then click Master Pages to
open the Master Pages panel.

* Click once on the template of your choice to apply it to your presentation.

« Insert a new slide by clicking the Slide button on the Standard toolbar.

+ Select a layout for the new slide.

+ Enter the required text in the provided text box.

» To insert a picture in the presentation, on the Insert menu, click Picture.

+ In the Insert Picture dialogue box, select the desired image and click Open to insert it.
Follow the same procedure to create the rest of the slides.

You have successfully created a presentation with the required text and images.
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To add 3D graphics and animations:

To render special 3D effects to a piece of text, on the Drawing toolbar, click the Fontwork Gallery
button.

Select the style in which you want the text to be displayed and click OK.

Double-click the Fontwork object.

Type the required text in place of the black ' Fontwork' that appears over the object.

Click once outside the object's selected area to exit the Fontwork edit mode.

To display the 3D-Objects toolbar, on the View menu, point to Toolbars and then select 3D-Objects.
To insert a 3D-Object in your current slide, click the desired object on the 3D-Objects toolbar.

Then move your mouse to the point where you want to insert the object.

Holing down the left mouse button drag the mouse to insert the object on the slide.

Change the proportion and size of the object by holding down the green handles.

To apply 3D effects on the inserted graphic, right-click the object. On the short-cut menu, click 3D
Effects.

Define the look and feel of the inserted object by selecting appropriate options in the 3D Effects dialogue
box.

After defining the options, click the Assign icon on top right of the 3D Effects dialogue box.
Click Close to exit the 3D Effects dialogue box.

To add animations, to the various elements in your presentation, on the Slide Show menu, click Custom
Animation.

Select an element and click the Add button on the Custom Animation panel to display the Custom
Animation dialogue box.

After defining all the desired settings for the object, click OK to apply the animation effects.

Your have successfully added 3D graphics and animations in your presentation.

To configure and perform a slide show:

On the Slide Show menu, select Slide Show Settings.

Select the desired options on the Slide Show dialogue box and click OK to apply the settings.
To start the slide show, select Slide Show from the Slide Show menu or press F5.

Your presentation runs as a lively slide show.

To export the presentation as a Flash file:

On the File menu, click Export.

Specify a file name in the File name field and navigate to the directory where you want to export the file.
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+ To export the presentation as a Flash file, select Macromedia Flash (SWF) (.swf) from the File format
drop-down list.

+ Click Save to export the file at the desired location.
The file is exported at the indicated location. You can now view the presentation as an SWF file.

Exercise 4: Creating Formulae Using Math. In your role as a high school mathematics teacher, you
need to create a mathematics test paper that also contains geometrical and arithmetical equations. You have
to find a way to display the mathematical equations properly in the text document.

Solution:
* Position the cursor on the document where you want to insert the formula.

* On the Insert menu, point to Object and then click Formula. The Equation editor appears at the
bottom of the document window.

+ To display the Selection window, on the View menu, click Selection.

« Start inserting the formula by selecting a symbol from the Selection window.
+ Enter the required text in the placeholders that appear in the equation editor.

* Follow the same procedure to enter the rest of the equation.

* Click anywhere on the document body to exit the equation editor.

+ To insert some formulas containing Greek characters, display the Catalog window by selecting it from
the Tools menu.

* Ensure that Greek is selected under the Symbol set drop-down window.
* Select the required Greek symbol from the Symbols window and click Insert.

+ Follow the same procedure to enter the rest of the formula.
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Objectives

In this lesson, you will learn how to:

+ Find and install games on Ubuntu

+ Play some of the more popular Ubuntu games

» Configure other games

Installing Games on Ubuntu

The default installation package of Ubuntu 8.04 LTS comes with 17 Ubuntu games, including Aisleriot,
Solitaire, Gnometris and Mines. In addition, you can install many games from other repositories.

Instructor Notes:

Understanding repositories is important because games are available for download from different
locations. You may need to recap on the Lesson 1 topic of Enabling Repositories. You will also
want to pre-install the two games covered in the lesson on every computer prior to starting the
session otherwise this will take up much time during class.

Note:

Enabling a repository is a one-time task. You do not have to enable the repositories every time
before installing software.

Installing a Game from a Repository

Add/Remove Applications>and Synaptic Package Manager are the Graphical User Interfaces (GUI)
that enables you to install applications from the Ubuntu repositories. However, using Add/Remove
Applications is the easiest way to install a game on your computer.

Procedure 5.1. To install a game from a repository:

1.  On the Applications menu, select Add/Remove.

Figure 5.1. Launching Add/Remove
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v} Games

A Graphics

[ office

»
»
{4 Internet 3
,
3 sound & Video  »
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Install and remove applications

2. Inthe Add/Remove Applications window, select Games from the left pane of the window to display
a list of games in the top section of the right pane, along with the popularity of each game among
users. The bottom section in the right pane displays a brief description of the game selected.
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Figure 5.2. Add/Remove Applications window
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These are the games from the official GNOME release. They have the
look and feel of the GNOME desktop, but can be used without it

The package contains the following games =
* aisleriot - different solitaire card games
* blackjack - the casino card game

* glchess - chess game with 3D graphics
* glines - color lines game, aka fiveormore
* gnect - four in a row game

* anibbles - snake game, up to four plavers &

The right pane, by default, displays the games supported by Canonical Limited. To change the list of
games, click Supported Applications and select the appropriate option from the drop-down list.

Figure 5.3. Changing List Option
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three difficulty levels, an interactive tutorial, and a scoring system.
20,000 Light Years Into Space" is written in Python using pygame and it
was rewarded with the second place in the Pyweek March 2006 Individual
Entries category.

This application is provided by the Ubuntu community.
Homepage: http: Jwhitham.org.uk/biscuit_games/lightYears,

(€|

You can navigate through the list of games or search a game by its name. To initiate a search, type
the name of the game in the Search box and press Enter. The top section of the right pane displays
the search results. Select the check box next to the game to mark it for installation and click Apply
Changes. A dialogue box opens, which requires confirmation to proceed with the installation.
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Figure 5.4. Searching a Game
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Frozen-Bubble is a clone of the popular "Puzzle Bobble" game, in which you
(o4 System Tools atternpt to shoot bubbles into groups of the same color to cause them to
2 pop. It features 100 single-player levels, a two-player mode, music and
striking graphics.
This game is widely rumored to be responsible for delaying the Woody
release.

URL: http:iiwww.frozen-bubble.org/

@ Universal Access

This application is provided by the Ubuntu community.

Note:

The search result is dependent on the display mode selected in the previous step. To widen
the scope of search, select All Available Applications in the Show drop-down list.

Nice to Know:

To remove a game from your computer, clear the check box next to that game and click
Apply Changes.

5. In the confirmation dialogue box, click Apply to proceed with the installation or click Cancel to
return to the Add/Remove Applications window.

Figure 5.5. Confirming Changes
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6. After the installation is complete, a dialogue box confirms the installation and provides the option
to start the installed game, return to the Add/Remove Applications window or close it. Select the
appropriate option in the dialogue box.
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Figure 5.6. Dialogue Box Confirming Installation
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7. To launch the installed game from the desktop, point to Games on the Applications menu and click
the name of the game.

Figure 5.7. Launching a Game
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Let's play!

Playing Ubuntu Games

Instructor Notes:

Allow the students to play these games for about 10 - 15 minutes.
Playing a game on Ubuntu is no different than playing it on any other Graphical User Interface (GUI)-

based operating system. There are no pre-requisites to play these games and the real fun is in exploring
these games yourself.

Note:

Ensure that you have hardware-accelerated 3D drivers installed for your video card.
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Instructor Notes:

To configure 3D acceleration on video cards see lesson 3 of this course or visit the following Web
site: http://doc.ubuntu.com/ubuntu/desktopguide/C/graphics-cards.html.

Playing Frozen-Bubble

In Frozen-Bubble, you attempt to shoot bubbles into groups of the same colour to cause them to pop.
Frozen-Bubble is a clone of the popular Puzzle Bobble game and features 100 single-player levels, two-
player mode, music and striking graphics. You can play this game with another player on your Local Area
Network (LAN) or invite a player on the Internet to play. Frozen-Bubble is not in the list of default games
so you should install it from the Universe repository.

Note:

This game does not have the option to turn off the sound. Therefore, if you are playing this game
at your workplace and do not want other people to know, ensure that the speakers are turned off
before launching this game.

Procedure 5.2. To play Frozen-Bubble:
1.  On the Applications menu, point to Games and click Frozen-Bubble to launch the game.

Figure 5.8. Launching Frozen-Bubble
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2. The Frozen-Bubble 2 window lists options to select the playing mode, customise the levels, change
the resolution of the graphics, specify the keys on your keyboard with which you want to play this
game or view the high scores list.
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Figure 5.9. Frozen-Bubble Main Menu

EOTTERERLD 8

To start playing the game in single player mode, select START 1P GAMe and press Enter to display
the Start 1- player game menu. Select PLAY DEFAULT LEVEL SeT and press Enter to launch
Level 1 of the game.

Figure 5.10. Single Player Game Menu

Note:

Use the up or down arrow keys to navigate through the options.

The aim of the game is to prevent the bubbles from reaching the penguin next to the igloo. At the
start of the game, you will see an arrangement of coloured bubbles on the window, a bubble gun
that contains a bubble, and a pointer. Use the left and right arrow keys to change the direction of the
pointer and the space bar to fire the bubble. To pop the bubbles, you should hit at least three bubbles
of the same colour. If the fired bubble hits a bubble of a different colour, it sticks to that bubble and
is added to the arrangement.
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Figure 5.11. Playing Window

FTOZEnBubbIes
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You have to fire the bubble from the bubble gun within seven seconds of firing the previous one;
otherwise, a Hurry warning flashes three times and the bubble gun fires the bubble automatically.
The bubble appearing in the igloo window is the next bubble to appear in the gun.

Figure 5.12. Flashing Hurry Warning

To add to the plight of the poor penguin, FB-01 and FB-02 keep pushing the plank towards the
penguin, reducing the area for the bubble arrangement.

If you succeed in popping all the bubbles, you win! You can then press any key to proceed to the
next level.
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7.

Figure 5.13. Displaying Level Results

Note:

Press the ESC key to go back to the previous window or close the application.

If you leave the game after achieving a high score, type your name in the window that opens and
press Enter to display the high score listings. In the list, you can view the level you reached and the

time taken to reach that level. Press ESC to return to the main menu.
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Figure 5.14. High Score Windows
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If you do not like the pre-defined arrangement of the bubbles, you can create your own arrangement by
selecting Level editor from the main menu.

Instructor Notes:

If time permits, ask the learners to use the level editor, create some arrangements of their own
and try the other options in the window.

Playing PlanetPenguin Racer

PlanetPenguin Racer, also called ppracer, is a simple racing game featuring Tux, the Linux mascot. This
game is based on the popular Linux game Tux Racer. The goal of the game is to slide down a snow and
ice covered mountain as quickly as possible, avoiding the trees and rocks that will slow you down.

Procedure 5.3. To play PlanetPenguin Racer:
1. Install the planetpenguin-racer package from the Universe repository.

2. On the Applications menu, point to Games and click Planet Penguin Racer to launch the game.
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3.

Figure 5.15. Launching PlanetPenguin Racer
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Press any key on the keyboard to proceed to the next window.
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Figure 5.16. Starting Window

PRESS ANY KEY TO START.

o

The next window displays the main menu of the game. Click the options on this menu to take part
in a racing event, practise before entering any event, configure the game settings, view credits and
quit the game.
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Figure 5.17. Entering an Event
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You can play this game by using a computer keyboard or a joystick. On the main menu, click
Configuration and then click Keyboard or Joystick to know their default key settings. You can also
change the key settings according to your preferences. Click Back to return to the main menu.

Figure 5.18. Configuration Options
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On the main menu, click Enter an Event, select the event and the cup in which you want to participate
and then click Continue to proceed.

Figure 5.19. Selecting Event and Cup

Select event and cup
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The next window prompts you to select a race. As a beginner, you do not have any option but to
continue with the default race. However, do read the Needed to advance information to know the
minimum requirement to qualify for the next round in the cup.

Click Race! to start the race.
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Figure 5.20. Selecting a Race

Select a race

o
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to conquer the 2
Bunny Hill

Contributed by: Unknown

9. The next window starts the race. The intent of the game is to make Tux reach the Finish line, collecting
herrings on the way. If you succeed in reaching the Finish line within the parameters mentioned in
Needed to advance, you proceed to the next round; otherwise, you have to play the round again.
There are four attempts or lives that you get to compete in an event. If you fail to satisfy the wining
criteria, one life is deducted.

Figure 5.21. Playing PlanetPenguin Racer

You can win the cups only by practising and focusing on improving your performance.
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Playing Other Popular Games

In addition to all the games available in Ubuntu, you can play games created for Microsoft Windows.
However, to do so, you need the ability to run Windows applications in Ubuntu. One of the programmes
that provides this ability is named Wine.

Installing Wine

Instructor Notes:

Before performing the following steps, ensure that all the students have a Microsoft Windows
game copied on their computer.

Procedure 5.4. To install and configure Wine:
1. Install the wine and wine-dev packages from Synaptic Package Manager.
2. The configuration of wine can be altered through Applications, Wine, Configure Wine.

3. This window allows you to customise a variety of settings for Wine, such as the Microsoft Windows
version that is being simulated, drive mappings, as well as application-specific settings. Click OK
to close the window.

Install the wine and wine-dev packages from Synaptic Package Manager.

Wine is configured on your computer with an artificial C: drive. You can now access many Microsoft
Windows application on Ubuntu.

Instructor Notes:

The information included in this document is sufficient for the students to start playing games.
The most suitable and easy method is chosen for illustration. However, performing other tasks,
such as adding CD and DVD drives to Wine or using Microsoft Windows themes in Wine requires
further configuration. If the students want to learn more about configuring Wine, refer them to
https://help.ubuntu.com/community/Wine.

Playing a Microsoft Windows Game on Ubuntu

A Microsoft Windows executable file can be started with Wine through right-click, Open with "Wine
Windows Emulator”.

If you install a Microsoft Windows application with Wine, an icon may be found in Applications, Other.

Lesson Summary

In this lesson, you learned that:
* You can install and play many games available by default on Ubuntu and in repositories.
* You can install games by using the Add/Remove Applications or Synaptic Package Manager.

* You can play Microsoft Windows games on Ubuntu by installing a programme that provides a Microsoft
Windows environment, such as Wine.
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Review Exercise

Intentionally left blank.

Lab Exercise

Exercise 1: Installing a game on Ubuntu. During a recent get together with your friends, you heard a
lot of good things about a game that they play on their Linux operating system. You wish to play the same
game, but you cannot find that game in the games package that got installed with Ubuntu. What do you
need to do in order to play this game on your computer?

Procedure 5.5. To perform the required task:

1.

On the System menu, point to Administration and click Software Sources to display the Software
Sources dialogue box.

On the Software Sources dialogue box, select the check boxes next to main and universe options.
Retain the Main server option in the Download from category and clear the CDrom check box.

Click Close to display a prompt and then click Reload on the prompt to update the list of applications
available.

To install the game, select Add/Remove on the Applications menu to display the Add/Remove
Applications window.

Select Games in the left pane of the window, change the Show list option to All Open Source
Applications, type the name of the game in the Search box and press Enter.

Select the check box next to the game to mark it for installation and click Apply Changes.
On the confirmation dialogue box, click Apply to proceed.

After the installation of the game is complete, a dialogue box confirms the installation and provides
the option to launch the installed game. Double-click the name of the game to launch it. Alternatively,
you can close this dialogue box and launch the game by using the Applications menu on the desktop.

Exercise 2: Installing Wine and playing a Microsoft Windows game on Ubuntu. You were browsing
the Web one day and came across an interesting game. You downloaded it and every thing seemed fine
until you realise that the game could be played only on Microsoft Windows, which is not installed on your
computer. You really liked the game, how do you play this on Ubuntu?

Procedure 5.6. To play a Windows game on Ubuntu:

1.

2.

3.

Install wine and wine-dev packages from Synaptic Package Manager.
Open the games setup tool with Wine.

Start the games from the Applications menu.
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Chapter 6. Customising the Desktop
and Applications

Objectives

In this lesson, you will learn how to:

+ Customise the look and feel of the Ubuntu desktop

« Work with the Nautilus file manager

* Add and remove applications

« Identify the types of single package files and their use
+ Install and uninstall Debian packages

+ Identify the categories of software repositories

* Add extra repositories

Introduction

The Ubuntu desktop comes completely clean and free of pre-determined icons and buttons. Customising
your desktop allows you to add icons to suit your work style.

In this lesson, you will learn about various ways to set up your Ubuntu desktop to suit your requirements.
You will also learn how to install and uninstall various software applications.

Customising the Desktop

Ubuntu and its derivatives can be customised through a Graphical User Interface or a Command Line
Interface.

The graphical tools to customize the desktop are available as menu options in the System menu. Point to
Preferences on the System menu to view the tools.

Note:
The System - Preferences menu enables users to customise their own desktop environment but not

that of other users on the same computer. In contrast, applications on the System - Administration
menu will make changes to the computer that will affect all users.

Changing the Background
The desktop background is the image or colour applied to your desktop.

Procedure 6.1. To change the default Ubuntu background select:

1. On the System menu, point to Preferences and then click Appearance. The Appearance
Preferences dialogue box opens.
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Figure 6.1. Launching Appearance Preferences Dialogue Box
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Nice to Know:

You can also right-click the desktop and select Change Desktop Background to open the
Appearance Preferences dialogue box.

2. In the Appearance Preferences dialogue box, select a desktop wallpaper from the available
wallpapers. The background changes immediately.
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Figure 6.2. Changing the Desktop Wallpaper
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Nice to Know:
To view the name of the wallpaper, move the pointer over its name.

Click Close in the Appearance Preferences dialogue box to apply the changes.

Figure 6.3. Applying Preference Change

’.‘; Applications  Places  System e@ (7] ] W Tue Dec 16, 4:12 pm [§] william windsor
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Procedure 6.2. Adding a New Wallpaper

In addition to the wallpapers available with Ubuntu, you can download wallpapers from other sources and
add them to the available wallpapers list in the Appearance Preferences dialogue box. To do this:

1. Open the Web site http://art.gnome.org/ and click Backgrounds.

Figure 6.4. Opening Wallpaper Source
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Welcome to art.gnome org - a place for high quality artwork and themes for the GNOME desktop. All News
themes and artwork on art.gnome.org are tested and moderated (see the Submission Policy) to ensure FAQ
a high standard of quality and to make certain they work with your GNOME desktop. Tutorials
Latest News Forums [
) Help us with future Art.Gnome.org version Screenshots
Search...
Latest Updates Top Rated =
The most recent additions te art. gneme org The top rated items on art gneme org Advanced Search
red-o-splash Drops Il
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20 October 2008 7 September 2008
(® 1 comments wotn ol 7comments Backgrounds
. . GNOME
Linux. Join the Contact Nature
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Done

2.  Download the wallpaper of your choice. During the download, you can view the screen resolutions
available for the selected wallpaper. You should download and save the version of your chosen
wallpaper that matches the screen resolution of your computer.

3. On the System menu, point to Preferences and then click Appearance. The Appearance
Preferences dialogue box opens.

4. Click the Background tab and then click Add. The Add Wallpaper dialogue box opens.

179


http://art.gnome.org/

Customising the Desktop
and Applications

Figure 6.5. Adding a New Wallpaper
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In the Add Wallpaper dialogue box, select the downloaded image and click Open.

Figure 6.6. Selecting Downloaded Wallpaper
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This step adds the image as new wallpaper.

Click Close in the Appearance Preferences dialogue box to accept the changes. You can now view
the new desktop background.
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Figure 6.7. Added Wallpaper
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Nice to know:

You can, of course, use a picture from any other source to use as your desktop background.
Many popular online photo collaboration sites allow visitors to download and use their content
for personal use. Many people also use their own digital photographs as backgrounds.

Procedure 6.3. Changing the Colour of the Background

To change the colour of the background:

1.

On the System menu, point to Preferences and then click Appearance to open the Appearance
Preferences dialogue box.

Click the Background tab and select the wallpaper No Wallpaper. You can only view colours if you
have not set any desktop wallpaper.
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Figure 6.8. Changing Background Colour
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3. The Colours box provides three types of background: Selid colour, Horizontal gradient and
Vertical gradient. Select the desktop colour of your choice and then click the colour chip next to the
Colours box. The Pick a Colour dialogue box opens.

Figure 6.9. Selecting a colour Option
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Wallpaper

Colors

oo <]

4.  Select a colour or the attributes of a colour such as hue and saturation to create a colour of your choice.
Click OK. The desktop reflects the new settings immediately.
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Figure 6.10. Specifying Colour
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5. Click Close to close the Appearance Preferences dialogue box.

Figure 6.11. Changed Background Colour
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Customising the Theme (Buttons & icons etc)

The desktop theme controls the visual appearance of the buttons, scroll bars, icons, panels, borders etc. A

number of themes are provided with Ubuntu.

Procedure 6.4. To select a theme for your desktop:

1. On the System menu, point to Preferences and click Appearance. The Appearance Preferences

dialogue box opens.

2. On the Theme tab, select the theme of your choice. The desktop reflects the theme automatically. To
customise your theme further, click Customise. The Customise Theme dialogue box opens.
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Figure 6.12. Customising Desktop Theme
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3. The default selection is Controls tab. The setting on the Controls tabbed page defines the visual
appearance of windows, panels and applets. Select a control from the Controls list. You will see an
immediate change in the appearance of the open windows.

Note:

You can customise the following objects on the screen:

Window: A rectangular area of the screen with a border and a title bar at the top. All
graphical applications run inside windows.

Panel: An area on the desktop from where you can access information such as date and
time. You can also launch applications and add or remove objects from panels. The Ubuntu
desktop contains two panels, the top edge panel at the top of the screen and the bottom edge
panel at the bottom of the screen.

Applet: A small application whose user interface resides within a panel.

Window Border: The border that appears around windows. It has a frame at the top of
the window that contains the name of the application and the edges that allow you to resize
the window.

Icon: A graphical symbol for the applications and options on the panels and windows.

Similarly, you can customise the background and text colour of your windows, input boxes and
selected items by configuring the settings on the Colours tab.

If you want to customise your window borders and icons, click the Window Border and Icons tabs
in the Customise Theme dialogue box.
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Note:

Ubuntu provides additional options to customise your themes. You can download more
controls, window borders and icons from the Web site http://art.gnome.org and save it at any
location on your computer. While customising the theme, click Install in the Appearance
Preferences dialogue box. The Select Theme dialogue box opens, and you can select the
downloaded objects.

Figure 6.13. Selecting Theme Controls
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4. Click Cleose in the Customise Theme dialogue box. To save the theme, click Save As in the
Appearance Preferences dialogue box. The Save Theme As dialogue box opens.
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Figure 6.14. Saving a Modified Theme
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5. Provide a name for the theme in the Name box and a description, if you want, in the Description
box. Click Save.

Figure 6.15. Specifying Theme Name and Description

Name: New Custom Theme

Description:

Sawve background image

6. Inthe Appearance Preferences dialogue box, click Close.

If you open a menu or window, you can see the changes in their appearance.
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Figure 6.16. Viewing an Application in a Modified Theme
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Procedure 6.5. Installing New Themes

You can also download other Ubuntu-compatible themes from Ubuntu's recommended source. To install
these themes:

1. Open the Web site(http://art.gnome.org/) and click DesktopThemes.

Figure 6.17. Opening Theme Source
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2. Download a theme of your choice. Select any theme and follow the instructions as they appear.

3. On the System menu, point to Preferences and click Appearance. The Appearance Preferences
dialogue box opens.
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4.

5.

On the Theme tab, click Install. The Select Theme dialogue box opens.

Figure 6.18. Installing a New Theme
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Select the downloaded theme and click Open.

Figure 6.19. Selecting the Downloaded Theme
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You can apply a new theme or retain the current theme. Click Apply New Theme to apply the new
theme. The screen will reflect the new theme immediately.

Figure 6.20. Applying New Theme
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| 4 Apply New Theme |

Click Close in the Appearance Preferences dialogue box.
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If you open any menu or window, it will reflect the selected theme.

Figure 6.21. Chess in Blue Heart Theme

Appearance Preferences

Customising a Screensaver

A screensaver displays (often moving) images on the screen when your computer is switched on but not
in use. To go back to the workspace, you can move the mouse or press any key on the keyboard.

Procedure 6.6. You can choose a screensaver and customise it. To customise a
screensaver:

1.  On the System menu, point to Preferences and click Screensaver. The Screensaver Preferences
dialogue box opens.
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2.

Figure 6.22. Launching Screensaver Preferences Dialogue Box
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Select a screensaver from the list. You can preview the screensaver in the right pane.

Figure 6.23. Customising Screensaver Settings
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The Regard the computer as idle after slider specifies when a screensaver starts to work if the
computer is not in use. The default time is set to 10 minutes. You can use this slider to select how
long the computer needs to be idle before the screensaver activates.
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4. To prevent any tampering of your computer in your absence, you can automatically lock your screen
the moment the screensaver activates. Locking requires users to type their password to reactivate the
desktop. Select the Lock screen when screensaver is active check box to lock the screen when the
screensaver starts.

5. Click Close.

The selected screensaver displays when the computer is idle for the specified period.

Customising the Screen Resolution

The screen resolution determines how large or small an item looks on the screen.

Procedure 6.7. To modify the desktop screen resolution:

1.  Onthe System menu, point to Preferences and then click Screen Resolution. The Screen Resolution
Preferences dialogue box opens.

Figure 6.24. Launching Screen Resolution Preferences Dialogue Box
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2. The default resolution is 1280x1024. You can change the resolution in the Resolution box.
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Figure 6.25. Customising Screen Resolution
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3. Click Apply. The Keep Resolution dialogue box opens, prompting you to confirm settings or use the
previous resolution and revert to the original settings. Click Keep resolution to apply new changes.

Figure 6.26. Resolution Confirmation Dialogue Box
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The screen resolution will change.

3D Effects

A computer screen is two-dimensional (2D) and until recently most applications were developed in a 2D
layout.

However, advancements in technology fuelled the demand for more life-like on screen visuals, as in three-
dimensional (3D) modelling and games. The operating system needs to perform complex calculations
to display 3D images in 2D. Consequently, to reduce the burden on the operating system and increase
the speed of applications, 3D accelerator cards were developed, which use the graphics processor on the
graphics card instead of consuming valuable CPU resources. Almost all modern graphics cards have a
built-in acceleration to display 3D.

Ubuntu can utilize the 3D capabilities of a graphics card for desktop effects. An example of these can be
seen with Compiz Fusion — spinning cubes, floating windows etc. Compiz Fusion is a fun application used
to liven up your desktop experience and make it 3D in appearance.

The effects are enabled by default and can be controlled from the Appearance menu. From here the
desktop effects can either be completely disabled or enabled. The number of effects can be controlled via
the normal effects and extra effects setting.

If a graphics card does not have 3D capabilities or support for 3D is missing from the Linux drivers for
the card, you will be notified that Desktop effects could not be enabled.
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Working with Files Using Nautilus

The Nautilus file manager in Ubuntu provides a simple and integrated way to manage files and applications.

Features of Nautilus

The Nautilus file manager enables you to organise files into folders and perform tasks such as:

* Create and display folders and documents: Create new files, organise them into folders and save them.
+ Search and manage your files: Classify files and search them as per their classification.

* Open special locations on your computer: Access the local network and save your files.

* Write data to a CD or DVD

+ Navigate using two modes:

+ Spatial mode: Allows you to open each folder in a separate window, which then helps open your files
as physical objects in different locations. You can view the content of various folders simultaneously.

* Browser mode: Opens your folders in a single window. Only one file manager opens in browser mode,
and it is updated when you click another folder in the file manager.

Instructor Notes:

Compare browser mode with Firefox to help students appreciate the similarity.

Nautilus

Procedure 6.8. To choose the required mode:
1.  Click the Places menu. A list of items appears:

* Home Folder: This is a personal folder created by default for every user to create and work on
files. It takes the user name by default.

» Desktop: An active component that lies behind all the screens on your computer and provides
easy and quick access to the files saved on it.

» Computer: Contains all drives and file systems; makes document backup onto CD and DVD
really simple.

+ CD/DVD Creator: It consists of folders that you can write to a CD or a DVD. You can also
back up your documents on a CD or a DVD.

2. Click any of the above items on the Places menu.
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Figure 6.27. Using File Browser
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The Nautilus file manager opens files in browser mode by default. If you open a folder in this mode,
the folder will open in the same window. The location bar shows the current location of the opened
folder in the hierarchy of folders, and the sidebar shows other folders saved on your computer.
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Figure 6.28. Files Display
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While in browser mode, you can move to the parent folder that contains the currently open folder. To
move to the parent folder, click Open Parent on the Go menu in the window.

Note:

You can also click Up on the navigation toolbar or press the BACKSPACE key to move to
the parent folder.

On the Edit menu, click Preferences. The File Management Preferences dialogue box opens.
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Figure 6.29. Launching File Management Preferences
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Edit Mautilus preferences

4. Click the Behaviour tab in the dialogue box. To change the mode to spatial mode, clear the Always
open in browser windows check box and then click Clese.

196



Customising the Desktop
and Applications

Figure 6.30. Changing File Management Behaviour
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0

Close the file manager window and open it again. Your files will now open in spatial mode. If you
open another folder, it will open in a different file manager window.

Figure 6.31. Confirming File Management Behaviour Changes
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Note:

Each time you open a particular folder in spatial mode, you will find its window displayed
in the same place on the screen and of the same size as during the last view. For this reason,
this mode is referred to as spatial mode.
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To move to the parent folder in spatial mode, click Open Parent on the File menu. Alternatively,
you can press the ALT+UP arrow key.

Nice to Know:

Konqueror is KDE equivalent of Nautilus file manager, which is used in the Kubuntu
derivative of Ubuntu. It is a multi-purpose application that can act as a file manager, Web
browser and universal viewer. As well as allowing you to browse Web sites, this application
provides basic file management and can many view different file types.

Package Managers

One of the biggest differences between Ubuntu and other operating systems is how you install and
uninstall applications. In Microsoft Windows, most applications provide their own installation and removal
methods. Some applications provide a method to keep themselves up to date, but others do not and there is
no easy way to ensure that everything on your computer is up to date. Keeping track of all the programmes
that have been installed and keeping all those programmes updated is largely up to you.

Ubuntu has a sophisticated package management framework that keeps track of all the software
installed, automates the process of installing and removing applications, and ensures that all the software
is kept up to date with the latest enhancements and fixes. All you have to do is decide what applications
you want installed, and then use a package manager to tell Ubuntu to install them.

Types of Package Managers

Ubuntu includes a few package managers by default and which one you use depends on how advanced
the package management tasks are that you want to achieve. This course covers Add/Remove applications
utility and the Synaptic Package Manager.

Note:

If you open more than one package manager at the same time, they may not work. Close all the
package managers and open just one.

Using Add/Remove Applications

The Add/Remove tool is the easiest to use and will enable you to install and uninstall many popular
packages. You can search for the package or packages you want to install by simply searching a keyword
such as 'email' or by looking through the given categories, selecting applications and choosing "Apply"
to start the installation.

Note:
You need administrative access to use any package manager. Type the password for your user

name at the prompt. This means that applications can not be added / removed from your computer
without your knowledge (and password).

Procedure 6.9. The procedure to add or remove software by using Add/Remove
Applications is:

1. On the Applications menu, click Add/Remove.
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Figure 6.32. Launching Add/Remove Applications
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The Add/Remove Applications dialogue box displays a list of applications. The check boxes against
the applications that are already installed are pre-selected.

Note:

Many package names in Ubuntu are quite obscure, so the package manager will also look
at the package description when searching.

Figure 6.33. Add/Remove Applications Window
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3. If you know the name of the package to be installed, you can type the name in the Search box.
Otherwise, you can click the appropriate software category in the left pane and select the check box
next to the required package in the right pane.

Nice to Know:

For more details about a package, click the package and view the bottom pane.

Figure 6.34. Searching for a Package in All Available Applications
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three difficulty levels, an interactive tutorial, and a scoring system.

"20.000 Light Years Into Space" is written in Python using pygame and it was
rewarded with the second place in the Pyweek March 2006 Individual Entries
category.

This application is provided by the Ubuntu community.
Homepage: http: Jjwhitham.org.uk/biscuit_games/Lightvears

4.  When you have finished selecting the packages to be installed or removed, click Apply Changes.

Figure 6.35. Applying Changes to the Package List
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5. You are prompted to confirm your selection. Click Apply to proceed.

Figure 6.36. Confirming Changes
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6. The progress indicator shows the status of the package being installed or removed.

Figure 6.37. Installing Selected Package from Repositories
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7.  After the changes are applied successfully, the package is installed.
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Figure 6.38. Installation Confirmation
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8. Double-click the package to launch it. If you want to add or remove more applications, click Add/
Remove More Applications or else click Close in the New application has been installed dialogue
box. The following figure shows Atomix, which has been installed by performing this procedure.

Figure 6.39. Launching the Installed Application - Atomix
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Score:

Time:

Note:

After installing a package, you can open it by using a particular menu based on its category.
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Using Synaptic Package Manager

Add/Remove Applications does not enable you to install and remove some more advanced packages, such
as the Apache web server, the PHP programming language or Scribe. In such cases, use Synaptic Package
Manager.

You can install, remove, configure or upgrade software packages, browse, sort and search the list of
available software packages, manage repositories or upgrade the whole system. You can queue up a number
of actions before you execute them. Synaptic informs you about the additional packages required by the

software package you have chosen as well as conflicts with other packages that are already installed on
your system. In addition, it presents more information such as package status, origin and filters.

Procedure 6.10. To add and remove any package using Synaptic Packager Manager:

1.  On the System menu, point to Administration and then click Synaptic Package Manager.

Figure 6.40. Launching Synaptic Package Manager
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2. Inthe Synaptic Package Manager dialogue box, you can select the package you need. The left pane
lists the categories, and the right pane lists the packages. If you do not know the name of the package,
select the category in the left pane to filter the list of packages. You can then select the check box
next to the required package in the right pane.
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Note:

If you want to view the installed and uninstalled packages, click Status. To know the source
repository of the package, click Origin. Click Custom Filters if you want to know the
whether a package is broken or can be upgraded.

Figure 6.41. Synaptic Package Manager Window
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If you know the name of the package, click Search. The Find dialogue box opens. Type the name of
the package in the Search field and click Search.

Note:

To return to the list of categories after searching the packages using Search, click Sections.

Figure 6.42. Searching a Package to Install
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Choose the action to be performed on the selected package. Select the Mark for Installation check
box to install the package or select the Mark for Removal check box to remove it. If you change
your mind, select the Unmark check box.

Figure 6.43. Marking the Package for Installation
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5.  If the package that you choose to remove or install depends on other packages, you will be notified
about the dependencies. To continue making changes, click Mark.

Figure 6.44. Confirming Additional Changes
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6. To confirm that you want to make the marked changes, click Apply.
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Figure 6.45. Applying Changes to Update Software Information
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7. The Summary dialogue box opens, prompting you for a final check before making the marked
changes. Click Apply to continue with the changes.

Figure 6.46. Final Confirmation to Install the Package
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8. When all the marked changes are made, you are notified about the changes applied. Click Close to
close Synaptic Package Manager.
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Figure 6.47. Installation Confirmation
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This step completes the procedure of installing packages by using Synaptic Package Manager. You
can access the installed package by selecting a particular menu, depending on the category of the
package. The following figure shows Abiword, which has been installed using this procedure.

Figure 6.48. Launching the Installed Application - Abiword
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Installing a Single Package File

The preferred method of installing programmes is by using package managers. If some packages or files
are not available, you can download and install them from Web sites. These files are associated with the
package managers of specific Linux distributions and are referred to as single package files. Examples are
Debian package files-.deb files and tarballs-.tar files.
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Note:

You should download files that are not present in Ubuntu archives only from a safe source.
+ Debian Package files: These files are associated with Ubuntu and have the .deb suffix.

* Tarballs: Zipped archive files that contain the source code of a programme. This source code needs to
be compiled before use. Installing programmes by compiling them from source is not covered by this
course.

Compiling and installing programmes from source tarballs can can be very complex to debug when things
go wrong. Tarballs are simple structures which don't specify what dependencies are required to enable
compilation to take place. For this reason it can also be time consuming and complex to determine the
necessary dependencies and either install or compile them also. Compiling from tarball is therefore not
covered on this course.

Note:

It is not guaranteed that the single package files will be compatible with your system. Also, you
will not receive security updates if you install these files. Therefore, wherever possible use a
native Ubuntu package of the application available through a package manager.

Installing/Uninstalling Debian Packages

Debian packages are installed and uninstalled using the graphical installer (gdebi). gdebi will attempt to
install any dependencies which are in the Ubuntu repositories, however if the package requires further
dependencies which are not in the Ubuntu repositories these will also need to be installed manually.

To install a Debian package, open the .deb file from the folder in which it resides.

Procedure 6.11. Installing a Debian package:

1. Download the package XVidCap xvidcap_1.1.6_i386.deb. As this package is not in the Ubuntu
repositories, you will need to download it from the following website: http://sourceforge.net/projects/
xvidcap/.

2. Once downloaded, simply double click the .deb file and the gdebi installer will start. It will check to
see if you have all the necessary dependents, and if so will offer an Install button. Simply press the
button to start the installation. In the event that dependencies cannot be resolved, an error message
will be displayed and you will not be able to install the package until they are fulfilled.

3. To uninstall the package, simply use the Synaptic Package Manager, as outlined previously in this
section.

Software Repositories

A software repository is a library of packages (applications) available over the Internet. The Ubuntu
software repository contains tens of thousands of freely available packages for you to download and install.
These packages have been specially built and selected for Ubuntu.

Software Repository Categories

Ubuntu repositories are categorised into four groups based on the level of support that software
development teams provide for a programme and the level of compliance the programme has with the free
software philosophy.
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* Main

* Restricted
* Universe
e Multiverse

The Main Component. The Main component contains software packages that are free and fully
supported by the Canonical team. These packages comply with the free software philosophy and are
available by default while installing Ubuntu. For all packages in the Main component, security updates
and technical support are available free of cost. OpenOffice.org, Abiword and the Apache web server are
some of the packages available there.

The Restricted Component. The Restricted component consists of packages for commonly used
software that are supported by the Ubuntu team but not available under a completely free license. Binary
drivers produced by some video card vendors are an example of packages available there. Packages in this
component are also available on the standard Ubuntu installation CD, but they can be easily removed.

The Universe Component. The Universe component includes thousands of packages for software that
is not officially supported by Canonical. The software is available under a variety of free licenses, taken
from a variety of public sources. This component is available only through Internet downloading.

All the packages in this component are expected to work perfectly. However, there is no guarantee of
security fixes and support for these packages. These packages are maintained by the community.

Instructor Notes:

It could be considered risky to use packages from the Universe component, especially because
the lack of guaranteed security updates.

The Multiverse Component. The Multiverse component contains packages of non-free software,
which means that the licensing requirements of the software does not meet the license policy of Ubuntu's
Main component. It is the user's responsibility to verify their rights to use the software and comply with
the individual licensing terms. Support and security updates are not provided. Examples of these packages
include VLC and the Adobe Flash plugin.

Instructor Notes:

Software from the Multiverse component could be hindered by patents and restriction on usage
and distribution. It is the user's responsibility to determine if the software can be used in its
jurisdiction and complies with local laws.

Many packages are not available in default Ubuntu repositories. These packages can either be installed

from other Ubuntu repositories or from third-party software. To use the packages present in third-party
software, you need to add the software and the repositories.

Procedure 6.12. Perform the following steps to add the third-party software and
repositories:

1. On the System menu, point to Administration and then click Software Sources.
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Figure 6.49. Launching Software Sources Dialogue Box
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The Software Sources dialogue box opens. The software sources for Ubuntu are selected by default.

Figure 6.50. Selecting the Required Sources

Ubuntu Software | Third-Party Software } Updates IAuthentlcatlon } Stat\st\cs}

Downloadable from the Internet
Canonical-supported Open Source software (main)
M Community-maintained Open Source software (universe)
Proprietary drivers for devices (restricted)
Software restricted by copyright or legal issues (multiverse)

[E Source code

Download frem: | Main senver B
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To install from a CD-ROM or DWD, insert the medium into the drive,
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Note:

You can also open the Software Sources dialogue box by using the Add/Remove
applications or Synaptic Package Manager to enable the repositories under the Ubuntu
Software tab.

2. To add a repository from the third party, click the Third-Party Software tab and then click Add.

Figure 6.51. Adding a Third Party Software Source
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3. Type the APT line for the repository you want to add as a source. To access the Debian main
repositories, type deb http://ftp.debian.org sarge main in the APT line box. Click Add Source.

Note:

The APT line should include the type, location and components of a repository.
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Figure 6.52. Stating the Source APT Line
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Click Close to save changes. The repository specified in the APT line is added to the third-party
software box.

Figure 6.53. Software Sources Dialogue Box Displaying the Added Source
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With the addition of an extra repository, you will be prompted to update information about available
software. Click Reload to do so.
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Figure 6.54. Reloading Available Software Information
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The progress indicator shows the status of package being installed or removed.

You can authenticate your downloads from the Authentication tab in the Software Sources dialogue
box. When you do not authenticate your downloads, your computer may show the error shown
below after downloading the package information. This error can be ignored. To authenticate the
downloading process, you need to import the GPG key, which is different for every repository. Click
Close in the dialogue box showing the error. This step will end the process of adding extra repositories
and updating package information.

Figure 6.55. Public Key Error

Software Sources EJ@E
(] ] EEEE

° Could not download all repository indexes

The repository may no longer be available or could not be
contacted because of network problems. If available an older
version of the failed index will be used. Otherwise the
repository will be ignored. Check your network connection
and ensure the repesitery address in the preferences is
correct,

Failed to fetch http:/fftp.debian.org/dists/sarge/main/binary-i386/l

Some index files failed to download, they have been ignored, or
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Adding New Language Settings

Ubuntu provides the option to enable numerous language settings for your desktop.

Support for new languages can be installed via Language Support, which is found in the Administration/
System menu. Depending on the language, the input method and keyboard mapping may need to be
changed as well. The Smart Common Input Method(SCIM) is used in Ubuntu to switch between different
input methods for complex characters in many non-Latin languages. The ctrl space hotkey is a convenient
switch between different input methods.

Lesson Summary

In this lesson, you learned that:

* GNOME is the default desktop for Ubuntu. You can use the Preferences option on the System menu
to customise the Ubuntu desktop look and feel.

* You can manage your file system using the Nautilus file manager. Use the spatial mode to open each
folder in a separate window and view the content of various folders simultaneously. Use the browser
mode to open folders in a single window.

* Add/Remove Applications is the easiest tool to install or uninstall packages.

* You can use Synaptic Package Manager to install or uninstall advanced applications that cannot be
installed using Add/Remove.

+ To install a package that is not available in the Ubuntu archives, you can download and install it from
Web sites. These files are associated with the package managers of specific Linux distribution and are
referred to as single package files.

+ Tarballs are zipped archive files that contain the source code of a programme. You can use advanced
command line tools to install or uninstall the tarball file.

Review Exercise

Question: What is the default desktop for Ubuntu?

Answer: GNOME is the default desktop for Ubuntu.

Question: From which Web site can you download additional Ubuntu wallpapers and themes?
Answer: You can download additional wallpapers and themes from the Web site http://art.gnome.org/.
Question: Mention any three features of the Nautilus file manager.

Answer: Three features of the Nautilus file manager are:

* Creating and displaying folders and documents

+ Searching and managing files

+ Navigating using two modes, browser and spatial

Question: Which is the file manager for the KDE environment?
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Answer: Konqueror is the file manager of the KDE environment.
Question: What is a package manager?
Answer: A package manager is a programme that helps add or remove packages in Ubuntu.

Question: Differentiate between a graphical package manager and a command line package manager.
Provide examples of each.

Answer: To add and remove packages, a graphical package manager uses the graphical interface while a
command line package manager uses the command line interface. Add/Remove Applications is a graphical
package manager and apt-get is a command line package manager.

Question: Software that is not licensed under Ubuntu's main component licensing policy is referred to
as

Answer: Software that is not licensed under Ubuntu's main component licensing policy is referred to
as non-free software.

Lab Exercise

Instructor Notes:

Explain to the students the purpose of each application. xpdf is a suite of tools used to view
Portable Document Format (pdf). This package supports standard X fonts, true type fonts and
typel fonts. Gnumeric is a stand-alone spreadsheet application that interoperates well with other
spreadsheets.

Exercise 1. You have installed Ubuntu 8.04 on your personal computer. You want to view your pdf
files, use a spreadsheet application for creating your daily tasks and archive your files. Install the following
packages:

a) xpdf

b) gnumeric

Procedure 6.13. a) Installing xpdf using Add/Remove Applications:

1. On the Application menu, click Add/Remove. The Add/Remove dialogue box opens.
2. In the Search box, type xpdf.

3. Select the check box next to xpdf.

4. Click Apply Changes.

5. Click Apply to make the changes.

6. Inthe New application has been installed dialogue box, click Close.

Procedure 6.14. b) Installing gnumeric from Synaptic:

1. On the System menu, point to Administration and then click Synaptic Package Manager. The
Synaptic Package Manager dialogue box opens.

2. Click Search to find gnumeric and select the gnumeric check box.
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Select the Mark for Installation check box. A dialogue box displaying the dependencies of this
package on other packages opens.

To continue making the required changes, click Mark.

To confirm making the marked changes, click Apply. The Summary dialogue box opens, prompting
you for a final check before making the marked changes.

Click Apply to continue with the changes.

When all the marked changes are made, you are notified of the changes applied. Click Close.
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Objectives
In this lesson, you will learn to:
* View and edit images

* Scan and send images

Instructor Notes:

It is advisable to cover all the topics during the training. However, if you fall short of time then
cover only the following topics:

* Introducing Graphics Applications

* Managing Photos with F-Spot

* 3D Effects

Try and take photographs of the class (students) before this session and then demonstrate the

applications using those photographs. This lesson should be very hands on as opposed to just a
demonstration.

Introducing Graphics Applications

Graphics applications form an integral part of Ubuntu. They enable you to organise your photo collection,
create and edit photos and images, scan and send objects and more.

In this lesson, you will learn about the various graphics applications available on Ubuntu and which one to
use when. These graphics applications are available either with the Ubuntu installation or in repositories
(those libraries we mentioned earlier).

Applications Available with the Ubuntu Installation. The following applications are included in the
Ubuntu installation package:

* GIMP Image Editor: An image editor used for advanced image creation and editing such as changing
the contrast, colour or the texture of an image.

+ F-Spot Photo Manager: A photo manager used to organise and manage photos. F-Spot enables you
to tag (label), categorise and sort photos.

+ XSane Image Scanner: An image scanner which also enables you to photocopy documents and fax
or e-mail scanned images.

Applications Available in Repositories. In addition to the default applications, you can search through
the repositories and install applications using the Synaptic Package Manager or the Command Line
Interface (CLI).
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Instructor Notes:

Thousands of applications are available in the repositories; this topic covers only a few of them.
If students want more information about a specific application, show them the way to view
application details in the Synaptic Package Manager.

Some of the graphics applications are available in Ubuntu software repositories:

|

Agave: A colour scheme designer. After you select a base colour, Agave suggests the appropriate
complementary colours or shades of the same base colour. You can also drag and drop a colour from
another application, such as GIMP. Whether you are designing a Web page or a pamphlet or painting
your house, this programme enables you to identify the appropriate colour scheme. Visit the Web site
http://home.gna.org/colorscheme/ for more information on Agave.

Blender: An open-source 3D content creation suite. You can create 3D models and animations,
add post-production effects or use it as a graphics editor to define interactive behaviour without
programming. Blender has a distinctive user interface that is implemented entirely in Open GL and
designed for speed. Python bindings for scripting and import/export features for popular file formats
such as 3D Studio are available in Blender. Blender can output still images, animations, models for
games or other third party engines and interactive content in the form of standalone binaries or web
plug-ins. Visit the Web site http://www.blender.org/ for more information on Blender.

|

Dia: A diagram editor similar to Microsoft Visio. Dia offers the capability to produce precise
and professional-level graphics. You can draw entity relationship diagrams, flowcharts and network
diagrams and export them to various formats, including EPS, SVG, XFIG, WMF and PNG. You can
also print diagrams spanning multiple pages. Visit the Web site http://live.gnome.org/Dia for more
information.

Gceolor2: A simple colour selector and picker that facilitates quick and easy selection of colours.

It also enables you to save new colours and delete existing ones. Visit the Web site http://
gcolor2.sourceforge.net/ for more information.

|

GNU paint: A user-friendly painting programme for GNOME. It offers easy-to-use drawing tools to
perform various image-processing operations. Visit the Web site http://gpaint.sourceforge.net/ for more
information.

In addition, several third-party applications, such as Picasa, a free software download from Google, are
compatible with Ubuntu.
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Picasa enables you to locate and organise all the photos on your computer, edit and add effects to your
photos and share your photos through e-mail and print and post images on the Web. You can download
Picasa from the following Web site http://picasa.google.com/linux/download.html.

The following section outlines the features of some of these graphics applications and how to use them.

Viewing and Managing Photos with F-Spot

Instructor Notes:

After a brief explanation of F-Spot and its features, refrain from lengthy explanation of the tasks.
Perform a brief demo of the tasks covered in the lesson and ask students to follow.

F-Spot is a personal photo management application for the GNOME desktop. You can import and view
pictures from the hard disk on your computer, digital camera or even the ipod. You can attach tags to your
photos and categorise them, build a photo CD, export photos over the Internet and share them online or
perform basic colour-correction and editing. F-Spot supports 16 common file types, including JPEG, GIF,
TIFF and RAW.

The following graphic shows the elements in the F-Spot interface:

Figure 7.1. F-Spot Window
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Importing Photos in F-Spot

After importing the photographs, you can categorise and tag them as you would to create a playlist in a
music player.

Procedure 7.1. Importing Photographs from the Hard Disk

To import photographs into F-Spot from the hard disk of your computer:
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On the Applications menu, point to Graphics and click F-Spot Photo Manager. The F-Spot window
opens.

Click the Import button on the toolbar. The Import dialogue box opens.

Figure 7.2. Importing Photos
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Note:

You can also click Import on the File menu to open the Import dialogue box.

In the Import Source box, the Select Folder option is selected by default. Retain the option, navigate
to the folder that contains the photographs and click Open.

Figure 7.3. Selecting Photo Import Source
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Figure 7.4. Displaying Images to Import
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Click Import in the Import dialogue box.

Figure 7.5. Importing Photos
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The photographs are listed as thumbnails in the F-Spot window. Notice that the timeline slider is
positioned according to the dates on which the images were saved on the hard disk of your computer.
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Figure 7.6. Browsing Photos
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The photographs listed in the F-Spot window are not associated with any category or parent
tag.

Procedure 7.2. Importing Photographs from a Digital Camera
To import photographs into F-Spot from a digital camera:
1. Click the Import button on the toolbar. The Import dialogue box opens.

2. Click the Import Source box. Plug the camera on the computer. F-Spot detects the camera and
displays the model and type of the camera in the Import Source box.

Figure 7.7. Selecting Photo Import Source
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3. Click the camera as the source for the photographs. The Select Photos to Copy From Camera
dialogue box opens, which lists all the photos in the camera. Select the photos you want to import
and click Copy.

Figure 7.8. Selecting Images to Copy
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4. F-Spot copies the photographs to the specified location and displays the copied photographs in the
right pane of the F-Spot window.

Viewing Photos

After importing, you can view all the photographs as thumbnails in the right pane of the F-Spot window.
You can view photographs in F-Spot by:

* Double-clicking each thumbnail to enlarge the view
¢ Select a thumbnail and click Fullscreen on the toolbar

The image opens in fullscreen mode.
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Figure 7.9. Browsing Photos
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Figure 7.10. Viewing Photos in Full Screen Mode

Click Exit fullscreen to return to the F-Spot window.

Organising Photos

By default, F-Spot organises photographs based on the dates in which they were saved on the computer.
You can view photographs for a specific date and time by clicking the corresponding year on the timeline
slider or moving the slider along the timeline. For example, assume that there are 100 images in the right
pane, 50 of which were saved in 2004 and 50 in 2007. To view the images for 2004, position the slider
on the timeline at the 2004 mark.
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To organise the photographs differently, you can attach a tag or a label to each photo and categorise them.
You can then view photographs based on these categories.

Some categories are already predefined and visible in the left pane of the F-Spot window. You can group
your photos under these tags.

To add a tag to a photograph:

+ In the F-Spot window, right-click a photograph, point to Attach a Tag and click the tag with which you
want to associate the photograph. The tag is displayed at the bottom of the photograph.

Figure 7.11. Tagging an Image
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Figure 7.12. Viewing Tagged Images
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The tagged image is now displayed under the tagged category.

Removing Red Eye

In some cameras, the proximity of the flash to the lens causes the light from the flash to reflect from the
subject's retina to the lens, leaving a red eye mark on the image. Referred to as a red eye, the size of the
mark depends on the amount of light reflected. F-Spot Photo Manager software can be used to remove
the red eye from images.

Figure 7.13. Image with a Red Eye

Procedure 7.3. To remove red eye from an image:

1. Inthe F-spot Photo Manager window, click the thumbnail of the image that has a red eye. Click the
Edit button in the navigation toolbar. Use your mouse to select the area you wish to correct on the
image. You can zoom in on the area by using the slider bar in the bottom of the work area.
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Figure 7.14. Removing Red Eye
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2. Click the Redeye Removal icon underneath the image. F-spot automatically corrects the image.

Note:

The edited image also replaces the image stored on your computer. Ensure that you save a
copy of the image before editing it.

The GIMP

GNU Image Manipulation Programme (GIMP) is the default graphic application in Ubuntu, licensed under
the GNU General Public License. It is an open-source multi-platform image manipulation tool, available
in many languages. You can use GIMP to re-touch photos, compose and create images, re-size, crop,
manipulate colours and convert image formats.

GIMP has a number of useful features:

* A full suite of painting tools, including brushes, a pencil and an airbrush

* Selection tools such as rectangle, ellipse, free, fuzzy and bezier

 Transformation tools such as rotate, scale, shear and flip

* Tile-based memory management so that the image size is limited only by available disk space
* Multiple undo/re-do operations limited only by disk space

* Advanced scripting capabilities

+ Layers and channels for complex drawings

+ Sub-pixel sampling for all paint tools to minimise distortion while representing high-resolution images
in lower resolution or stretched mode

+ Full alpha channel support to simulate transparency in images
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+ Support for multiple file formats, including GIF, JPEG, PNG, XPM, TIFF, TGA, MPEG, PS, PDF, PCX
and BMP

Procedure 7.4. To launch GIMP from the desktop:

1.  On the Applications menu, point to Graphics and click GIMP Image Editor. The GIMP Tip of
the Day prompt is displayed. Click Close on the GIMP Tip of the Day prompt. The GIMP window
opens.

Figure 7.15. GIMP Tip of the Day Dialogue Box
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Nice to Know:

The GIMP mascot is a coyote named Wilber. He provides useful tips while you use the
application. If you do not want to see the tips, clear the Show tip next time GIMP starts
check box.

2. To open an image for modification, on the File menu, click Open and select the image you want to
modify.

Figure 7.16. Opening an Image for Editing
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3. The selected image opens in the Image window.
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Figure 7.17. Editing Image
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You can now modify the image by using the tools available in the GIMP window.

Nice to Know:

You can drag and drop a colour from the toolbox or from a colour palette onto an image.
This fills the current image or selection with the selected colour.

Instructor Notes:

If time permits, allow students to familiarise themselves with GIMP. Ask students to open
an image and perform basic operations such as cropping the image, inserting text into the
image, rotating the layer and smudging the image by using the available tools.

Drawing with Inkscape

Inkscape helps you draw illustrations for the Web, graphics for mobile phones, simple line drawings,

cartoons, complex works of art, figures for chapters and books or organization charts.

Inkscape is a high-end graphic tool with capabilities similar to Illustrator, CorelDraw or Xara X. It is
multi-platform software that is freely available for the Linux, Microsoft Windows, Solaris and Mac OS

X operating systems.

You can use it to rotate, re-size, skew, proportion, fill and stroke objects with a high level of precision.

Advanced visual effects such as gradient and transparency are also available.

Inkscape is not part of the default graphics package in Ubuntu however, you can install this package from

repositories.

Installing Inkscape

There are two ways to install Inkscape. You can install this application from the repositories by using

Synaptic Package Manager or from the Command Line Interface (CLI).
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Note:

Your computer must be connected to the Internet while installing the application from the
repositories.

Procedure 7.5. Installing Inkscape by Using Synaptic Package Manager

1. Onthe System menu, point to Administration and click Synaptic Package Manager. The Synaptic
Package Manager window opens.

Figure 7.18. Launching Synaptic Package Manager
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2. Inthe Synaptic Package Manager window, the left pane lists the categories of software and the right
pane lists the packages in a category. Click Search. The Find dialogue box opens. Type Inkscape
in the Search field and click Search.

Note:

To view installed and uninstalled packages, click Status. For the source repository of the
package, click Origin. Click Custom Filters to determine whether a package is broken or
upgradeable. To return to the list of categories after searching the packages, click Sections.
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Figure 7.19. Searching Inkscape
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3. The Search results are displayed in the right pane of the Synaptic Package Manager window. Right-
click Inkscape and select the Mark for Installation check box.

Figure 7.20. Marking Inkscape for Installation
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4. Click Apply on the toolbar to begin the installation process. A Summary dialogue box is displayed,
which prompts you to confirm the changes. Click Apply to proceed with the installation.
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Figure 7.21. Confirming Changes
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5.  After the installation is complete, click Close in the Changes applied dialogue box.

Figure 7.22. Changes Applied Confirmation
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changes. You can close the
window now.

[] Automatically close after the changes have been successfully applied

D Details

To launch Inkscape, on the Applications menu, point to Graphics and click Inkscape Vector illustrator.

Creating Vector Graphic Images Using InkScape

Instructor Notes:

To utilise the full potential of this application requires some hands-on experience on similar
applications. This topic introduces students to Inkscape and covers the basic concepts. To engage
students with some prior experience, use an example from the help manual and make them
perform the steps given in the manual.
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Page: This area enables you to specify various options for the output. For example, you can specify
the Page dimensions for printing on A4 size paper. The Page adjusts accordingly and you can adjust the
proportion the drawing relative to the Page.

Menu Bar: This toolbar provides menus such as file save and zoom. You can perform all operations in
Inkscape by using the options listed on these menus.

Command Bar: This toolbar provides shortcuts to major operations on the menu bar.

Drawing Toolbar: This toolbar provides options to perform drawing operations. You can create basic
shapes such as a rectangle, a square or an ellipse.

Tools Control Bar: This toolbar provides options specific to a tool on the Drawing toolbar. For example,

if you select the polygon tool from the Drawing toolbar, the Tools Control Bar displays options to set the
corners in the polygon.

Status Bar: This toolbar indicates the status of objects such as dimensions and layers. For example,

when you roll the mouse over the window, the Status Bar indicates the position of the cursor relative to
the window.

Note:

Vector drawing software uses standard notation to refer to shapes such as simple lines, rectangles
and complicated shapes as objects.

Creating and Saving Objects. Creating a new object in Inkscape requires extensive use of the Drawing

toolbar. However, the options in this toolbar help you to create basic shapes. To create complex objects,
you need to further edit, combine and manipulate these shapes.

Procedure 7.6. To create an object by using the Drawing toolbar:

1. Click the object button associated with the shape you want to draw. Point anywhere in the page where
you want to start drawing the object.

2. Drag the cursor to the desired size of the object. The object is displayed in the page.
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Figure 7.23. Drawing an Object
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The Tools Control Bar displays options to create the object. For example, if you are creating a
rectangle, the toolbar provides the option to specify the height and the width of the rectangle.

After creating the shape, click Save on the Command Bar. The Select file to Save to dialogue box
is displayed. Type the name of the file in the Name text box, specify the location where you want
to save the file and click Save.
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Figure 7.24. Saving an Object
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Note:

Inkscape saves images as vector graphics. You can resize a vector image without affecting
the resolution of the image.

Using a Scanner

Scanning an object in Ubuntu is simple. If you have a USB scanner, plug the scanner directly into your
computer. Most plug-and-play devices are compatible with Ubuntu, if however, the computer fails to detect
the scanner, you will need to check its compatibility with Ubuntu.

Checking Scanner Compatibility

You can check the compatibility of your scanner with Ubuntu in one of two ways:

* Visit this Web site for the list of scanners and drivers compatible with Ubuntu: https://wiki.ubuntu.com/
HardwareSupportComponentsScanners.

* Check the status of your scanner at the following Web site: http://www.sane-project.org/sane-
backends.html. This site lists the drivers distributed with sane-backends-1.0.18 and supported hardware
and software.

Scanning an Image

You can scan an image by using the scanner interface or the scanning application XSane, which is available
in Ubuntu.
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Procedure 7.7. To scan an image by using XSane:

Options dialogue box is displayed.

scanner and click Scan to begin scanning the object.

Figure 7.25. Using XSane
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On the Applications menu, point to Graphics and click XSane Image Scanner. XSane automatically
searches for a scanner attached to the computer. After your computer detects the scanner, the XSane

The XSane Options dialogue box provides options to modify the default settings of the output. You
can specify the number of copies to be scanned, the name of the output file, the output file type, and
colour and contrast options. After you specify the properties of the output file, place the object on the
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Figure 7.26. Viewing Scanned Output

Adjust image paramreters such

as set gamma value, brightness
and contrast

After the object is scanned, a viewer window displays the output.

Viewe

)2

File Edit Filters Geometry

NOENDEENED

Size 637 x 871 pixel, 8 bit/col

our, 1 colours, 75 dpi x 75 dpi, 541 .8 KB

236



Making The Most of
Images and Photos

Note:

Before beginning the scanning operation, check the compatibility of your scanner with
Ubuntu. Sometimes, Ubuntu detects the scanner as hardware but fails to scan if the required
driver is missing.

4. Continue to scan other images or close the XSane Options dialogue box to exit the application.

Lesson Summary

In this lesson, you learned how to:
* View and organise your photo collection by using the default Ubuntu graphic applications:

» The F-Spot Photo Manager enables you to import pictures, organise your photos using tags, create
a photo CD, display photos as a slide show and create albums of your photo collection for the Web.

» Use GIMP for advanced image manipulation and creation.
+ Create graphics in the SVG format by using the Inkscape vector graphics editor.

* Scan your images and save them in various formats by using XSane Image Scanner.

Review Exercise

Question: Which of the default graphics applications provides the option to display only a category of
images from a randomly stored pool of images?.a) Inkscapeb) F-Spotc) Xsaned) GIMP

Answer: b) F-Spot

Question: Which default graphics application in Ubuntu facilitates photo sharing over the Internet?
Answer: The F-Spot Photo Manager

Question: Is there any additional software required to import images from a digital camera?

Answer: No, Ubuntu automatically identifies plug-and-play devices. F-Spot Photo Manager can
identify the connected device and enable you to import images directly from the application interface.

Lab Exercise

Exercise 1: Creating a Web Album by using F-Spot. You have just returned from a vacation with
your friends. You decide to write about this experience on your blog and post some photographs of the
trip. However, uploading images one by one to the Web site involves a lot of effort and time. You want
to find a more convenient way to do this.

Procedure 7.8. To perform the required task:
1. Launch F-Spot Photo Manager. The default window is displayed.

2. Click Import on the navigation bar. Navigate to the folder containing the photos Open. The
workspace displays all the images available in the folder.
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Select the images you want to include in the Web album.

Click Copy to import the selected photos. F-Spot displays the photos in the preview window.

In the preview window,select the photos you want include or use Select All from the Edit menu.
In the Photo menu, select the Export to and then Web Gallery.

You will need to enter the name of the Gallery, as well as the URL and log-in information for the site.
F-Spot will then upload the selected items to the website.
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Objectives
In this lesson, you will learn to:

* Play, edit and organize music and video files.

Instructor Notes:

It is recommended to cover all the topics in this lesson. However,if you fall short of time then
cover only the following topics:

Legal Restrictions
Playing Audio Files
Using an iPod
Viewing DVDs

Playing Online Media

Legal Restrictions

Ubuntu fully supports playback of music, videos and DVDs available in free and unrestricted formats.
A number of multimedia formats are restricted by licenses and software patents in some jurisdictions.
Ubuntu does not offer this capability by default for these formats but it easy to enable playing a variety of
proprietary formats. This section will guide you through the patent and copyright restriction considerations
for using proprietary file formats.

The license of the format is different from the license of the content itself. For example a video's content
can be licensed under a Creative Commons license, and be available as MPEG file. While the content
can be distributed freely, the format is proprietary and a software for playback may need to be licensed
in some jurisdictions.

To understand the legal issues associated with the use of proprietary formats, you first need to understand
the difference between free and non-free or proprietary formats.

Playing Music Files

Ubuntu comes with the Rhythmbox Music Player to play and organise music files. Similar to iTunes in
its interface, this music player is a free software application designed to work in the GNOME desktop
environment. Using Rhythmbox, you can play your music files, listen to Internet radio, import music from
CDs and organise your music files. Rhythmbox offers comprehensive audio support for a large number of
audio formats and contains various useful features that make playing music easy and enjoyable.

Instructor Notes:

You need to demonstrate and let the students play fully with at least 1 music, 1 DVD playback
and 1 audio recording.
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Playing Music using Rhythmbox

Procedure 8.1. To play music using Rhythmbox:

1. On the Application menu, point to Sound & Video and then click Rhythmbox Music Player. A
welcome screen is displayed.

Figure 8.1. Launching Rhythmbox

-C“Applications Places System a

E!'b Accessories »

|'£L| Games 3
‘fi Graphics »
@__;:. Internet 3
@ Office »
/‘( Programming 3
w Sound & Video ) ’:} Audio CD Extractor

Q. Brasero Disc Burning

@ Add/Remove..,

'i'\:,,,,}"' Rhythmbox Music Player

@ Sound Recorder

Play and organize your music collection

2. The main window of the Rhythmbox Music Player opens. Now, you will be able to organise your
favourite music using this window.
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Figure 8.2. The Rhythmbox Music Player
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To start playing music in Rhythmbox, you need to first select the music source from the Source list.
By default Library is selected as the source when you open Rhythmbox for the first time.

Library is the main source available in Rhythmbox. You can import all your music files into the
Rhythmbox library and can start playing immediately. You also use the music files in your library to
create smart customised playlists and play-queues. To start importing individual music files, right-
click Music and click Import File. It displays the Import File into Library dialogue box.

Figure 8.3. Importing Music Files
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4.

In the Import File into Library dialogue box, navigate to the folder from which you want to import
the files. Select the files that you want to import and click Open.

Figure 8.4. Selecting the Files to Import

E][Ea williamwindsor || Music || Ceséria Evora ||S&do Vicente
Places Name ~  Modified
%, Search | | 01 - S80 Vicente Di Longe.ogg Yesterday at 13:30
&) Recently Used | ] 02 - Homem Na Meio Di' Homem.ogg Yesterday at 13:31
Eg willamwindsor | ] 03 - Tiempo ¥ Silencio (feat. Pedro Guerra).ogg Yesterday at 13:31
& Desktop | | 04 - Sabér De Pecado.ogg Yesterday at 13:32
L File System | | 05 - Dor Di Amor.ogg Yesterday at 13:33
| FACTORY_IMAGE | | 06 - Nutridinha.ogg Yesterday at 13:33
I HP | | 07 - Regresso (feat. Caetano Welosa).ogg Yesterday at 13:34
53 Music | | 08 - Esperanga Irisada.ogg Yesterday at 13:35
& Documents | | 09 - Ponta De Fi.ogg Yesterday at 13:35
B Music | ] 10 - Crepuscular Sclid&o (feat. Bonnie Raitt).ogg Yesterday at 13:36
& Pictures | ] 11 - Linda Mimosa (feat. Orquesta Aragon).ogg Yesterday at 13:37
& Videos | ] 12 - Negue (feat. Chucho Valdés).ogg Yesterday at 13:37
| ] 13 - Bondade E Maldade.ogg Yesterday at 13;38
| ] 14 - Fada.ogg Yesterday at 13:39
| ] 15 - Pic Mic MNa Salamansa.ogg Yesterday at 13:39
l@gancel i d_jgpen

Nice to Know:

While importing music files from your music collection, Rhythmbox also imports the
metadata tags associated with the files. These tags are used by Rhythmbox to categorise the
music files by genre, artist, album, title, and track number.

The selected music files are imported into the library and displayed in the the Rhythmbox window.
You will notice that the main Rhythmbox window is split into various panes. Each pane displays
different details about your music collection. To play music from the library, you can use the Artist,
Album and Track panes to select the music tracks that you want to play and then use the playback
controls to start playing the music tracks. Click the Play button to start playing the selected track.

242



Playing Music and Videos

Figure 8.5. The Rhythmbox Window
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If you click the Play button without selecting any track, Rhythmbox will start playing the first track
from your current view. You can use the Shuffle button to play tracks randomly. You can also create
a play list by right-clicking a music track and selecting Add to Playlist. To stop or pause a track,
click the Play button again.
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Figure 8.6. Creating New Playlist
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Rhythmbox offers many additional useful features in the form of various plugins. Some of these
plugins are not turned on by default. To access these plugins, on the Edit menu, click Plugins. The
Configure Plugins dialogue box opens.
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Figure 8.7. Accessing Plugins
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Edit music player preferences

You can view all the available plugins in the left pane of the Configure Plugins dialogue box.
Selecting a plugin displays its details in the right pane of the dialogue box.

Depending on your requirements and preferences, you can activate these plugins to get extra
functionality in your Rhythmbox. For example, the Magnatune Store plugin enables iTunes-style
song previews and paid downloads. Activating Visualization renders a real-time visualization of the
music on the screen while you listen to a song track. Similarly, if you want to automatically retrieve
the lyrics of the song being played, activate Song Lyrics by selecting the corresponding check box
and click Clese to exit the Configure Plugins dialogue box.
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Figure 8.8. Activating Plugins
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10. You are returned to the main Rhythmbox interface. To start retrieving the song lyrics, on the View

menu, click Song Lyrics.
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Figure 8.9. Retrieving Song Lyrics
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11. Amazingly, Rhythmbox retrieves the song lyrics for you. Now, you can sing along while listening
to your favourite song.

Figure 8.10. The Song Lyrics Retrieved
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12. Similarly, if you wish to view animations while listening to a song, click the Visualization button.
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Figure 8.11. Activating Visualisation
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13. You can view animations while playing a song.
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Figure 8.12. Viewing Animations
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14. Rhythmbox also enables you to listen to music from a variety of sources, such as Internet radio stations
and podcasts.

To play music from a podcast of your choice, right-click the Podcast option in the Source list and
select New Podcast Feed.
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Figure 8.13. Adding New Podcast Feed

Cesana Evorat=Bondade’EeMaldade

Music Edit Wiew Control Help

[ K e @ =3 G, [ ] &
Play | Previous  Next Repeat  Shuffle Browse Wisualization MNew Podcast Feed...

Bondade E Maldade by cesania Evora from Séo Vicente

1:16 of 5:02

A Music (<] §earch:[ jl l All l Feeds Episodes

’ Podcasts lFEEd

= % New Podcast Feed...
B Radio
@ Update All Feeds

Last.fm [

Stores - @ Date Title Feed Time Status

@ Magnatune
E Jamendo

Playlists -
@ My Top Rated
@ Recently A...
@ Recently PI...

Devices ~

(B rroplendn 5

[+] (4]

Subscribe to a new Podcast Feed

Note:

Podcasts are audio shows broadcast over the Internet that you can subscribe to. Subscribing

to a podcast enables you to download each new audio release from the subscribed podcast
source.

Instructor Notes:

If the students want to know more about podcasts, advise them to read the Wikipedia article
on podcasting: http://en.wikipedia.org/wiki/Podcasting.

15. Enter the podcast feed URL in the New Podcast Feed text box and click Add.
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Figure 8.14. Entering Podcast Feed URL

New Podcast Feed

URL of podcast feed;

[ds.feedburner.come.IbuntuUkPodcastOgg-high?formatzxmll

l ogancel

[ 4 add |

16. Rhythmbox automatically looks for the latest podcasts and downloads them for you. To play a podcast
episode, select the episode that you want to play and click the Play button.

Figure 8.15. Playing a Podcast

Cesana Evorat=Bondade’E-Maldade =

Music Edit Wiew Control Help

[> K e @ % [ ] § .
Play | Previous  Mext Repeat  Shuffle Browse Visualization Mew Podcast Feed...

Bondade E Maldade by Cesaria Evora from Sdo Vicente 4:27 of 5:02

A Music —{ Search: j] [ All l Feeds Episodes B
, Podcasts I} | Feed =
— . 1 feed
B Radio
Ubuntu UK Podcast » ogg-high -
Last.fm bs
Stores - i Date Title Feed Time Status (s
@ Magnatune Mar 11 08:37 AM  SO1EO1 - A little |... Ubuntu UK Podcast 41:27
Mar 24 06:01 PM  SO1EOZ2 - Stuck ... Ubuntu UK Podcast 40:04
E Jamendo
] Apr 07 04:36 PM SO1E03 - Help Me  Ubuntu UK Podcast 37:17
Playlists e
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May 27 02:10 PM  SO1EO06 - Flamin... Ubuntu UK Podcast 39:01
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Jun 26 04:43 PM SO1E08 - Donch... Ubuntu UK Podcast 55:57
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(B _rrockead @ =) wl 18 N7eAn mna SAIE1A Eaew i Libhuntu LIV Dadeact AQ:1a

Kl

19 episodes, 14 hours and 44 minutes, 401.6 MB

17. Rhythmbox also allows you to listen to radio streamed from Internet radio stations across the world.
To listen to Internet radio, click the Radio source in the Source pane.
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Figure 8.16. Playing Internet Radio
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18. By default the Radio source lists several radio stations, each of them broadcasting a different genre
of music. Double-click on the radio station of your choice to listen to the streaming media.
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Figure 8.17. Listening to a Radio Station

Music Edit Wiew Control Help
= .
[> ki B (= 8 © (] Ey €
Play | Previous  Mext Repeat  Shuffle Browse Visualization Mew Internet Radio Station...
Virgin Classic Rock (Broadband) 0:08
E
ﬂ Music - Search: [ ;ﬂ -
— il Title Genre —
’ Podcasts o
- . CBC Radio One (Canada) General
[ Radio :
CBC Radio Two (Canada) General
Last f . .
@ astm MNRK Alltid Klassisk (Norway) Unknown
Stores ¥ MNRK Alltid MNyheter (Morway) Unknown
@ Magnatune MNRK mP3 (Norway) Unknown
Jamendo MNRK P1 (Morway) General
Playlists - MRK P2 (Norway) General
[@| My Top Rated MNRK P3 (Morway) General
@] RecentlyA.. MNRK Stortinget (Morway) Unknown
[> wirgin Classic Rock (Broadband) Rock'n'Rall B
@ Recently PI...
wvirgin Classic Rock (Modem) Rock'n'Roll
Fr| o .
Virgin Radio UK (Broadband) Pop
i - |
DE\iICES L wirgin Radio UK (Modem) Pop L
(ot rroclead o | L=
17 stations i

Instructor Notes:

Advise students to read the Wikipedia article on Internet Radio if they want more background
information: http://en.wikipedia.org/wiki/Internet_radio.

19. You can also add a new radio station to the existing list by clicking New Internet Radio Station and

pasting the URL of the new radio station in the URL of Internet radio station text box. Click Add
to add the radio station in the existing list.
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Figure 8.18. Adding New Radio Station
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20. You can add many more Internet radio stations in the same way and listen to your favourite radio
stations with just a click of your mouse.

Playing and Extracting Audio CDs

Sound Juicer is the default application available in Ubuntu for playing and extracting audio compact discs
(CDs). It is an easy-to-use CD player and ripping tool that requires minimal user intervention in playing
and extracting audio CDs. Using Sound Juicer, you can play audio tracks directly from the CD and extract
audio tracks and convert them into audio files. Sound Juicer allows you to extract audio files into the
following three formats:

* Ogg Vorbis: Ogg vorbis is a free, unpatented and open source alternative to the proprietary MP3 format.
Like the MP3 format, it discards parts of the sound that humans cannot normally hear. An Ogg Vorbis
file is typically a tenth of the size of a WAV format file containing the same content.

* FLAC: FLAC stands for Free Lossless Audio Codec. It is an unpatented, open source audio format.
Unlike MP3 or Ogg Vorbis, FLAC compresses audio without discarding any information. A FLAC file
is typically half the size of a WAV file containing the same content.

* WAV: WAV is short for Waveform Audio Format. It is an uncompressed format typically used for short
snippets of sound and voice recordings.
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Note:

To know more about Ogg Vorbis and FLAC audio format, visit the following Web sites:
* http://www.vorbis.com/faq/

« http://flac.sourceforge.net/
Playing Audio CDs

Procedure 8.2. To play audio CDs using Sound Juicer
1. Insert an audio CD in the CD drive of your computer. The Sound Juicer CD player and ripper is

launched automatically. To start Sound Juicer manually, click the Applications menu, point to Sound
& Video and then click Audio CD Extractor.

Figure 8.19. Launching Sound Juicer

ﬁApplicatinns Places System e@e

E_}. Accessories »

[v} Games b

‘J'i Graphics C

E; Internet r

IQJ Office r
p )

~ Programming 3

m Sound & Video v @ Audio CD Extractor

I.::.l Brasero Disc Burning

@. Add/Remove. ..

B Movie Player

—

Rhythmbox Music Player

o}

ﬁ Sound Recorder

2. Sound Juicer's main interface is displayed. When Sound Juicer detects a CD, it examines the CD and
tries to search the Internet to locate information about the CD's content. If you are connected to the
Internet, Sound Juicer will retrieve the CD artist, title, and track data from MusicBrainz.org.

To play all the tracks sequentially, you can simply click the Play button.
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Note:

MusicBrainz.org is a community-maintained online database, which contains data on over
360,000 published albums.

Figure 8.20. Playing Audio CD

%] oundiuicer; [=]
Disc Edit Help

[

Title: [Séo Vicente ]

Artist: [Ceséria Evora ]

Genre: Year: |2001| Disc:
[ l [
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¥ 4 Sabér De Pecado Ceséaria Evora
¥ s Dor Di Amor Ceséaria Evora
7 & Rltridink CeeAria Dyenr z
. | [»]
l [ Blay l l .\9/. Extract l

Notice that Sound Juicer has fetched the track information from MusicBrainz.org. In the upper part
of the Sound Juicer window, you can see the basic information about the disc, including title, artist,

genre and total duration. The lower part of the window displays a list of tracks, each with its full
title, artist and duration.

To play only the tracks of your choice, select the particular tracks by selecting the corresponding
checkboxes and then click the Play button.
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Figure 8.21. Selecting the Song tracks

| Sound Juicer, = EE
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You can now enjoy listening to your favourite music tracks.

Figure 8.22. Playing the Selected Tracks
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Extracting Audio CDs

If you want to listen to your favourite music tracks without needing to insert a CD every time, you can

create a copy of the CD and extract the music tracks on your computer.

Procedure 8.3. To extract the audio CD:

Insert the audio CD and click the Extract button. However, if you want to define the audio quality,
format and the location where the files would be stored, click Preferences on the Edit menu. This

displays the Preferences dialogue box.

Figure 8.23. Defining Preferences For Audio Files

< Sutichjuilas BEE
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| [+]
l [ Play l l _ Extract

You can use the Preferences dialogue box to define a number of things such as how the folder
hierarchy should be saved, how the files should be named and whether to eject the CD automatically

after the tracks are extracted.

In the last section of the Preferences dialogue box, you can define the file format in which the tracks
would be stored on your computer. Based on your requirements, select any one format from the

Output Format drop-down list.

Nice to Know:

You can also extract CD audio files to the proprietary, non-free MP3 format. Instructions for
extracting audio files into the MP3 format can be found in the help for Sound Juicer. Go to

Help>Content and then navigate to the Preferences section.
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Figure 8.24. Specifying Audio Format

(4] Preferences =

Device

4
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Folder: lE] Music = l
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File name: l Number - Title v
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Example Path: /The Beatles/Help!/07 - Ticket To Ride.ogg

Format CD Quality, Lossless (FLAC audio)

Output Format: CD Quality, Lossy (0gg multimedia) @Edit Profiles...

\oice, Lossless (WAV audio)

oice, Lossy (Speex audio)

Each of these file format has its own customisable profile. Depending on the type of the music track
and the destination where it has to be stored, you may need to customise these file formats. Click the
Edit Profiles button, then select the desired profile and click the Edit button to edit the profile of the
selected file format according to your needs.

Figure 8.25. Editing Audio Profile

Profiles:

CD Quality, AAC = [#yNew
CD Quality, Lossless

CD Quality, Lossy % Edit

CD Quality, MP3

\oice, Lossless

(oI

Voice, Lossy

€ Help b4 close

The Editing profile dialogue box for the selected audio profile is displayed. You can edit the audio
profile according to your requirements and the click Close to exit.
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Figure 8.26. Customising Audio Profile
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You can also use the Preferences dialogue box to define the location where you want the audio files
to be stored on your computer. By default, Sound Juicer stores the audio files in the Home directory.
To define a location of your choice, select a directory from the Music Folder drop-down list and click
Close to exit the Preferences dialogue box.

Figure 8.27. Specifying Audio File Location
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After configuring your preferences, you can go ahead and start extracting all the tracks by clicking
the Extract button. However, if you want to exclude some tracks, deselect them by clearing the
corresponding check boxes.

Depending on the speed of your computer, the extracting process can take a long time. You can watch
the total progress of the process in the lower left section of the Sound Juicer window.
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Figure 8.28. Extracting Song Tracks
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Sound Juicer notifies you after the selected tracks are extracted successfully. Click Open to view the
tracks copied on your hard disk.

Figure 8.29. Viewing Copied Tracks

@ Have | Told You Lately has been copied successfully.

‘ Eject ‘ @gpen gaglose

The CD audio tracks are now copied as audio files on your hard disk. You can listen to these tracks
by simply double-clicking them.
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Figure 8.30. The Copied Tracks
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Burning Audio CDs

Besides copying audio tracks from a CD to your computer, Ubuntu also enables you to copy music files
from your computer onto a CD or DVD. Brasero is the CD/DVD burner application that comes bundled
with Ubuntu, by default. It is an easy-to-use application that also allows CD/DVD data disc creation, CD/
DVD copying and burning of existing images to CD/DVD.

Procedure 8.4. To burn an audio CD:

1. Launch Brasero by selecting the Applications menu, point to Sound & Video and then click Brasero
Disc Burning. The Brasero window is displayed.
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Figure 8.31. Launching Brasero
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The Brasero Window displays. Click the Audio Project button. You will need to navigate to the
folder containing the audio tracks you wish to add to the new CD project.
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Figure 8.32. Starting a new Audio Project
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Figure 8.33. The New Audio Project window
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Now you need to specify the files that you want to be copied onto the blank CD. To start specifying
the desired audio files, click the Music folder. This displays the contents of any items previously
imported. Double-click the title of the folder where the music files are located. The files are listed

in the middle window. You can now add files to the project using any of the methods described in
the right side window.
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Figure 8.34. Specifying Audio Files to Copy
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The selected files now appear in the project window. You can also view the estimated disc usage once
these files are written to the disc at the bottom of the project window. Based on this data, you may
decide to add or delete some files from your current selection. Once you are sure of the files to be
copied to the disc, click the Burn button to start writing the audio files from your computer to the CD.

Figure 8.35. Writing Audio Files to Disc
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The Disc Burning Setup window allows you to change the Properties of the project. You can select
the Options checkbox to leave the disc open to add a data session later. Click the Burn button to
begin writing the files to the disc.
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Figure 8.36. Confirming the CD Writing
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Brasero now starts writing the music files to the media disc. You can view the progress in the Burning
Audio Disc dialogue box. This process may take some time depending on the size of the files to be
written to disc. Once the process is complete, you have a new CD containing all your favourite songs.
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Figure 8.37. Writing an Audio CD
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Playing Proprietary Multimedia Formats

As previously stated, due to the legal restrictions associated with the use of proprietary formats, Ubuntu
does not offer support for such formats by default. If you wish to play proprietary formats, you will need
to install additional multimedia codecs. A multimedia codec is a small piece of software that allows you
to watch videos or listen to music of a specific format. Although Ubuntu includes many codecs by default,
you may need to install more because there are many different multimedia formats and it is unrealistic
to provide them all.

Playback of multimedia files in Ubuntu is handled by the Gstreamer multimedia framework. GStreamer
by itself does not provide any multimedia codecs, it relies on codecs that have been packaged into a plugin
that it uses to perform the actual recording and playback. Typical plugins are:

* gstreamer0.10-plugins-ugly

« gstreamer0.10-plugins-ugly-multiverse
« gstreamer0.10-plugins-bad

« gstreamer0.10-plugins-bad-multiverse

« gstreamer0.10-ffmpeg
Note:

To know more about which Gstreamer package contains which plugins, visit the following Web
site: http://gstreamer.freedesktop.org/documentation/plugins.html.
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Other applications, such as VLC, MPlayer and Xine, do not use the Gstreamer framework.

You can use the Synaptic Package Manager, or the Command Line Interface (CLI) to install these
multimedia codecs available in the repositories.

Nice to Know:

Codecs can be installed directly from the Movie Player. When Movie Player recognizes a format
it cannot play, it checks if a Gstreamer plugin is available for this format. If it finds one, you can
install the codec easily without following the lengthy solution presented below.

Procedure 8.5. To install a codec plugin using Synaptic Package Manager:

1.

2.

On the System menu, point to Administration and then click Synaptic Package Manager. The
Synaptic Package Manager window opens.

Figure 8.38. Launching Synaptic Package Manager
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The Multiverse and Restricted repositories are not activated by default in Ubuntu. To install the
additional multimedia codecs, you need to first activate these repositories. On the Settings menu,
click Repositories. The Software Sources dialogue box is displayed.
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Figure 8.39. Displaying Software Sources
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3. To enable the Multiverse and Restricted repositories, select the third and fourth check boxes available
on the Ubuntu Software tabbed page, and click Clese to exit the dialogue box.

Figure 8.40. Enabling Repositories
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Installable from CD-ROM/DVD

To install from a CD-ROM or DVD, insert the medium into the drive.
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4. You may receive a notification that your repository information has changed. Click Close to exit this
message.

Figure 8.41. Repositories Information Notification
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5. Once you return to the Synaptic Package Manager window, you are required to click the Reload
button to apply your changes.

Figure 8.42. Applying Changes
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6. On clicking the Reload button, the system starts checking the repositories for new, removed or
upgraded software packages.
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Figure 8.43. Checking Package Information
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7.  After the Multiverse and Restricted repositories are added in the Ubuntu software sources, you can
download and install additional multimedia codecs. To install a software package, you need to first
locate the package in the Synaptic Package Manager window. You can either search for a specific
software package manually or run a search using the search utility provided in the Synaptic Package
Manager. To initiate a search for a specific package, click Search.

Figure 8.44. Initiating Software Search
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8. In the Search field, enter the name of the software package that you are looking for. Click Search
to begin the search.
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Figure 8.45. Searching a Software Package
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9. The search results are displayed in the right pane of the Synaptic package Manager window. Right-
click the package to be installed and select Mark for Installation.

Figure 8.46. Marking Packages for Installation
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10. You can mark multiple packages for installation by following the same procedure. Once all the
required packages are marked, click Apply to start downloading the packages. The Summary
dialogue box is displayed.
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Figure 8.47. Initiating Package Download
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11. The Summary dialogue box allows you to take a last look at all the software packages that you have
marked for installation. To go ahead with the marked installations, click Apply.

Figure 8.48. Conforming Package Installation
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12. After all the marked software packages are downloaded and installed, the Changes Applied dialogue
box is displayed. Click Close to exit the Changes Applied dialogue box.
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Figure 8.49. Changes Applied Notification

oy Changes applied =
Changes applied
% Successfully appled all
changes. You can close the
window now.

] Autormatically close after the changes have been successfully asplied

[ Details

13. The check box corresponding to the recently installed software package has changed to green,
indicating that the software has been installed successfully. You can repeat the same procedure to
install all the multimedia codecs required for playing proprietary multimedia formats.

Figure 8.50. Software Successfully Installed

File Edit Package Settings Help

Reload  Mark All Upgrades Search

Custom Filters

All g Package Installed Version  Latest Version Ra
| |
gstreamer0.10-plugins-u . gstreamer0.10-plugins-ugly _ 0.10.6-Oubuntu2 _ 0.10.6-Oubuntu2 G
[0  gstreamer0.10-plugins-ugly-dk 0.10.6-0ubuntu2 G
O gstreamer0,10-plugins-ugly-dc 0.10.6-0ubuntu2 G
[0  gstreamero.10-plugins-ugly-m 0.10.6-Oubuntul G
—
[] gstreamer0.10-plugins-ugly-m 0.10.6-0ubuntul GS|~]
] [+]
' [ D :
Mo package is selected.
[ Sections ]
[ Status ]
[ Origin ]

[ Search Results }

5 packages listed, 1140 installed, 0 broken. 0 to install/upgrade, 0 to remove

Using an iPod

The iPod is a popular portable media player, designed and marketed by Apple. You can play music in MP3
and AAC (Advanced Audio Coding) audio file formats and store up to ten thousand songs on the device
itself. The iPod does not support free multimedia formats.
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Playing Music Using an iPod

Procedure 8.6. To play music using iPod:

1. Plug your iPod into one of your computer's USB ports. Ubuntu automatically mounts it and places
it as an icon on your desktop. Simultaneously, the iPod device opens in the Rhythmbox Music
Player window. You can view all the files loaded on your iPod device in the lower right pane of the
Rhythmbox window. To play a music track from your iPod, just select the track from the list and

click the Play button.

Figure 8.51. Plugging in an iPod
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2. The song starts playing in the Rhythmbox Music Player. However, if the format of the music file is
not supported by the Rhythmbox Music Player, you may not be able to play the file and you will
receive an error message. In this case, you will need to follow the procedure described in the previous
section to download all the necessary software codecs from the Ubuntu repositories.
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Figure 8.52. Playing Music from iPod
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Ubuntu also allows you to transfer music files to and from the iPod device. However, this is not
possible using Rhythmbox. You will need to install the gtkpod software to be able to transfer music
file between your computer and the iPod device. You can easily download this software from the
Universe repository using the Synaptic Package Manager.

To access gtkpod, after it is successfully installed on your computer, on the Applications menu, point
to Sound & Video and then click gtkpod. The gtkpod window opens.
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Figure 8.53. Launching gtkpod
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You can view all the music files stored on the iPod device in this gtkpod window. Notice that in the
gtkpod interface, your music files have automatically been categorised based on artists, album and

genre. This categorisation helps you quickly browse through your collection and select.

You can use the gtkpod interface to manage the files on your iPod in multiple ways. You can create
and edit playlists, normalize the volume on single tracks or multiple tracks at a time. You can also
use the gtkpod interface to add more files in your iPod or transfer files from your iPod onto your
computer. To add files from your computer to your iPod device, click Files. This displays the Add

Files to 'device name' dialogue box.
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Figure 8.54. Using gtkpod to transfer files to iPod
O G RO e el

Fle Edit View Tocls Help

Gt Gl
Load iPod(s) Sawve Changes Add Files  Add Folder Add Playlist | New Playlist
Playlists Artist | Album l Genre l’ ‘[ Artist | Album | Genre l’
Htocal All New Zealand Our Land - Our -
Elreibre B EpEEEr Lord of the Rings: The Return
b = Dinda’s iPod | Alan jackson
~{ | Unreleased =
| || | D
Title Artist Album Genre Plycnt  + Rt
[] _1Relatio David Sp Learn Spanish - Podcast 0 e
] _2Spanis David Sp Learn Spanish - Podcast 0 0
[¥] 2Travel S David Sp Learn Spanish - Podcast 0 0
[¥] 3Travel S David Sp Learn Spanish - Podcast 0 0
[¥] 4Travel S David Sp Learn Spanish - Podcast 0 0
W] All star  Smashrr Promo Mainstre: Baseball 0 3
[#] All The Ri Nickelba Rock 0 1
[¥] Angel of Sarah Br Highlights From Soundtrack 0 10
Album Art o (Afmmminiomon il Theois —_— | |1,]L

15.6 GB Free [FRE Thonn

5. Inthe Add Files to 'device name' dialogue box, navigate down to the folder from which you want to
add the files to your iPod. Depending on your preferences you may either add a single file at a time
or an entire directory. Select the tracks that you want added and click Open.
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Figure 8.55. Selecting the Files to Transfer

D gtkpod [=][o][x]
Fle Edit VWiew Tools Help

E]lﬁa williamwindsor || Music | Great Big Sea ||Rant and Roar

Places ] Name ~ | Modified ]
[5, search | ] 01 - Ordinary Day.cgg Today at 14:55

&) Recently Used | ] 02 - When I'm Up.ogg Toclay at 14:56

3 williamwindsor | ] 03 - Mari-Mac.ogg Today at 14:56

@ Desktop | | 04 - End of the World.ogg Today at 14:57

L File System | | 05 - Fast as | Can.ocgg Today at 14:58

F, Dinda's iPod | | 06 - The Night Pat Murphy Died.ogg ~ Today at 14:58

[ FACTORY_IMAGE | ] 07 - Goin Up.ogg Today at 14:59
HP ||| 08 - General Taylor.ogg Today at 14:59

B Documents | | 09 - Dancing With Mrs, White.ogg Today at 14:59

& Music =) | ] 10 - Semething To It.ogg Today at 15:00 || |
| i | | — _| | ] 11 - Lukey.ogg Today at 15:00 | |

112 - The tld Black Rum.oan Tordav at 15:071 /17
l ogancel I h.fjgpen

Gtkpod starts adding the files to your iPod. When the process is complete a message "Successfully
added files" is quickly flashed at the bottom of the gtkpod window. You can also view the recently
added files in the bottom pane of the gtkpod window.

You can repeat the aforementioned steps to add more files from different folders. After you have
added all the required files to your iPod, click the Save Changes button to load and save the files.
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Figure 8.56. Updating the iPod
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When you are done updating your iPod and want to disconnect it, close down the Rhythmbox window.
Right-click the iPod icon on the desktop and then select Eject. You now can safely remove your iPod
from the computer.

Creating and Editing Audio Files

Ubuntu provides you with various tools to create your own music and audio files. The default application
available in Ubuntu for creation of audio files is the GNOME Sound Recorder. Similarly, you can also
edit audio files using Audacity.

Creating Audio Files

Ubuntu provides you with tools to create new audio files using an input device such as a microphone.
Sound Recorder is the default application available in Ubuntu for creating audio files.

Procedure 8.7. To start recording audio using Sound Recorder:

1.  On the Applications menu, point to Sound & Video and then click Sound Recorder.
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Figure 8.57. Launching Sound Recorder
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2. Sound Recorder allows you to record and play .flac, .ogg, and .wav audio files. To start a recording
session, you need to select an input device, such as a microphone, phone or line-in, from the Record
from input drop-down list. You can also select the audio quality from the Record as drop-down list.

Figure 8.58. Selecting the Input Device
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3. Before starting the recording, it is advisable to configure the volume control settings to derive quality
audio output. To access the volume controls, on the File menu, click Open Volume Control.
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5.

Figure 8.59. Accessing Volume Controls
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You use the slider buttons on the tracks to set the volume control for all the audio input and output
devices. To further specify your volume preferences, click Preferences on the Edit menu. This opens
the Volume Control Preferences dialogue box.

Figure 8.60. Displaying Volume Preferences
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The Volume Control Preferences dialogue box allows you refine the sound settings by selecting or

clearing the various options. Click the Clese button to exit this dialogue box.
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Figure 8.61. Configuring Sound Settings
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You are returned to the Sound Recorder window. Now, you can start recording the audio from the
selected input device by clicking the Record button. The recording starts.

Figure 8.62. Recording Sound
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After the recording is complete, you can play the recorded sound file by clicking the Play button. The
progress indicator moves along the progress bar as the sound file is playing. You can also view the
duration of the recorded file in minutes and seconds under the File information section.
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Figure 8.63. Playing Recorded Sound File
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Editing Audio Files

You can use Audacity for editing audio files. Audacity is not included in the default installation of Ubuntu
but it is a free and open source software application, which can be installed easily from the Universe
repository of Ubuntu. You can install Audacity using either the Add/Remove Applications or the Synaptic
Package Manger.

Procedure 8.8. To edit audio files using Audacity:

1. On the Applications menu, point to Sound & Video and then click Audacity Sound Editor.
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Figure 8.64. Launching Audacity
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2. When you access Audacity for the first time, it will ask you to select a language to use with the
application. Apart from English, Audacity provides language support for more than 30 languages,
including Arabic, Bulgarian, catalan, Czech, Danish, Finnish and many more. Select your language
preference from the Choose Language for Audacity to use drop-down list and click OK.

Figure 8.65. Selecting Language for Audacity
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3. The Audacity main interface window is displayed. You can use the various controls and tools to play,
create and edit audio files.
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Figure 8.66. The Audacity Window
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You can now start editing an existing audio file in Audacity. To do so, you need to first import the
audio file into Audacity. To import an audio file, on the File menu, point to Import and then select
Audio. The Select one or more audio files dialogue box opens.

286



Playing Music and Videos

5.

Figure 8.67. Importing Audio Files into Audacity
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Select the audio file that you want to edit and click Open to open the file in Audacity.
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Figure 8.68. Selecting the Files to Import

) Recently Used | ] 02 - Homem Na Meio Di' Homem.ogg

53 williamwindsor | ] 03 - Tiempo ¥ Silencio (feat. Pedro Guerra).ogg

] Desktop
. File System

|| 04 - Sabér De Pecade.ogg
|| 05 - Der Di Amor.ogg

|| 06 - Nutridinha.ogg

[ 07-
[ o8-

[, Dinda’s iPod
L_ FACTORY_IMAGE

= HP

Regresso (feat. Caetano Veloso).ogg

Esperanga Irisada.ogg

& Documents | | 09 - Ponta De Fi.ogg

= Music | ] 10 - Crepuscular Scliddo (feat. Bonnie Raitt).ogg
= Pictures | ] 11 - Linda Mimosa (feat. Orquesta Aragon).ogg
&= videos | ] 12 - Negue (feat. Chucho waldés).ogg

|| 13 - Bondade E Maldade.ogg
|| 14 - Fada.ogg
|| 15 - Pic Nic Na Salamansa.ogg

m[% williamwindser I Music || Cesdria Evora |[Sao Vicente]

Places Name - Modified

&, Searc - S&o Vicente Di Longe.o sterday at 13:
Search 01 - S&o Vicente Di Longe.ogg Vesterday at 13:30

vesterday at 13:31
Yesterday at 13:31
Yesterday at 13:32
Yesterday at 13:33
Yesterday at 13:33
Yesterday at 13:34
Vesterday at 13:35
Vesterday at 13:35
‘Vesterday at 13:36
Yesterday at 13:37
Yesterday at 13:37
Today at 15:36

Today at 15:35

Yesterday at 13:39

All files

.
v

The selected audio file opens in the Audacity interface. The audio file is represented as the blue
waves in the lower part of the Audacity window. Now you can perform a whole range of tasks on this
file.You can cut off some unwanted portion of the imported audio file, insert silence at some point,
can add various audio effects on different sections of the file and may even export the file into an

altogether different file format.

Audacity also allows you to play an audio file. Click the Play button to start playing the audio file.

Figure 8.69. Playing the Imported File
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7. The audio file starts playing in the Audacity audio editor. You can use the various tools available with
Audacity to start editing the current audio file:

» Magnifying tool: If you find that due to the length of the current file, you are unable to view the
portions that you want to edit, you can use the Magnifying tool. This will let you zoom in on a
specific area.

+ Envelop tool: This enables you to change the volume of specific selections of the sound file.

» Time Shift tool: Allows you to move the entire sound file in relation to time; helpful when you
are working with multiple tracks.

+ Selection tool: Enables you to highlight portions of the sound file on which you want to work.

To start editing a specific portion of the sound file, activate the Selection tool by clicking it.

Figure 8.70. Picking the Selection Tool
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8. Select the area you wish to edit by dragging across the area while pressing the left mouse button. The
selected area appears in a shade of darker gray.
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Figure 8.71. Selecting Audio Portion to Edit
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You can now cut the area if you wish to remove this part of the audio file otherwise, edit this portion
by applying various sound effects to it. The Effect menu contains all the digital audio effects that you
can apply on an audio file. Some of these are:

» Amplify - Increases or decreases volume without altering sound quality

» BassBoost - Increases the volume of a specific frequency.

» Echo - Allows you to add an echo specify the delay time.

+ Fade in - Fades from silence to the present volume

+ Fade out - Fades from present volume to silence

+ Invert - Flips the audio samples upside down

* Noise Removal-Allows you to remove background noise

* Reverse - Allows you to play the selection backward

To increase the volume of the selected portion, on the Effect menu, select Amplify. The Amplify
window opens.

290



Playing Music and Videos

Figure 8.72. Applying Sound Effects
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10. In the Amplify window, you can use the slide bar to increase or decrease the amplification. Click OK
to apply the effect to the selected portion of the audio.

Figure 8.73. Amplifying the Audio Clip
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11. Notice that the blue waves in the selected area have changed. You can now listen to the changed audio
by clicking the Play button.

Figure 8.74. Verifying the Edit Effects

File Edit Wiew Tracks Generate Effect Analyze Help

n) ») m) W) M ® ’T% g
et v Sl Sl i - \H %
R e . ;
o e o[ 4 mlalule] o] 22808
»g.. :
I I - . I I_ : l r'I'IIT' T I 1
Stereo, 44100H. r H F|r ”1 ” Tlrl T” m r[”
16-bit PCM .
Mute | Solo
R
L..g.. R
EProject Rate (Hz): Selection Start: @ End () Length Audio Position:
SnapTo [] 00h02mO05sv 00h02m58sv 00h00OmOOSsY

|C|ick and drag to select audio |

12. After you are satisfied with all the edit effects, you can save the edited audio file. Because the default
audio format of Audacity is not readily supported by many applications you should save the file in a
more popular audio format, such as Ogg Vorbis or MP3.

To save the file in a different file format, click Export.

Figure 8.75. Exporting Audio File
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13. In the Export File dialogue box, select the folder where you want to save the file. Then, select the
desired file format from the drop-down list and then click Save to export the file in the specified
file format.

Figure 8.76. Exporting as MP3 File
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14. Audacity starts exporting the file in the specified file format. This process may take up some time
depending on the length of the audio file.
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Figure 8.77. Export Progress Indicator
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The audio file is exported to the specified location. You can now close the Audacity window and
listen to the edited audio file whenever you wish.

Playing DVDs

Most commercial DVDs are encrypted with the Content Scrambling System (CSS), which attempts to
restrict the sotware that can play a DVD. By default, Ubuntu is capable of playing DVDs that are not
encrypted. Due to legal restrictions surrounding the CSS format, as well as Ubuntu's commitment to free
multimedia formats, some software packages needed for encrypted DVD playback are not installed by
default in Ubuntu. You can install these packages from Ubuntu repositories to enable the playback of
encrypted DVDs.

Note:

It is possible that the use of some of the following software to play or copy DVDs is not permitted
by law in some countries. Please check your rights before proceeding.

You may also consider downloading the following additional applications that are capable of playing
certain formats by default:

* Mplayer movie player
* VLC media player
» Xine

¢ Totem-xine
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Totem Movie Player, the default movie player included in Ubuntu can automatically play a DVD when it
is inserted into the DVD drive. However, it will not provide access to the DVD menu. Other free software
media players like VLC, mplayer and xine do make the DVD menu available.

Playing DVDs in Totem Movie Player

After you have installed all the required software packages from various Ubuntu repositories, you can play
a DVD on your Totem movie player.

Procedure 8.9. To play a DVD on Totem:

1. Insert the DVD in the DVD drive of your computer. This will automatically launch the Totem and
the DVD will start playing.

Figure 8.78. Playing a DVD in Totem
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2. To view the DVD in full screen mode, on the View menu, click Fullscreen. Alternatively, you can
simply press F on your keyboard.
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Figure 8.79. Enabling the Full Screen View
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3. You can enjoy the DVD in full screen mode or press ESC and return to the Totem window.

Figure 8.80. Viewing DVD in Full Screen
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4. Totem also allows you to configure some settings to view the DVD according to your preferences.
To configure the preferences settings, on the Edit menu, click Preferences.
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Figure 8.81. Displaying Totem Configuration
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You can use the Preferences dialogue box to define various display settings, such as the brightness,
colour, hue and saturation of the display. After specifying your preferences, click Close to exit the
dialogue box.
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6.

Figure 8.82. Customising Display Settings
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When watching a DVD, you can use the various options provided in the Go menu to navigate inside
the DVD. To skip to the next frame, on the Go menu, click Skip Forwards.

Figure 8.83. Navigating Inside a DVD
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You are taken to the next frame in the DVD. If you do not want to view the side bar when playing
the DVD, click the Sidebar button.
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Figure 8.84. Hiding the Sidebar
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Figure 8.85. Viewing the DVD
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8.  This hides the side bar and now you can view the DVD on a larger space and simultaneously, have
all the playback controls right in front of you.

Backing up DVDs

If you have a collection of old and not-so-easy-to-find DVDs, you may wish to back up these on your
computer or create extra copies of them. You may even want to extract certain tracks from your DVD and
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watch it later. To do so, Ubuntu provides you with a number of DVD backup applications or DVD rippers.
Although these applications are not included in Ubuntu by default, you can download and install them
from the Ubuntu repositories. Some of these applications are:

+ Thoggen

* K9copy

* dvd::rip

« HandBrake

Instructor Notes:

If the students want to know more about the above applications, advise them to wisit
the following Web pages: For dvd:rip- http://www2.exitl.org/dvdrip/ For K9copy- http://
k9copy.sourceforge.net/ For HandBrake- http://handbrake.mOk.org/?chapter=documentation.
Backing up DVDs Using Thoggen. Thoggen is a DVD backup utility for Linux, based on GStreamer
and Gtk+. This application is designed to be easy-to-use. Rather than exposing the complexities of the
DVD ripping process, which many other applications tend to do, it tries to simplify the process for average
users by offering sensible default options.
Thoggen includes certain key features:
+ Is easy to use and has a nice graphical user interface (GUI)
* Supports title preview, picture cropping, and picture resizing
* Provides language Selection for audio track
* Encodes into Ogg/Theora video

+ Can encode from local directory with video DVD files

+ Is based on the GStreamer multimedia framework, which makes it fairly easy to add additional encoding
formats/codecs in future.

Note:

Thoggen is still beta software, but should work fine nevertheless. It is advisable, however, to
check the list of known issues at http://thoggen.net/download/.

To be able to back up your DVD using Thoggen, you need to first install it. You can easily find this
application in the Universe repository of Synaptic Package Manager and install it on your computer.
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Figure 8.86. Installing Thoggen
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Procedure 8.10. To start backing up your DVD using Thoggen:

1.  On the Applications menu, point to Sound & Video and then click Thoggen DVD Ripper.
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Figure 8.87. Launching Thoggen

"'Applicatiuns Places System =
‘o .
E:'b Accessories 3

(vt Games v

‘i Graphics 3

o

ey Internet 3

@ Office C

f Programming 3

ﬁ Sound & Videa » Q Audacity
|

’:D Audio CD Extractor
@. Add/Remove...

l::]' Brasero Disc Burning

gtkpod
| Movie Player
.. Rhythmbox Music Player

Sound Recorder

Thoggen DWD Ripper

Extracts Wideo from your DVDs

The Thoggen window appears. As a first step to backing up your DVD, it simply asks you to select the
specific tracks on the DVD that you want to back up. Specify the tracks by selecting the corresponding
check boxes and then click OK to proceed.
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Figure 8.88. Specifying the Tracks to Back up
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In the next step of the backing up process, you are allowed to view and configure some of the settings
according to your requirements. You can select the picture size from the corresponding drop-down list
and define the output crop, by clicking the Configure Cropping button. Otherwise, you cam simply
click OK to accept the default settings and continue with the process of backing up your DVD.
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Figure 8.89. Changing Default Settings
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4. The DVD backing process starts immediately. You can view the progress of the current as well as the
entire process in the Progress section of the Thoggen window. Thoggen takes quite long to backup
a DVD. However, the final output is of a very high quality.
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Figure 8.90. Backing up DVD
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Playing Online Media

Ubuntu provides you with tools to directly play music and videos available on the Internet. You can listen
and watch online videos and audios directly from within your browser but may require to install some
special player for this. Your ability to watch or listen to online media depends on how the provider of the
music and video has made them available.

Watching Videos in a Web Browser

You can play many of the videos available on the Internet directly from within your browser. For example,
You can watch the Google videos and the You Tube videos directly in your FireFox window without
installing any special player or additional browser plugins. The following screenshot displays a video being
played inside the Firefox window:
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Figure 8.91. Watching Video in a Web Browser
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However, depending on the format of the video that you want to watch, you may also require to download
and install certain additional browser plugins. Some of the plugins available for the default Firefox web
browser are:

+ Totem Xine plugin: Install the totem-xine-firefox-plugin package from the "Universe" repository.

+ Totem gstreamer plugin: Install the totem-gstreamer-firefox-plugin package from the "Universe"
repository.

+ Mplayer plugin: Install the mozilla-mplayer package from the Universe repository
+ Flash plugin: install the flashplugin-nonfree package from the "Multiverse" repository

The plugin installation process depends on the framework you use. If you use Totem-gstreamer, the
default movie player included in Ubuntu, you need to install the totem-gstreamer-firefox-plugin package.
However, to enable playing streaming video in your browser, you need to first install the Microsoft
Windows codec and then install the totem plugin.

You can even install an additional mediaplayer, such as RealPlayer 10, to watch online video streams in
Realmedia formats. When you have installed all the above mentioned plugins and codecs, you can watch
RealMedia files even with your default media player, such as Totem. But, you may also want to install
RealPlayer on your computer because RealPlayer supports streaming RealMedia files slightly better than
other players.

The RealPlayer, developed by RealNetworks, supports a number of audio and video codecs such as

realaudio, realvideo 10, mp3, ogg vorbis and theora, h263 and AAC. The RealPlayer for Linux is available
in the Canonical commercial repository and can also be freely downloaded from the RealPlayer web site.

Note:

RealPlayer is a proprietary software and is not supported by the Ubuntu community.
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Installing RealPlayer. As mentioned above, the realPlayer for Linux is available in the Canonical
commercial repository. Ubuntu does not include this repository by default. Therefore, you will first need
to add Canonical's commercial repository to your system. Once the repository is added, you can search for
the Realplayer package and then install it on your computer.

Procedure 8.11. Watching Online Videos Using RealPlayer

1. You can now access the realPlayer from the Applications menu. To access RealPlayer, on the
Applications menu, point to Sound & Video and then click RealPlayer 10.

Figure 8.92. Launching RealPlayer
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2. The RealPlayer Setup Assistant is displayed to guide you through the set up of the RealPlayer. Click
Forward to start the set up process.
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Figure 8.93. Initiating RealPlayer Set up
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4. Before installing the RealPlayer application on your computer, you need to review the terms of the
end user license agreement and accept it to be able to proceed with the setup. Click Accept.
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Figure 8.95. Accepting the License Agreement

License Agreement
Please review the terms of the end user license
agreement. By clicking "accept" you indicate that you
accept the terms of the license agreement
REALMETWORKS, INC.

END USER LICENSE AGREEMENT

REALMETWORKS PRODUCTS AMD SERVICES

REDISTRIBUTIOMN NOT PERMITTED

License for RealMetworks Products and Services
IMPORTAMNT -- READ CAREFULLY BEFORE USING THIS

View RealNetworks Privacy Policy...] M Accept

(@) [ e | [ e |

5. You have reached the final screen of the Realplayer setup Assistant. Specify the provided options and
click OK to complete the set up.

Figure 8.96. Completing the Set-up Process
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6. The RealPlayer window is displayed, indicating that the set up was successful. Now you can watch
online streaming media in the RealPlayer.
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Figure 8.97. The RealPlayer Window
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To start viewing the online video of your choice, launch Firefox and navigate to the Web page from
which you want to view the streaming media.

On the Web page, click the link to open the video of your choice.

Figure 8.98. Selecting the Link to the Online Video
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9. You are asked to specify whether you want to open the linked file in RealPlayer or save it to your
computer. To view the video as online streaming media, accept the default selection and click OK.
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Figure 8.99. Viewing Video as Streaming Media
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10. The Downloads dialogue box displays the progress of the download. After the file is downloaded to
your temporary Internet folder, the video starts playing in the RealPlayer window.

Figure 8.100. Watching Online Video in RealPlayer
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11. You can add the link to your Favorites list to be able to view the video again without searching for it
on the Internet. To save the video as a Favorite, on the the Favorites menu, click Add to Favorite.
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Figure 8.101. Saving a Video as Favourite

File Play View Tools Favorites Help

=r Add to Favorites

A Manage Favorites...

Export Favorites..,

Import Favorites. ..

1. Video-04 (I think I'l mowve)

CLAUDIA CHRISITIAN

as Commandear Susan Ivanowva

Playing (520 kbps) 0:06  0:57

12. The video is now saved as your favorite. In future, you can view this video directly from inside your
RealPlayer by selecting the link from the Favorites menu. You can also play an online video directly
from inside the RealPlayer by specifying the location of the video. To do so, on the File menu, click
Open Location.

Figure 8.102. Viewing Online Video Directly from RealPlayer
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13. Type the URL or the file path of the video in the Open Location dialogue box and click OK to start
playing the online streaming video.
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Figure 8.103. Specifying Video Location
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Editing Videos

In addition to viewing movies and videos, Ubuntu also provides you tools to help you edit a video. The
tools available with Ubuntu include:

Kino: An advanced video editor, Kino captures video to disk in Raw DV and AVI format. It allows you
to load multiple video clips, cut and paste portions of video, and save it to an edit decision list in SMIL
and XML formats.

Stopmotion: Stopmotion is a free application for creating stop-motion animation movies. It enables you
to create stop-motions from pictures imported from a camera or from the harddrive, add sound effects and
export the animation to different video formats such as mpeg or avi.

Subtitle Editor: Subtitle Editor is a GTK+2 tool to edit subtitles for movies and videos. you can use it
for creating new subtitles or to transform, edit, correct and refine existing subtitles. This programme also
shows sound waves, which makes it easier to synchronise subtitles to voices.

Pitivi Video Editor: Pitivi Video Editor is a non-linear editor, which allows you to easily edit audio and
video projects. Using Pitivi, you can capture audio and video, mix, resize, cut, and apply effects to audio and
video sources. It also allows you to save the projects in any format supported by the GStreamer framework.

Editing Videos Using Pitivi Video Editor

Pitivi Video Editor is not included in Ubuntu by default. It is available in the Universe repository of Ubuntu.
You can install Pitivi using Synaptic Package Manager.
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Procedure 8.12. To edit video using Pitivi Video Editor:

3.

On the Applications menu, point to Sound & Video and then click Pitivi Video Editor. The Pitivi
vo 11.1 window opens.

The main Pitivi interface is divided into a number of panes. You can use the various buttons on the

task bar to perform tasks such as opening, importing, adding, viewing and saving video clips. To edit
a video clip, first import the clip in the Pitivi Video editor by clicking the Import Clips button.

Figure 8.104. The Pitivi Interface
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In the Import a clip dialogue box, navigate to the folder from where you want to import the video
clip, select the single or multiple clips to be edited and click Add to import it in the Pitivi window.
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Figure 8.105. Importing Video Clips in Pitivi
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The selected video clip is now imported into the Pitivi Video editor. You can double-click the video
clip to view it in the right pane. Click the Stop button on the control bar to stop the playback.
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Figure 8.106. Viewing the Imported Video
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Add clips to the timeline
by dragging them here.

To edit the imported video clip, you need to drag them to the bottom pane to add them to the time
line and then select the Project Settings option from the File menu. This opens the Projects Settings
dialogue box.
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Figure 8.107. Displaying the Project Settings Dialogue Box
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In the Projects Settings dialogue box, you can edit the various aspects of the selected movie clip
by defining various specifications according to your preferences. You can use the Video Output
section to define the height, width and the frame rate of the video. Similarly, you can define the audio
specifications under the Audio Output section. Click OK after specifying your preferences.
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Figure 8.108. Specifying Edit Preferences
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You return to the Pitivi window. To start applying your specifications on the selected video clip, click
the Render project button. This displays the Render project dialogue box. You can use the Modify
button on the Render project dialogue box to further modify your specifications for the video clip.
Otherwise, click the Choose file button to specify a file name for the edited video clip.
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Figure 8.109. Specifying the Output File
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This opens the Choose file to render to dialogue box. Use this dialogue box to assign a name for
the edited video clip and specify the location where you want it to be saved. After specifying these

details, click OK to continue.
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Figure 8.110. Selecting the File to Render to
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The name of the file now appears on the Output file button. Start editing the video clip by clicking
the Record button.

Figure 8.111. Editing the Video File
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10. The Pitivi Video Editor has started rendering a new project based on your specifications. You can
view the progress of the process in the progress bar. Once the rendering is complete, click the Close
button on the top-right corner to exit the Render project dialogue box.

Figure 8.112. Project Rendering Progress Indicator

Output file: baseball

Settings
Video : 320 x 240 pixels at 320.00 fps (smokeenc)
Audio : 2 channels at 44100 Hz (16 bits) (vorbisenc)

e T e g ——— |

| ogancel | | Becord |

11. The newly edited video clip is now saved at the specified location.

Figure 8.113. The Edited Video Clip

File Edit View Go Bookmarks Help

. .® < -

Back Forward Up to Reload
Places (%] 75

53 williamwindsor <] ﬁl

& Desktop baseball

L File System

L8 WD Passport
I HP
\—! FACTORY_IMAGE
2 Network Servers

@ Trash

[E2 Docurments

[E5 Music

[F3 Dirtiiras |

"haseball" selected (73 .6 KB)

Lesson Summary

In this lesson, you learned that:
+ Software usage and distribution is controlled by laws and legislations unique to each country.

* When using or redistributing proprietary media formats, you should be aware of the associated patent
or copyright laws.
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* You can use Rhythmbox to play and organise music, listen to Internet radio and import music from CDs.

» Using Sound Juicer, you can play audio tracks direct from the CD, extract audio tracks and convert
them into audio files in various file formats. In addition, the default audio CD/DVD burner for Ubuntu,
Brasero, can be used to create audio and data CD/DVDs.

» Playback of proprietary multimedia formats can be enabled in Ubuntu by installing additional
multimedia codecs from the repositories.

+ Ubuntu offers you tools to play music from your iPod through gtkpod.

* Sound Recorder can be used to create audio files in various formats.

+ Audacity enables you to record and edit audio files.

» DVD playback in Totem Movie Player can be enabled by installing the required software packages.
» Thoggen is a DVD backup utility for Linux that can be used in Ubuntu to copy DVDs.

+ Ubuntu provides you with tools to listen and watch online videos and audios directly from within your
browser or in a mediaplayer such as RealPlayer.

« Pitivi video Editor can be used to play and edit videos.

Review EXxercise

Question: List the main features of a free software license.
Answer: A free software license include the following features:
+ Enables anyone to distribute or sell the software

* Makes the source code of the software available

+ Allows users to make modifications and to produce derived works
* Does not restrict the use of other software

Question: Which is the default music player in Ubuntu?

» Totem

* Rhythmbox

* Audacity

+ gtkpod

Answer: b) Rhythmbox

Question: What are podcasts?

Answer: Podcasts are audio shows, broadcasted over the Internet, that you can subscribe to. Subscribing
to a podcast enables you to download each new audio release from the subscribed podcast source.

Question: Which application is available in Ubuntu by default to play and extract audio compact discs?

¢ Xine
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* RealPlayer

* Brasero

* Sound Juicer

Answer: Sound Juicer

Question: In which formats does Sound Juicer enable you to extract audio files onto your computer?
Answer: Sound Juicer enables you to extract audio files into the following three formats:

» Ogg Vorbis

* FLAC

« WAV

Question: From where does Sound Juicer retrieves retrieve the CD artist, title, and track data?
Answer: Sound Juicer will retrieve the CD artist, title, and track data from MusicBrainz.org.
Question: Name the default CD audio recording application available in Ubuntu?

Answer: Brasero is the audio CD burner application that comes bundled with Ubuntu, by default.
Question: Why do you need to install additional multimedia codecs in Ubuntu?

Answer: Due to the legal restrictions associated with the use of proprietary formats, by default, Ubuntu
does not offer support for such formats. You need to install additional multimedia codecs to enabling such
proprietary media formats in Ubuntu.

Question: You can download and install multimedia codecs using the

Answer: Synaptic Package Manager or Command Line Interface

Lab Exercise

Exercise 1: Playing Music Using Rhythmbox. You have recently installed Ubuntu and want to play
and organise your music files, listen to music podcasts and Internet radio. List the steps that you would take.

1. On the Application menu, point to Sound & Video and then click Rhythmbox Music Player.
2. To start importing individual music files into Rhythmbox, right-click Library and click Import File.

3. In the Import File into Library dialogue box, navigate to the folder from which you want to import
the files.

4. Select the files that you want to import and click Open.
5. Select the music tracks that you want to play and the Play button to start playing the selected track.

6. To play music from a podcast of your choice, right-click the Podcast option in the Source list and select
New Podcast Feed.

7. Enter the podcast feed URL in the New Podcast Feed text box and click Add.

8. To play a podcast episode, select the episode that you want to play and click the Play button.
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9. To listen to Internet radio, click the Radio source in the Source pane.
10.Double-click on the radio station of your choice to listen to the streaming media.

11.To add a new radio station to the existing list of stations, click New Internet Radio Station and paste
the URL of the new radio station in the URL of Internet radio station text box.

12.Click Add to add the radio station in the existing list.

13.You can add many more Internet radio stations in the same way and listen to your favourite radio stations
with just a click of your mouse.

Exercise 2: Playing and Extracting Audio CDs. You have built up an impressive CD collection over
the years and you would like to play these on your Ubuntu desktop, retrieve details about the music tracks
and extract your favourite music tracks onto your computer in a compatible format to be able to play them
later. List the steps that you would need to perform to do all that you want.

Procedure 8.13. To play audio CDs:

1. Insert an audio CD in the CD drive of your computer. The Sound Juicer CD player and ripper is
launched automatically.

2. Notice that Sound Juicer has fetched the tracks' information from MusicBrainz.org.

3. To play the tracks of your choice, select the particular tracks by selecting the corresponding
checkboxes.

4. Click the Play button to play the tracks.

Procedure 8.14. To extract an audio CD:

1. Insert the audio CD into your computer's CD drive.

2. On the Edit menu, click Preferences.

3. In the Preferences dialogue box, click the Output Format drop-down list.

4.  Select the format of your choice from the Output Format drop-down list.

5. Select the directory where you want to extract the files from the Music Folder drop-down list.
6. Click Close to exit the Preferences dialogue box.

7. Inthe Sound Juicer window, select the tracks that you want to extract by selecting the corresponding
check boxes.

8.  Click the Extract button to start extracting the files.

9. Sound Juicer notifies you after the selected tracks are extracted successfully. Click Open to view the
tracks copied on your hard disk.

10. The CD audio tracks are now copied as audio files on your hard disk. You can listen to these tracks
by simply double-clicking them.

Exercise 3: Burning Audio CDs. You have recently discovered a Web site from where you can freely
download hundreds of songs. You do not want these files to occupy the precious space on your computer's
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hard drive. Therefore, you want to copy these files on audio CDs, so that you can listen to them in future
without taking up space on the hard drive.

Procedure 8.15. To burn an audio CD:

1.

7.

8.

Insert a blank (recordable) CD in the CD drive of your computer.

Click the click the Make Audio CD button. This launches the Brasero Disc Burning application.
Click the New Audio Project button.

Navigate to the desired folder with the files you wish to add to display its contents.

Select the specific audio files that you want to be copied and click the Add button or simply drag
each file name to the Files area in the right side of the project window.

Once you are sure of the files to be copied to the disk, click the Burn button to start writing the audio
files from your computer to the CD.

The Disc Burning Setup dialogue box displays. Click Burn to continue.

Brasero now starts writing the music files to the media disc.

Exercise 4: Playing Proprietary Multimedia formats. You have a huge collection of music in MP3
format stored on your computer and want to play these music files on your Ubuntu desktop. List the steps
that you will need to take to be able install the required multimedia codecs.

Procedure 8.16. To Install a codec plugin using Synaptic Package Manager:

1.

10.

On the System menu, point to Administration and then click Synaptic Package Manager. The
Synaptic Package Manager window opens.

The Multiverse and Restricted repositories are not activated by default in Ubuntu. To activate these
repositories, on the Settings menu, click Repositories. The Software Sources dialogue box is
displayed.

To enable the Multiverse and Restricted repositories, select the third and fourth check boxes available
on the Ubuntu Software tabbed page, and click Clese to exit the dialogue box.

You may receive a notification that your repository information has changed. Click Close to exit this
message.

Once you return to the Synaptic Package Manager window, you are required to click the Reload
button to apply your changes.

On clicking the Reload button, the system starts checking the repositories for new, removed or
upgraded software packages.

To install a software package, you need to first locate the package in the Synaptic Package Manager
window.

To initiate a search for a specific package, click Search.

In the Search field, enter the name of the software package that you are looking for. Click Search
to begin the search.

Right-click the package to be installed and select Mark for Installation.
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11.

12.

13.

14.

Once all the required packages are marked, click Apply to start downloading the packages. The
Summary dialogue box is displayed.

To go ahead with the marked installations, click Apply on the Summary dialogue box.

After all the mark software packages are downloaded and installed, the Changes Applied dialogue
box is displayed. Click Clese to exit the Changes Applied dialogue box.

The check box corresponding to the recently installed software package has changed to green,
indicating that the software has been installed successfully.

Exercise 5: Playing DVDs. One of your friends has recently given you a DVD gift box set of your
favourite movies of all times. Now, you want to play this DVD in your Ubuntu desktop and enjoy your
favourite movies.

Procedure 8.17. To play the DVD in the Movie player:

1.

10.

Install the following software packages from the Universe and Multiverse repositories using the
Synaptic Package Manager.

+ gxine

* libdvdcss2

* libdvdnav4

+ libdvdplay0

+ libdvdvread3

Install the Ubuntu Restricted Extras software package from the Ubuntu repository.

Insert the DVD into the DVD drive of your computer. This will automatically launch the Totem and
the DVD will start playing.

To view the DVD in full screen mode, on the View menu, click Fullscreen. Alternatively, you can
simply press F on your keyboard.

You can enjoy the DVD in full screen mode. At any point of time, while watching the DVD in
fullscreen mode, you can press ESC and return to the Totem window.

To configure the preferences settings, on the Edit menu, click Preferences.

After specifying your preferences, click Close to exit the dialogue box.

To skip to the next frame, on the Go menu, click Skip Forwards.

You do not want to view the side bar when playing the DVD, click the Sidebar button.

This hides the side bar and now you can view the DVD on a bigger space and simultaneously, have
all the playback controls right in front of you.
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Objectives
In this lesson, you will learn:

» How to seek help for Ubuntu from various sources such as system documentation, online documentation,
commercial support, community support, Launchpad and The Fridge.

Instructor Notes:
This lesson includes an optional hour. In addition to covering the lesson content, you can devote

this hour to elaborate on topics already covered in the previous lessons or select something from
the optional material, such as partitioning and booting or sections from the music and video lesson.

Introduction

Help and support for Ubuntu is readily available through a number of sources so you need not panic if you
run into a problem. Essentially there are two channels for accessing support:

 The first level is: Free, community based and involves system and online documentation, mailing lists,
forums, IRC channels and Launchpad.

* The second level is: Paid for, commercial services through Canonical itself and / or various partners.
Figure 9.1. Accessing System Documentation
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System Documentation

The first resource that you should explore is the offline system documentation. The Ubuntu Documentation
Team [https://wiki.ubuntu.com/DocumentationTeam] maintains and updates the documentation for each
release. This documentation is very reliable and available in different languages.

Ubuntu System documentation is organised into topic based help, including answers to common questions.
It is accessed by clicking the Help and Support button located under the System Menu. The following
screenshot shows the home page of the Help and Support offline system documentation.

Figure 9.2. System Documentation
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New to Ubuntu? This section introduces you to the wonderful world of Ubuntu including an easy to use
guide if you are migrating from Microsoft Windows to Ubuntu. Also in this section, the help guide will
explain how to use your desktop, the role of the administrator and basic computer skills. A great resource
for any newcomers and a top-up to this desktop course.

Some applications do also offer access to the help system through the Help menu or keyboard shortcut F1.

One of the great features of the system documentation is the ability to search the documentation to help
solve the problem you have. Simply type in the term you are looking for and the system will search all
the documents and guides with related information.

Online Documentation

Instructor Notes:

Guide the students through each one of the options on the Web.

The online Ubuntu documentation is available at https://help.ubuntu.com [https://help.ubuntu.com]. There
are two different types of documentation available on this site, official and community.
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The official documentation is the documentation that is included with your Ubuntu installation by default
and is locally accessible from your Ubuntu desktop. You can also access this documentation on the Internet
at the Web site mentioned above.

The following screenshot shows the home page of the Ubuntu documentation site:

Figure 9.3. Online Documentation
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# Ubuntu 8.04 LTS - the current long term support version, released in April 2008, codenamed Hardy Heron.
= Ubuntu 7.10 - previous stable version, released in October 2007, codenamed Gutsy Gibben.

» Ubuntu 6.06 LTS - previous long term support version. released in June 2006. codenamed Dapper Drake.

The material in this document is available under a free license, see Legal for details
For information on contributing or to report a problem, visit the Ubuntu Documentation Project
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Done @

The documentation is classified according to the various Ubuntu releases, such as Ubuntu 8.04 LTS, 7.10
and 6.06 LTS.

To access the official documentation locally from your Ubuntu desktop, without connecting to the Internet,
on the System menu, click Help and Support. You can also use the Help icon on the top panel of the
desktop.

The information available in the official documentation will be enough to guide you through most topics
and problems. However, if you are unable to find an answer to your queries here, you can look for answers
in the second type of documentation available on this site. This is documentation created by the community,
without following the stringent quality control process of the Ubuntu Documentation Team. Access this
documentation via the tab labelled Community Docs. The community documentation is stored on a Wiki,
which allows the documentation to be changed quickly. While the community documentation covers more
topics and some subjects in greater depth than the official documentation, the lack of quality assurance
control and especially maintenance makes it a slightly less reliably alternative.

The community documentation is a large collection of community-contributed documents, primarily
covering the following topics:

+ Migrating from other operating systems, such as Microsoft Windows and Red Hat
* Post-installation configuration for a variety of tasks such as

* Maintaining your computer

+ Connecting and configuring hardware

The following screenshot displays the information available in the community documentation:
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Figure 9.4. Community Documentation
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The community documentation is also classified under various categories. You can select the desired
category from the page index at the right of the page. You can also use the Search field in the top-right
corner of the page to look for specific information within the community documentation. Be aware that
Titles will restrict the search of your term to the pages titles only. If a search via titles does not produce
any results, a full Text search may find the right page.

You can also find relevant information on the CommonQuestions page. Access the CommonQuestions
page by clicking the Common Questions link on the community documentation page.

The following screenshot displays the CommonQuestions page on the Ubuntu Web site:

Figure 9.5. The CommonQuestions Page
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Below is a selection of common questions with answers that may help you if you are new to Ubuntu. Choose a topic
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2. Related Projects: Kubuntu, Edubuntu and

Xubuntu

3. Ubuntu and Debian?
2. Installing Ubuntu

1. CDs and DVDs

2. Network and Other Installation Methods
3. Using Ubuntu
. Installing software
Reposttories and sources. list
Upgrading
Administration: Root vs Sudo
MP3/Divx/DVDs/Quicktime/Realmedia
[Elashilaya L~
Done help.ubuntu.com &
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Additional help is available to you in the form of Ubuntu screencasts. You can click the Ubuntu
Screencasts link on the Community Documentation page to access a number of videos on using and
installing Ubuntu. Each video is created with the aim of educating new users of Ubuntu. Each video is
available in three sizes, large, medium and small, and two formats, OGG and Flash.

The following is an example of a screenshot from a video on installing applications:

Figure 9.6. The Screencasts Page

Fle Edit View History Bookmarks Tools Help
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8 Canomscal supporied Ofud Source saftware (main)
8 Communty manianed Gpen Source softwane (unmversa)
@ Sropratary dmers for dewcas (rstnciad)
@ Software resincted by copynght or lagal ssues (mukamrse)

Download from: | Saver for United Kingdem

Installabie fram CD-ROM/DVD

COAOM with Usunty 7.04 *Feisty Faws®
Ofhcaally

| Transferring data from static.screencasts ubuntu.com. .. |

Note:

These screen casts are licensed under the Creative Commons Attributions-Share Alike 3.0
License. You are free to modify, share, sell or distribute these screencasts as long as the attribution
to Ubuntu is intact.

Community Support

The vast and ever growing Ubuntu community also offers a range of free support options for your Ubuntu
desktop. Apart from the community documentation, the Ubuntu community provides support through:

* Mailing lists

* Web Forums

IRC Channels
¢ LoCo Teams

¢ The Ubuntu Team Wiki
Mailing Lists

To get help on a specific problem, all you need to do is to send your query through e-mail to the relevant
mailing list and you will get a quick response from the team.

331



Ubuntu Help and Support

You will need to subscribe to the mailing list first by visiting the Ubuntu Mailing Lists Web site at https://
lists.ubuntu.com/. The Mailing Lists page displays all the public mailing lists to which you can subscribe
and their topic.

The following screenshot displays the Mailing Lists page:

Figure 9.7. The Mailing Lists Page

fle Edit View History Bookmarks Tools Help
& - & @ [F2] nttpsfists.ubuntu.comy [~] @~ @)

Most Visited > fGetting Started [E)]Latest Headlines ~
_; b
.1 N
(s ubuntu -
®

Mailing Lists

Below is a listing of all the public mailing lists on lists.ubuntu.com. Click on a list name to get more information
about the list, or to subscribe, unsubscribe, and change the preferences on your subscription.

List administrators, you can visit the list admin overview pade to find the management interface for your list

If you need help with your Ubuntu system, please try one of the Community Support Lists below. If you are
having trouble using the lists themselves, please contact mailman@lists.ubuntu.com.

Categories

. Ubuntu Announcements
. Community Support
. Announcement Lists
Development Lists
Quality Assurance and Related Lists
Bug Lists
Package Upload and Automatic Notification Lists
. Ubuntu Worldwide L oCo Teams
. Localization Lists
. Other Ubuntu Projects and Groups

CO®~OU L WM

-

Done lists ubuntu.com &

To get help for your Ubuntu desktop, you should go to the Community Support and select the ubuntu-
users mailing list. This will take you to a page like the following:

Figure 9.8. Subscribing to Ubuntu-users Mailing List

File Edit Wiew History Bookmarks Tools Help

] - c = @ httpslists,ubuntu cormjmailmanylistinfofubuntu-users | '] [‘ @

[ Most Visited = b Getting Started Latest Headlines ~

ubuntu-users -- Ubuntu user technical support, not for general discussions

About ubuntu-users English (USA)

To see the collection of prior postings to the list, visit the ubuntu-users Archives.

Using ubuntu-users

To post a message to all the list members, send email to ubuntu-users@lists.ubuntu.com.
You can subscribe to the list, or change your existing subscription, in the sections below.
Subscribing to ubuntu-users

Subscribe to ubuntu-users by filling out the following form.

You will be sent email requesting confirmation, to prevent others from gratuitously subscribing you.
This is a hidden list, which means that the list of members is available only to the list administrator.

Your email address: [ J

Your name (optional): [ l

You may enter a privacy password below. This provides only mild security, but should
prevent others from messing with your subscription. Do not use a valuable password as
it will occasionally be emailed back to you in cleartext.

If you choose not to enter a password, one will be automatically generated for you, and it [~]

Done

lists ubuntu.com &

You need to provide your e-mail address, your name and a password in the appropriate boxes and then
click the Subscribe button.
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When you subscribe to a mailing list, a confirmation mail is sent to your provided e-mail to verify that
it is your address. To activate this mailing list, you need to first open your e-mail account and then click
the link provided in the confirmation e-mail.

Figure 9.9. Confirmation Mail
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ubuntu-users@lists.ubuntu.com mailing list. To confirm that you want
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Search, add, or invit keeping the Subject: header intact. Or visit this web page:
R https:lists.ubuntu.comimailman/confirm/ubuntu-users/2944b104f0163c26e778104c5a0efc
Set status heri v bl18ef13b52
falk
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Add
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most mail readers, since that usually leaves the Subject: line in the =
lvlahnl rictht faren (additinnal "Ra v tast in tha Siihiact: iz al \[ I lL
4 »

Clicking this link takes you to the Confirm subscription request page, where you can verify the details
of your subscription request and subscribe to the selected mailing list by clicking the Subscribe to list
ubuntu-users button.

Figure 9.10. Confirm Subscription Request Page

2 CONTiTIEUbE CripHON rEqUEEL =M D2)IS I rerox. = l

File Edit Wiew History Boockmarks Tools Help
- - @: /J} ‘-3 https:jflists uburtu.com/mailman/confirm/ubunty = v DI |C|" .--\]

(% @ Getting Started [l Latest BEC Headlines

El

1 Gmail - confirm 944b104f01... | 3 confirm subscription re... & |

Confirm subscription request
Your confirmation is required in order to complete the subscription request to the mailing
list ubuntu-users. Your subscription settings are shown below; make any necessary
changes and hit Subscribe to complete the confirmation process. Once you've confirmed
your subscription request, you will be shown your account options page which you can
use to further customize your membership options.

Note: your password will be emailed to you once your subscription is confirmed. You can
change it by visiting your personal options page.

Or hit Cancel my subscription request if you no longer want to subscribe to this list.

Your emall address: wwindsorll@gmail.com
Your real name:| Wwindsor

Receive digests? ¢ No ¢ Yes

Preferred language: | English (USA) ~|

L . pa— O B L . . 1 L=
Done | lists.ubuntu com &

Finally, you will receive a confirmation message saying that your subscription request to the selected
mailing list has been confirmed.
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Figure 9.11. Confirmation of Subscription Request Page

2 dubadrlpilin g uaat suniligel = ol Blegiv.e ==
Fle Edit View History Bookmarks TIools Help
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[~ Gmail - confirm 944b104fol... <} Subscription request co... [ -
Subscription request confirmed

You have successfully confirmed your subscription request for

"wwindsorl l@gmail.com" to the ubuntu-users mailing list. A separate confirmation
message will be sent to your email address, along with your password, and other useful
information and links.

You can now proceed to your membership login page.

ubuntu-users list run by mako at ubuntu.com, brian.murray at ubuntu.com
ubuntu-users administrative interface (requires authorization)
Overview of all lists.ubuntu.com mailing lists

!Delly‘ered by Mailman Bython Powered Gnu's Not Unix
version 2.1.8

Done lists.ubuntu com &

Soon after, you will receive a welcome mail containing the mailing address of your selected mailing list
and you will then be able to send e-mail messages to this list. Before sending your first query, it is good
practice to read a bit of the archive, as the topic may have already been covered. The archive will also give
you an idea of how much volume to expect from a list and get a "feel" of others who are active on the list.

It is possible that you will be flooded with many responses to your posting. The level of emails received

can be controlled by adjusting your preferences on the UserCP (User Control Panel). You can use this
panel to customize your profile and preferences too.

Instructor Notes:

To use the mailing lists, some guidelines are given in the Mailing List Etiquette page. To read
these guidelines, go to http://www.ubuntu.com/support/community/mailinglists/etiquette.

The mailing lists archive is an excellent resource of information, as quite a few questions have been
discussed on the lists already. The archive can be seen as a memory for the mailing lists expertise.

Web Forums

Web forums are often an easier and more immediate alternative to mailing lists as you can receive help on
various issues without subscribing to a high-traffic mailing list. They are easier to use, available in a Web
browser and are an ideal way for you to meet other Ubuntu users and developers.

The following screenshot displays the home page of the Ubuntu forums Web site:
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Figure 9.12. Web Forums

View Higtory Bookmarks Tools Help
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forums
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User Name User Name ) Remember Me?
[-) Ubuntu Forums -
Password Log in

Register Reset Password Forum Help > Forum Council -7 Today's Posts Search

Welcome to the Ubuntu Ferums, we encourage you to REGISTER on our forums and participate in the community. Ubuntu is a
complete Linux-based operating system, freely available with both community and professional suppert. By JOINING US today you
can participate in our active and growing community. Registering on our forum gets you access to post new messages, get suppert,
use private messages, download images from our gallery and much much more!

The Ubuntu Forum Community 8

Absolute Beginner Talk a2
(45821 Threads ) { 321,249 Reples )
The perfect starting place to find out more about computers, Linux and Ubuntu.

dualbooting XP/ubuntu on 2...- by amheuwr 1 Minute Ago

Main Support Categories =
(148,717 Threads ) ( 706,396 Replies )
Choose the most appropriate category for your questions regarding ANY UbuntwKubuntw: u release.

() Image my hard drive to a...- by EEhbulk 1 Winute Ago -
Dene

Note:

To access the Ubuntu forums, go to: http://ubuntuforums.org/ or http://www.ubuntu.com/
community/forums.

The Ubuntu forums are entirely maintained and moderated by volunteers and are available in many
languages such as Chinese, Dutch, German, Finnish and French.

The following screenshot displays a view of the Ubuntu French forum:

Figure 9.13. Ubuntu French Forum
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Done
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You need to register on the forum to be able to post messages and get support. To do this, click the Register
link displayed on the home page which will lead to the following page:

Figure 9.14. Ubuntu Forum Rules Page
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Fle Edit View History Bookmarks Iools Help
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[ Most visited ~ g Getting Started [5]Latest Headlines =

-7 ubuntu

Search

Ubuntu Forums Rules

[~ Forum Ruls

In order to proceed, you must agree with the following rules

Forum Rules

Registration to this forum is free! We do insist that you abide by the rules and policies detailed
below. I you agree to the terms, please check the ' agree' checkbox and press the 'Register' button
below. If you would like to cancel the registration, click here to return to the forums index.

Forum Rules

Registration to this forum is freel We do insist that you abide by the rules and policies detailed
below. If you agree to the terms, please check the ‘T agree' checkbox and press the 'Register’ button
[11 have read, and agree to abide by the Ubuntu Forums rules.

Register

Done

Follow all the instructions on this and the following pages to sign on to the Ubuntu forum. You will then
receive a confirmation that your registration is complete.

You can now sign in with your new user name and password and start using the Web forum for posting
new messages and searching the existing ones. The postings on the Web forum are segregated into several
categories based on their subject. To get an answer for a specific question, you may first look into the
related category. Each category contains threads to all the postings already made under that category.

An alternate method to search the desired information is by using the Search option on the right of the
home page. You can type your question in the Search Forums field and run a search. It is more than likely
that you will find your desired information in these postings.

However, if you do not find the required information in the questions that have already been asked, you
can create a new posting on the Web forum. You are likely to receive an answer very quickly, otherwise
the Unanswered Posts Team will pick up your post within 24 hours.

IRC Channels

The IRC channels are a form of real-time Internet chat that enable users to talk directly (and immediately)
with one another.

IRC channels are available on the freenode network, irc.freenode.net. The best channel for you to interact
with other Ubuntu users is #ubuntu. Other specialised channels related to Ubuntu variants, such as
#kubuntu, #edubuntu and #xubuntu are also available. In addition, channels related to bugs, development,
LoCo teams, accessibility and documentation are also available.

Note:

To see a list of IRC channels and clients, go to https://help.ubuntu.com/community/
InternetRelayChat.
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There are many ways to connect to an IRC channel and one of them is by using the Pidgin instant messenger.
Connecting to Pidgin was covered in Lesson 3.

Procedure 9.1. Once in Pidgin, you can access various IRC channels by:

1. Open the Buddies menu to view the available options, and click Add Chat. This displays the Add
Chat dialogue box.

Figure 9.15. Buddies Menu

Buddies Accounts Tools Help

[ New Instant Message... Ctrl+M
Join a Chat... ctrl+C

@ Get User Info... ctrl 11
View User Log Ctrl+L
Show 4
Sort Buddies »

¢ Add Buddy. ctrl+8

< Add Chat.

4 Add Group...

&1 Quit ctr+0Q

@ Avalable -

2. To interact with ubuntu users, type #Ubuntu in the Screen name field. Then click Add. This adds
the Ubuntu users' account to your Buddies List.

Figure 9.16. Add Chat Dialogue Box

. Please enter an alias, and the appropriate information about
) the chat you would like to add to your buddy list.

[Twwmdsor@\rc.ubuntu‘com {wwindsor) (IRC)

Account:

Channel:

Alias:

[
[
Password; [
[
[

d

]

]

J
=]

3. Notice that #ubuntu is added as an IRC account to your Buddy List. Double-click the account name
to enter the IRC channel for Ubuntu users.
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Figure 9.17. Buddy List

Buddies Accounts Tools Help
~ Buddies

@ #ubuntu

4. You have now entered the IRC channel for Ubuntu users. You can use the box at the bottom of the
window to type your messages, and press Enter to send them.

Figure 9.18. IRC Channel for Ubuntu Users
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not tried killing the processes yet. 7
(10:05:27 IST) joanki: ok almost done here e
I 4242
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(10:05:30 IST) joanki: use as is what for home o
(10:05:20 IST) Ubuntul01: errm cops aczid
(10:05:32 ST) IntuitiveMipple: piecesandbits: use LUKS adam_
and cryptsetup Ada
(10:05:34 IST) joanki: i know meint peint fer home is /
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(10:05:35 I1ST) slocate left the room. adaptr
(10:05:36 1ST) Ubuntul0ol: anyone have a clue on that addo
one? e
(10:05:36 ST} joanki: but what about use as i =
adlis... =)

@lFont | 2 Insert

LoCo Teams

The Ubuntu LoCo (short for 'Local Community') teams are a vital resource for providing localised support.
With the incredible success of Ubuntu around the world, the Loco project helps groups of Ubuntu fans
and enthusiasts work together in their regional teams to help advocate, promote, translate, develop and
otherwise improve Ubuntu.You can access them through: http://www.ubuntu.com/support/community/
locallanguage.

The following screenshot displays the list of languages in which you can receive help and support on
Ubuntu:
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Figure 9.19. The LoCo Teams Page
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Done

To receive help and support on Ubuntu in your local language, select the desired language from the Non-
English Support list.

Figure 9.20. Non-English Support Page
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Non-English Support

Support channels on IRC and mailing lists exist for Ubuntu users whose first language is not English. You are
welcome 1o join one of these or start your own.

An important part of the Ubuntu manifesto is your ability to use your software in your local language. Part of —
that is ensuring that Ubuntu includes the best translations available for the Ubuntu desktop software (and you
can help ta improve those translations).

Another part of that commitment is helping to create mailing lists and IRC channels for Ubuntu users in
different languages.

If you want to start a local team or to join an existing one, visit https://wiki. ubuntu.com/LoCoT eams
Bengali (Bangladesh)

* Website: hitp://www. ubuntu-bd.org/

s Forum: htip://forum. ubuntu-bd.org/

* IRC: #ubuntu-bd on irc.freenode. net

* Mailing list: https:/lists. ubuntu. /mailman/listinfo/ubuntu-bd

Brazilian
» Website: http://www. ubuntubrasil.org
» Forums: http://forum. ubuntubrasil.org
* Wiki documentation: http://wiki. ubuntubrasil.org

® IRC: #ubuntu-br on chat freencde.net

~ Mnilinn lints bt fliste hstis asemd

Done

Note:

If you want to start a LoCo team or join an existing one, go to: https://wiki.ubuntu.com/
LoCoTeams. To view the list of LoCo teams, visit https://wiki.ubuntu.com/LoCoTeamList.
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The Ubuntu Team Wiki

The Ubuntu Team Wiki is a central Web site that provides access to useful information on Ubuntu and the
supporting Ubuntu project. The pages are continually updated by the Ubuntu community members. The
Ubuntu Team Wiki can be accessed at https://wiki.ubuntu.com/.

The following is a screenshot of the Ubuntu Team Wiki home page:

Figure 9.21. The Ubuntu Team Wiki
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Welcome to the Ubuntu Community Team Wiki!

This is THE definitive place for members of the Ubuntu community to discuss ideas and store team-related
information.

Released (Current + Stable)
Hardy Heron B8.04 LTS April 24, 2008 Supported until April 2013 (Serwver) or April 2011 (Desktop) =

Done wiki.ubuntu.com &

As an Ubuntu user, you can also contribute to the wiki content and edit any of the pages on this site.
However, you must observe the Ubuntu code of conduct while editing any content.

Although the official Ubuntu wiki is available only in English, many wikis exist through the LoCo Web
sites. For instance, the French wiki URL is http://wiki.ubuntu-fr.org. You can find other LoCo teams in
https://wiki.ubuntu.com/LoCoTeamList.

Note:

For more information on editing the Ubuntu wiki, visit https://wiki.ubuntu.com/HelpOnEditing.

Launchpad

Launchpad is a collaborative Web-based suite that helps people develop directly or contribute to the
development of free and open source software. It is a collaborative system developed by Canonical, with
Ubuntu as the most popular project hosted on it. You can use Shipit with your Launchpad ID and order
Ubuntu CDs, report a bug, assist in translation of Ubuntu and more. This course covers the Launchpad
Technical Answers section, Launchpad Bug Tracking and Shipit (ordering Ubuntu CDs).

You can visit Launchpad at https://launchpad.net. The following screenshot displays the home page of the
Launchpad site:
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Figure 9.22. The Launchpad Page
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Information stored on Launchpad can be retrieved anonymously. To submit information on Launchpad, you
need to first create an account on Launchpad. You can create a Launchpad account by clicking the Register
link at the top-right corner of the home page and filling the required details under the Not registered
yet? section. Click Register to complete the registration process. You may also use an OpenID login
to access Launchpad. For more information on on OpenID see the project website at: http://openid.net

[https://openid.net].

Figure 9.23. Registration Page

Ele Edit wiew History Bookmarks TIocls Help

& - & @[] https:plaunchpad net/+ogin [-] @~

[ Most Visited ~ v Getting Started [5]Latest Headlines~

i launch;

Already registered?

To log in, enter your e-mail address and Launchpad password

E-mail address: | ]

Password:
[Forgotten your password?]
Not registered yet?

Creating your Launchpad account is easy. Here's what to do:

1. Enter your e-mail address.
2. Launchpad will e-mail you asking you to confirm your address.
3. Follow the confirmation URL in the e-mail and you're done!

E-mail address: l

Register

Done

Note: We will never disclose, share or sell your personal information, nor send you e-mail not directly related to Launchpad

What is Launchpad? | Get help with Launchpad © 2004-2008 Canonical Ltd. | Terms of use

launchpad.net &

11

After you register, you can log on again and return to the home page to search the required information.
You can do this by either asking a fresh question or searching the relevant information within the existing

answers on the Launchpad site.
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Launchpad Technical Answers

To search for an answer in the existing questions, click the Answers icon on the right. This displays the
Questions and answers page. To obtain information about a specific project, such as Ubuntu, you can
select the project name from the Most active projects list. This displays the Question for Ubuntu page
on Launchpad.

Nice to Know

Many applications on Ubuntu provide the Get Help Online menu entry in their Help menu. This
can be used as a shortcut to visit the Technical Answers section in Launchpad.

Figure 9.24. Questions and Answers Page

Fle Edit View History Bookmarks Tools Help

- 10} https:jfanswers.Jaunchpad.net/ ~| [[C~ 2
P! P a
[ Most Visited = g Getting Started [5]Latest Headlines
Launchpad Home Code Bugs Blueprints Translations Answers

Questions and answers

n )
@ All projects © One project: (Choose...)

Launchpad Answers helps you build a community support network and knowledge base for your project.
Encourage new users to ask questions rather than file bugs!

Most active projects Latest questions asked Latest questions solved
<2 Ubuntu @810 login (Open) @Ubuntu country-specific software
1P Launchpad itself posted 1 minute ago by & Glenn in repository servers (Solved)
& Ubuntu Eee _ Ubuntu posted 6 hours ago by & Ankur
i, ©)2.6.24-22 kernel modules 7 (Open) Banerjee, answered by & sawas
posted 10 minutes ago bya Fabian Radevic in Ubuntu
*® inkscape _ Rodriguez in Virtualbox @Export in "SIMPLE" SVG (Solved)
@avg stopped updating. | still have a posted 14 hours ago by & Francis
years licence left (Open) Hemsher, answered by & Francis
posted 13 minutes ago by & Nicholas Hemsher in Inkscape: A Vector
_in "yelp" source package in Ubuntu _ Drawing Tool =
Done answers launchpad.net &

On this page, all answers specific to the Ubuntu project are listed under various categories. You can type
your question in the Search field to search for an answer in the existing questions. Alternatively, you can
click the Ask a question button to display the Ask a question page.
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Figure 9.25. Questions for Ubuntu Page

Questions for UbuntiT = Mozl a Firetox:
Ele Edit wiew History Bookmarks Iools Help
] - & @[] rttpsiranswers launchpad.netjubuntu [~] @ Jle @/

[ Most Visited v @ Getting Started [F]Latest Headlines ~

Languages filter (Change your preferred languages)
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Status
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@ 55027 8.10 login 1minute & Glenn — Open
ago
@ 55025 avg stopped updating. | still 13 minutes & Nicholas velp Open
have a years licence left ago
@ 55024 HUAWEI 169 MODEM USE 25 minutes g Sean — Open
STICK ago
@ 55023 Updates Ubuntu 8.01 27 minutes g Keith Harris yelp Answered
ago
@ 55022 broken system,want to get 34 minutes & aditya — Open
backup of updates and ago
packages of the installed
packages 7ckage?
B 58091 howto inctall tachnamata 24 minskae & firnfox 2.0 Anon
Done

Overview je Bugs Blueprints Translations Answers
Questions for Ubuntu > st all FaQs
> Open
[ ] [by relevancy :] [ Search ] > Answered

> My questions

» Need attention

* Ask a question

> Set answer contact

Answer contacts for
Ubuntu

& Alan Pope

& alessio Treglia
Alexander Kraev

& ali Hatami

& aiusici

& andrew Morris
Andrés

& Amnau Alcazar

& Arun Kolhapur

& athanasios Lefteris
Rhavani Shankar =

answers launchpad.net {5

You can ask a question by selecting your preferred language and then typing the summary of your question
in the Summary field. Clicking Continue displays a list of questions that may be similar to what you asked.

Figure 9.26. Ask a Question Page

problem. We will use it to look for similar questions that may already exist.

Change your preferred languages to modify the list of languages available for writing the question

Language: | English (en)* |

The language in which this question is written, The languages marked with a star (*) are the
languages spoken by at least one answer contact in the community.

summary: |

A one-line summary of the issue or problem.

Done

Fle Edit wiew History Bookmarks Tools Help
- - c @‘ [E]https:lfanswers.Iaunchpadnatlubuntul+addquastmn | '] ['l so0gle
Most Visited ~ g Getting Started [5Latest Headlines ~
ilauncho % ubuntu L B
overview le Bugs Blueprints Translations Answers
Ask a question > List all FAQS
> Open
Please enter a short description (at least 4 words) in the language of your choice, that describes your > Answered

> My questions

> Meed attention

> Ask a question

> Set answer contact

Latest questions

@ [open) 8.10 login
[Open] avg stopped
updating. | still have a
years licence left

@ [open) HUAWE! 169
MODEM USB STICK

@ [Answered] Updates
Ubuntu 8,01

@ [open] broken

system,want to get

backup of updates and
packages of the installed

answers launchpad.net &

If you still do not find the required answer, go ahead and type the description of the problem in the
Description field. You can then click Add to add the question to the main Launchpad database.
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Figure 9.27. Question Page

@ open Question #46451, asked on 2008-09-26 by Scett Price

How do | get Hardy on an AMD64 to recognize
my webcam?

I have an HP USE webcam that came with my AMD-64 dual-core system. It doesn't recognize the cam in
any video rendering programs. I tried MAKEDEV with it plugged in, but nothing still. | also added the
Jasper libs, nothing, and tried that blognux site but no AMD64. Anyone know how | can accomplish this?

Thanks.
& peter b said on 2008-09-26:

in synaptic there is a package called
cheese
just install it; you should be ok.

peter b

Done

> Edit question

> History

> Subscribe

> Link existing bug
> Remove bug link
>This is a FAQ

Ubuntu question #46451
Question from:

& scott Price
Language: Eng|

Assignee:

No assignee
Last query: 2008-09-2
Last reply: 2008-0

Related bugs

B 227940 Nn Arivar for

answers launchpad.net &

(@ 0 7 Sl {0 | get Hard 1BlieiE il Siran S EE)
Fle Edit wiew History Bookmarks Tools Help
& - & &[] httpsiranswers Jaunchpad netjubuntu/+question/46451 [-] E= @)
[5 Most visited ~ g Getting Started [ Latest Headlines
Glaunchio F Ubunt al ]
Overview Bugs Blueprints Translations Answers m

When your question is answered, you will receive an e-mail notification, stating that your question has

been replied to.

Launchpad Bug Tracker: Malone

Malone is a Web-based, collaborative, bug-tracking tool available with Launchpad. It provides you with
a location to report any bugs that you find in Ubuntu and its various applications. It also enables you to

track the bugs during their life, right until they have been resolved.

If you find any problems in Ubuntu and its related applications, you can report it on Launchpad by clicking
the Bugs icon on home page. This displays the Bug tracking page of the Launchpad Web site.

The Bug tracking page displays all the recently reported and recently fixed bugs. Before reporting a new
bug on Launchpad, you must run a search in the existing bug reports to ensure that this bug has not been

reported already.
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Figure 9.28. The Bug Tracking Page
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Bugs in Ubuntu Filters
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Fix Key contacts reported
Triagdagrs
(1) ‘ Driver: Ubuntu Drivers
Tags
[ Bug supervisor: Ubuntu Bugs
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Security contact: Ubuntu Security Team 0.61.08-3buildl 1
onfrmd 0.7 1
o » Bug tracker: Launchpad B D 1
bugs fixed elsewhere e 1
Incomplet * 1495 bugs fixed elsew 1416 1
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« 7684 incomplete bugs can expire };’32” i
» List al! open bugs . 12 1
» Subscribe to bug mail 1310 1
1394 14
1400 1
.
Done bugs.Jaunchpad.net & .

You can report a fresh bug on the Report a bug page, which can be displayed by clicking the Report a
bug button on the Bug tracking page.

Type a small description of the bug in the Summary field, and click Continue to report the bug.

Figure 9.29. Report a Bug Page

Fle Edit View History Bookmarks Tools Help

- - c = [ﬂ] httpsy/bugs launchpad net/ubuntu/+ilebug | '] [‘ 15‘\1

[ Most Visited > g Getting Started [5]Latest Headlines ~

Jlaunch % Ubuntu Q
(&

Overview Bugs EBlueprints Translations Answers

Report a bug

Please describe the bug in a few words, for example, "weather applet crashes on logout":

Summary:

» Advanced reporting options

Most Frequently Reported Bugs
summary
252174 gvfsd-trash crashed with SIGSEGV in g_main_context_dispatch()
224589 system-config-samba.py crashed with SystemError in _init__()
199592 scim-bridge crashed with SIGSEGWY in scim::Module::unload()
199496 Tomboy.exe crashed with SIGSEGY in exit()

[«]

Done bugs launchpad.net &

When you click the Continue button, the bug tracker displays a list containing similar bugs reported earlier
on Launchpad. If you do not find your bug listed here, you can still report the bug as a fresh bug by clicking
the No, I'd like to report a new bug radio button at the bottom of this page. This displays a new section
at the bottom of the page.

345



Ubuntu Help and Support

Figure 9.30. Look for the Reported Bug
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Is the bug you're reporting one of these?

@ /3 #14838 New spatial breaks browsing usablity
Fix Released, last updated 2005-04-01

O @ #105113 desktopshould do free space check on regular updates too
Fix Released, last updated 2008-12-15

O % #300342 please sync package gnomint from debian sid
Fix Released, last Updated 200812-13

New, last updated 2008-10-01

O 3 #26508 Dapper USB Wired Keyboards & USB Wired Mice Freeze at First GUI Login
Invalid, last updated 2005-12-05

P
Done

O % #276846 madom freeze and freeze with drag and drop amd 64 opteron nvidia 7900gto Ubuntu Hardy 8.04.1 64bit

bugs launchpad net & -

You are then required to provide further detailed information about the bug, such as the steps to reproduce
the bug and version information. After providing the required details, you can finally submit the bug report

by clicking the Submit Bug Report button.
Note:

Visit Malone at https://launchpad.net/malone.

Shipit
Shipit is an application you can use to request the delivery of Ubuntu CDs. Although Ubuntu can be freely

downloaded from the Internet, you can also request a free-of-charge mail delivery of the Ubuntu CD. This
is especially useful if you have slow Internet connection, as downloading the OS can take a while. Delivery

may take up to 10 weeks.

The following screenshot displays the Shipit site:

Figure 9.31. The Shipit Page

Requestan UBimt G =M oAl athir et ox:

Ele Edit view History Bookmarks Iools Help

<« - G @ https:Hsh\plt‘ubuntu‘cnm/

Most Visited 4 Getting Started @Latest Headlines

-
<> ubuntu

Get Ubuntu

» What is Ubuntu? Home » Get Ubuntu » Request a Free CD

» Products » Support  ® Community » Partners  » News

Visit the Ubuntu Store
Buy Ubuntu branded
merchandise, DVDs and

world class suppert
learn more »

Not loggec in— Locy In/ Regiister

» Requesta CD
» Rekase Notes
» Countdown

» Mirror Ubunty

Request a CD of Ubuntu
Desktop Edition

» Software Catalogue

» Merchandise

» Case Studies

Check the status of an existing request

© 2008 Canonical Ltd.
Done

v Get Ubuntu H
o Requesting an Ubuntu CD
- el Ubuntu is available free of charge and we can send you a CD of the latest version (8.10

(Intrepid Ibex)) with no extra cost, but the delivery may take up to ten weeks, so you
should consider downloading the CD image if you have a fast Internet connection.

Request a CD of Ubuntu
Server Edition

shipit.ubuntu.com =

(4]
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Note:

Visit Shipit at http://Shipit.ubuntu.com.

The Fridge

The Fridge is an information hub for the Ubuntu community, bringing together news, grassroots marketing,
advocacy, team collaboration and great original content. Just like the family fridge at home, this is where
the Ubuntu family can exhibit its best work for everyone to see, along with the requisite jokes, reminders,
invitations, news clippings and photos.

Note:

Visit The Fridge at http://fridge.ubuntu.com/.

The following is a screenshot of The Fridge home page:

Figure 9.32. The Fridge

Fle Edit View History Bookmarks Iools Help
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[E Most visited v 4§ Getting Started Latest Headlines

b Prciets b Gppor B Community B Paimm Hews

(]
sV bu ﬂtU

The Fridge

News for human beings

Navigation 4000 Attendees at French Team Release Party

» about Thu, 2008-12-11 20113 — nali

Upcoming events Every 6 months, the French Team holds release parties. For Ubuntu 8.10, a release party was held in Paris with
12 install parties throughout France.

Yubuntu Developer Meeting (1
Th release party, organized by ubuntu-party and the French loco team, ubuntu-ir, ook place at the “Cite des

sciences etde |'industrie” in Paris, 29-30 November 2008
4000 people attended the event, which broke the record from last year, almost 3000 visitors!

But an Ubuntu Party is notonly a party where gesks come, eat drink beer and socialize. An Ubuntu Party
consists of various activities, for all knowledge levels.

Popular Content In anutshell, there wers

Todav'e: A b ok i
Done

Paid For Commercial Services

Canonical provides professional support across the globe. You can purchase this support by contacting
the Global Support Services team on the Ubuntu Web site at http://www.ubuntu.com/support/paid.
Professional support services can also be obtained through the network of companies and partners listed
in the Canonical Marketplace.

Professional Support Services from Canonical

Canonical Global Support Services are deployed to enable 24x7 assistance to customers. The Global
Support Services team utilises its vast experience and knowledge base to identify the challenges that
customers may face when installing and maintaining new platforms and applications. From optimising
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your small office set-up to providing guidance on very large deployments, the Global Support Services
team is always ready to help you get the most out of Ubuntu.

Support is provided for desktops, servers and thin client servers, and clusters. The following screenshot
shows the various types of support services offered:

Figure 9.33. The Various Type of Support Page
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Installation support
Get Ubuntu

Getting Ubuntu up and running is fast and easy, but having expert help on-hand to solve your problems
can take your solution o new heights. From optimising your small office set-up to guidance on very large

@ Get Support deployments, our team can help ensure you get the most from Ubuntu, and the world of free software.
Enterprise peace of mind

e

“ # Get Involved Ubuntu provides enterprises with greater security, higher perfformance and more capability for substantially

less money than proprietary altematives. Thus, it is no surprise that an increasing number of IT Managers e
Done

To purchase commercial support, click the contact us link available at the bottom of the Canonical Global
Support Services page. This takes you to the About us page. You can fill the form provided on this page
to request more information about Canonical Global Support Services. Alternatively, you may click the
Purchase Support button present in the left Navigation pane. If you are a company employee, ask your
L.S. team for details of your support options as this will vary from company to company.

Figure 9.34. About Us Page
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Done
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After you purchase the support, you will receive a confirmation e-mail message containing your support
ID number. You will also receive a phone call welcoming you to the service.

The Canonical Marketplace

The Canonical Marketplace lists a number of companies and partners located in various regions of the
world which provide local support for desktops and servers running Ubuntu.

The following screenshot displays the Marketplace page on the Ubuntu Web site:

Figure 9.35. The Canonical Marketplace
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= . Ubuntu Training
e \11 SUPPOﬂ learn morex»

Partner Programme Ubuntu Marketplace

There is a growing network of companies that provide local suppert for deskiops and servers running
Ubuntu. Find a company close 1o you, or get your own company listed in the marketplage.

Software Programme Global Provider
Hardware Programme The premier provider of global support is Ganonical Ltd. To find a local support provider, select your region
Find a Pariner from the list below.

Partner Programme FAQ Local Providers

Please select one of the following regions:

=
=S * Africa
o Get Ubuntu Adrica
b d' s Asia
s Europe
@Gelsunnuﬂ N Wﬂ
Done
Note:
.

To find support and solutions from local providers, visit http://www.ubuntu.com/support/
commercial/marketplace.

Selecting your region from the list provided will lead you to a comprehensive list of all the Local Support
Service providers in that region. The following screenshot displays a list of all the Local Support Services
providers existing in Africa:
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Figure 9.36. Local Support Services Page
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Done
Note:
.

If your company is providing Ubuntu-related services then you too have the option of being listed
in the Canonical Marketplace as a Local Services Provider. To do this simply click the send us
your information link at the bottom of the Marketplace page.

Lesson Summary

In this lesson, you learned:

+ The various sources where you can find both free and paid for support on Ubuntu - system and online
documentation, commercial support, community support, Launchpad and The Fridge.

+ System and Online documentation provide the primary source of help and contains both official and
community documentation.

+ The Ubuntu community also provides vital support through mailing lists, Web forums, IRC channels,
LoCo teams and the Ubuntu Team Wiki.

* You can use Launchpad to perform tasks such as searching Ubuntu related information, tracking bugs
in Ubuntu and placing orders for Ubuntu CDs.

* The Fridge is an information hub for the Ubuntu community, bringing together news, grassroots
marketing, advocacy, team collaboration and great original content.

+ Canonical provides professional support across the globe, which you can purchase by contacting the
Global Support Services team.

* Professional support services can also be obtained through the companies and partners listed in the
Canonical Marketplace.
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Review Exercise

Question: Name the major sources of help and support for Ubuntu.

Answer: The major sources of help and support for Ubuntu are system and online documentation,
commercial support, community support, Launchpad and the Fridge.

Question: What types of documentation is available on the documentation site of Ubuntu?

Answer: Four types of documentations are available on the Ubuntu documentation site. These are the
Ubuntu official documentation, community documentation, common questions and Ubuntu screencasts.

Question: What are the options for obtaining commercial support for Ubuntu?

Answer: The options for obtaining commercial support are either by getting the support directly from
Canonical through their Global Support Services team or through the network of companies and partners
that are listed in the Canonical Marketplace.

Question: What are the different platforms through which the Ubuntu community extends its help and
support?

Answer: The different platforms through which the Ubuntu community extends its help and support are:
* Mailing lists

* Web forums

* IRC channels

* LoCo teams

* The Ubuntu wiki

Question: What are IRC channels?

Answer: IRC channels are a form of real-time Internet chat that allows users to talk directly to one
another.

Question: What help and support do the LoCo teams provide to Ubuntu users?

Answer: The LoCo teams are primarily involved in providing free local support, such as one-on-one
troubleshooting, group sessions and presentations about Ubuntu. Simultaneously, these teams are actively
engaged in providing non-English support to the Ubuntu users.

Question: What is Launchpad?

Answer: Launchpad is a Web-based suite that helps people develop free and open source software. It
is a collaborative system developed by Canonical and is primarily used to track many aspects of open
source development.

Question: What is the name of the bug-tracking tool available with Launchpad?

Answer: Malone is the bug-tracking tool available with Launchpad.
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Chapter 10. Partitioning and Booting

Note:

Partitioning and Booting is an additional section and not an integral part of the desktop course.
Many users, especially corporate desktop users who have system administrators to set up their
computers for them will find this section irrelevant. Home users, or advanced Ubuntu users may
find this extremely useful.

Objectives

In this lesson, you will learn:
 The benefits of partitioning
* How to create partitions

* How to configure start-up options

What is Partitioning

Analogy Time. Simply broken down, a new hard disk is similar to the foundations of a house - it needs

some structure and walls before you can start putting things (like furniture) into it. The partition is the first
level of foundation on the disk. Once the disk is logically carved up into partitions, it can be thought of as a
house with rooms. Each partition (room) is of a specific size which could potentially be resized again after
you move it, but would cause some disruption as objects get moved to make room. Once a partition (room)
is created it can then be formatted using the filesystem of your choice. Once the filesystem has been laid
down, it's possible to start populating the partition with data in the form of files and folders (furniture).

So, a partition is a logical chunk of space allocated out of the entire disk. Depending on how a system
is configured at installation time, there may be one or more partitions on a disk. In some instances, it is
also possible to modify the layout, number and size of partitions, but this is often considered an expert's
function.

Many Microsoft Windows users will have just one large partition - often known as "C: drive", however it is
also common for Microsoft Windows users to have multiple partitions which are labelled with successive
alphabetic characters (D:, E: and so on).

Similarly, with Ubuntu it's possible to install the system in exactly one partition on the disk, or spread data
and applications over multiple partitions.

Figure 10.1. Partitioning

Disk

Two partitions

There are valid arguments for both scenarios. Having one single partition with all applications, libraries
and data will result in a simple to manage system. It also provides flexibility as installing applications or
adding data will use space from a common "pool".
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Note:

If you accept all the defaults when installing Ubuntu, you will end up with a system separated
into two partitions on the disk. One contains all files, the other is known as "swap" which can be
thought of as an extension to your computer's internal memory.

Alternatively, it is possible to create multiple partitions of differing sizes into which different types of
applications, libraries and data can be placed. This is often used in a multi-user or server environment
where user data is kept separate from system programmes, log files and configuration files. A significant
benefit to this can be seen when there is a problem on the system and log files start to grow. The log files
(in one partition) will not consume all available disk space in this scenario because they will be confined
to their own (small) partition of the physical disk.

Which ever partitioning scheme has been chosen, this is not set in stone. It is possible to use a partition
editing utility to resize partitions (subject to sufficient free space in each partition), however this is quite
an advanced topic, and generally nto done while the system is in use.

Note:

Whilst it is possible to change the disk partitioning layout after the system has been installed, it
is important to make backups before making any changes to the partitions.

About filesystems. Partitioning a disk is only the beginning. Once the disk has been divided up, those
partitions need to be formatted so that the operating system can place files on the disk in a structured
manner. There are many different filesystem types, each with their own advantages. With Microsoft
Windows the two main filesystems are FAT (File Allocation Table) and NTFS (New Technology File
System). With Ubuntu there are many options including ext2, ext3, reiserfs, xfs and many others. The
Ubuntu installer chooses ext3 by default, but of course it is possible to override this.

Nice to Know:

ext3 is a great general purpose journalling filesystem. It handles most tasks well however, xfs
is sometimes chosen instead on media-centre systems as it performs better when handling very
large files - such as music and video files.

Mount points. A mount point is a place in the directory hierarchy where a filesystem could be presented.
There is no real Microsoft Windows equivalent to this. With Microsoft Windows the partitions C:, D: and
S0 on, are seen as entirely separate entities so the operating system, applications and data is often referred
to by a user as being "on the C: drive" or "in a folder on the D: drive".

Nice to Know:

"Mount" is the term used when referring to a filesystem being made available for access. CD
and DVDs are usually automatically mounted when they are inserted. The same goes for USB
connected devices such as memory sticks, hard disks and music players.

On Ubuntuy, files and folders reside within a partition as they do with Microsoft Windows. However the
partition is not normally referenced directly by the user. The user would typically say that files are "in my
home directory" (when referring to /home/< username>), or "in the root directory" (when referring to / )
without specifying which partition on the disk those directories reside in.

Under most standard installations of Ubuntu there will be only one partition where all files and folders
reside. However if a user plugs in an external USB-connected memory stick or USB hard disk, Ubuntu will
mount the partition(s) on that device under mount point(s) within the directory tree. For example a USB
attached memory stick or hard disk will usually appear under /media/disk (unless the device has partitions
which are labelled, in which case they will appear under /media/<labelname> )
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Further considerations. As previously mentioned, resizing partitions is not a trivial task. Under most
circumstances it requires that all filesystems involved are unmounted, this means they must not be in use.

Typically then to resize partitions the system should be booted to an unused filesystem - such as a bootable
Live CD. Considerable thought should therefor be given before partitioning a disk with regards to the

number and sizes of partitions to be created to prevent later unnecessary resizing.

Caution:

You may run out of hard drive space in your home partition due to the sub-division of the drive
into fixed-size partitions. This may occur even if the other partitions have plenty of usable space.
Good and logical partitioning requires you to predict how much space each partition needs.

For new users, home users and other single-user set-ups, a single root (/) partition with a swap partition

would be the easiest and the most convenient to create and use. However, for multi-user systems or

computers with lots of disk space, it is best to have the /home, /tmp, /usr and /var directories as individual
partitions separate from the root (/) partition.

Before partitioning your hard drive, you should consider the following:

« root: Also called the slash directory, it is the highest directory of the directory tree. When creating the
root partition, you need to ensure that the root should contain the /etc, /bin, /sbin, /lib and /dev directories,
otherwise you will not be able to boot-up the system. You also need to ensure that the root partition is
allocated at least 150-250 MB of disk space.

/home: This directory contains all user-specific files and data. On a multi-user system, every user will
store personal data in a sub-directory of this directory. The size of this directory would depend on the
number of users using the system and the files they store in this directory. Ideally, you should plan the
disk space for this partition based on your planned usage. In general, about 100-MB disk space can be
allocated for each user. However, you may need to reserve a lot more space if you are planning to save
a lot of multi-media files in your home directory.

Nice to Know:

It is good practice to have /home on a separate partition because it allows for a smoother transition
from one distribution to another.

/var: This directory contains variable data, such as news chapters, e-mails, Web sites, databases and the
packaging system cache. The size of this directory also depends on system usage. Most probably, the
size of this directory would be dictated by your usage of the Ubuntu package management utilities. If
you plan to install all the packages that Ubuntu offers, you need to allocate 2 to 3 GB of space for the /
var directory. However, if you want to save hard disk space and do not plan any major software updates,
you can get by with as little as 30- or 40-MB disk space for the /var directory.

/tmp: This directory contains temporary data created by programmes. Some applications, including
archive manipulators, CD/DVD authoring tools and multi-media software also use this directory to
temporarily store image files. You need to plan space allocation for this directory based on your usage
of these applications. for this directory.

/usr: This directory contains all user programmes (binaries), their documentation and supporting
libraries. This directory tends to use the maximum space on the hard disk. Therefore, you should provide
at least 500-MB disk space for this directory. But, you need to increase this space depending on the
number and types of software packages you plan to install. Based on your planned usage and the
available disk space, you may allocate 1.5 to 6 GB of disk space for this directory.
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Nice to Know:

The /usr partition is sometimes referred to as User System Resources and not user as was
originally intended.

Creating a Partition

As mentioned earlier, multiple partitions are very useful especially in cases where a partition is corrupted,
as it enables you to boot into GNU/Linux to fix the system, without having to reinstall the system. To do
this, a root partition is required. This partition should contain the essential components of the system.

Caution:

The hard disk drive that you are formatting should not contain any data. If you have already
formatted the drive and it contains data, skip the partitioning step and move to the next step -
mounting.

If the hard disk drive that you want to format is blank and unformatted, you can use either of the following
tools to partition it:

+ Partition Editor (GParted): GParted is useful for creating space for new operating systems, re-organising
disk usage, copying data residing on hard disks and mirroring one partition with another (disk imaging).

* Command Line: The command line is faster and more powerful than GParted. When navigating through
the file system, you can use the command line to jump from one directory to another in a split second.

Use the command-line interface if you are comfortable using the Terminal.

If you want to create a partition using GParted, you need to first install GParted by using Add/Remove
Applications or Synaptic Package Manager.

Installing GParted by Using Synaptic Package Manager

Procedure 10.1. To install GParted by using Synaptic Package Manager:

1.  On the System menu, point to Administration and then click Synaptic Package Manager. The
Synaptic Package Manager window opens.
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Figure 10.2. Synaptic Package Manager Location
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When the Synaptic Package Manager window opens for the first time, it displays a list of all
the software packages available in the Ubuntu software repositories. The left pane lists the various
software categories. You can select a specific category to view the available software packages listed
in that category. Alternatively, you can use the Search functionality provided in the Synaptic Package
Manager to locate specific software in the list.

Click the Search button to search the package you want to install. The Find dialogue box appears.

In the Search field of the Find dialogue box, type the name of the package, Partition Editor, and
click the Search button. The package, gparted, is now displayed in the right pane of the Synaptic
Package Manager window.

Right-click the package name to select an action that you want to perform on it. Notice that various
options are available to perform a number of actions on the selected package. If the selected package
is not installed currently, you can mark it for installation. If the selected package is already marked
for installation, you can unmark it to clear the selection. Similarly, if the package is already installed,
you may select Upgrade to upgrade the package and Mark for Removal or Mark for Complete
Removal to delete the package from your computer.

To install the package, select the Mark for Installation check box.

The gparted package is now selected for installation. To continue with the installation, click Apply.
This displays the Summary dialogue box.

The Summary dialogue box prompts you to perform a final check before implementing the marked
changes. Click the Apply button to apply the marked changes. The Downloading package files
window opens.

Wait for all the required files to download. After all the required files in the package are downloaded,
the Changes applied dialogue box appears.
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The Changes applied dialogue box notifies you that all the requested changes have been applied.
Click Close to exit the dialogue box.

Figure 10.3. Synaptic Package Manager
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In the Search field of the Find dialogue box, type the name of the package, Partition Editor, and
click the Search button. The package, gparted, is now displayed in the right pane of the Synaptic
Package Manager window.

Figure 10.4. Finding a Package in Synaptic
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Right-click the package name to select an action that you want to perform on it. Notice that various
options are available to perform a number of actions on the selected package. If the selected package
is not installed currently, you can mark it for installation. If the selected package is already marked
for installation, you can unmark it to clear the selection. Similarly, if the package is already installed,
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you may select Upgrade to upgrade the package and Mark for Removal or Mark for Complete
Removal to delete the package from your computer.

To install the package, select the Mark for Installation check box.

Figure 10.5. Marking a Package for installation
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The gparted package is now selected for installation. To continue with the installation, click Apply.
This displays the Summary dialogue box.

Figure 10.6. Summary Dialog Box
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The Summary dialogue box prompts you to perform a final check before implementing the marked
changes. Click the Apply button to apply the marked changes. The Downloading package files
window opens.
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9.

Figure 10.7. Applying Changes Box
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Wait for all the required files to download. After all the required files in the package are downloaded,
the Changes applied dialogue box appears.

Figure 10.8. Changes Applied Box
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The Changes applied dialogue box notifies you that all the requested changes have been applied.
Click Close to exit the dialogue box.

Figure 10.9. Synaptic Package Manager after Installation
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The partition editor is installed on your computer. You can now partition the hard disk drive.
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Figure 10.10. Opening Partition Editor
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Partitioning Using Gparted

Procedure 10.2. To partition the hard drive by using GParted:

1. On the System menu, point to Administration and then click Partition Editor. The GParted
window opens.

Nice to Know:

GParted is also available from the Live CD.
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Figure 10.11. GParted Window
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In the top-right corner of the GParted window is the drive drop-down box. You can use this box to
select the hard drive that you need to partition by specifying the logical name you noted earlier. The
Gparted window refreshes and shows you a representation of the selected drive.

If the existing partitions on the drive have not yet been used, a white bar would run across the window.
However, if the existing partitions contain some data, the data will be represented by a pale yellow
area.

Instructor Notes:

Explain how to read the specifications of the current partitions and file systems.

You can either resize an existing partition or create a new partition in the unallocated space of the
hard drive. Before resizing an existing partition, you must make sure that you unmount it by right-
clicking the partition and then selecting Unmount. Remember that you cannot resize a partition to
be smaller than the yellow area, which represents the data on the partition.

To create a new partition in the unallocated drive space, right-click the area and select New on the
short-cut menu. The Create new Partition dialogue box appears.

The Create new Partition dialogue box enables you to select specifications for the new partition.
Apart from defining the size of the new partition, you can also select the partition type, whether
primary or logical, for the new partition. In addition, you can even define the file system to be used
on the new partition. By default, Ubuntu uses the ext3 partitions. However, if you want the new drive
to be readable by both Microsoft Windows and Ubuntu without installing anything extra, you can
format it as Fat 32.
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Figure 10.12. Creating a New Partition
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You can either resize an existing partition or create a new partition in the unallocated space of the
hard drive. Before resizing an existing partition, you must make sure that you unmount it by right-
clicking the partition and then selecting Unmount. Remember that you cannot resize a partition to
be smaller than the yellow area, which represents the data on the partition.

To create a new partition in the unallocated drive space, right-click the area and select New on the
short-cut menu. The Create new Partition dialogue box appears.

Figure 10.13. Create New Partition Box
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The Create new Partition dialogue box allows you to select specifications for the new partition.
Apart from defining the size of the new partition, you can also select the partition type, whether
primary or logical, for the new partition. In addition, you can even define the file system to be used
on the new partition. By default, Ubuntu uses the ext3 partitions. However, if you want the new drive
to be readable by both Microsoft Windows and Ubuntu without installing anything extra, you can
format it as Fat 32.

Note:

If you are creating a partition on a new hard drive, select Primary Partition. An SCSI or S-
ATA hard disk can have a maximum of 4 primary partitions and 11 logical partitions while an
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integrated development environment (IDE) hard drive can have up to 63 partitions overall.
The primary partition used to house the logical partitions is called an extended partition.
Unlike primary partitions, logical partitions must be contiguous: the blocks in the partition
are following each other without any gap.

Figure 10.14. Confirmation Box
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5. Inthe New Size (MiB) field, specify the size of the partition by using the up or down arrow key. You
can also define the size by dragging the black bold arrows on the top white bar.

6. Select Primary, Logical or Extended partition from the Create as drop-down list.
7. Next, specify the file system by selecting from the Filesystem drop-down list.

8. Click the Add button to complete the partition. The white bar updates to show a new partition on
the disk.

9.  You can create multiple partitions at this stage by following the above-mentioned procedure and then
clicking Apply to add them to the hard drive. The Apply operations to hard disk dialogue box
appears.

Figure 10.15. Applying Pending Operations Box
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10. The Apply operations to hard disk dialogue box recommends that you back up data before
performing the changes and seeks your final confirmation before applying the changes to the hard
disk. Click the Apply button to partition and format the hard disk according to your specifications.

363



Partitioning and Booting

Figure 10.16. GParted with New Partition
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11. The system starts applying the changes to the hard disk. The duration of the operation will depend on
the size of the new partition. You can click the Details button to view more information about where
and how changes are being made, whilst the operation is running.

Figure 10.17. Deleting a Partition
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12. Once you receive a message that all the specified operations have been successfully completed, you
can safely close the window by clicking the Clese button. However, if something goes wrong and
the process does not complete successfully, you can save the process output for future reference by
clicking the Save Details button.

13. The newly created partition is now visible in the GParted window. You will also notice that your
system automounts the newly created partition.
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Mounting refers to the process of attaching the newly created partition or drive to an existing directory
to make it accessible. The directory where the new partition is attached is called the mount point.
After the partition is mounted, you can access the files on that partition by accessing the mount point
for the new partition. Early Linux distributions did not allow the auto-mounting of new partitions or
drives. However, from Ubuntu 8.04 LTS, you can easily access the new partitions by auto-mounting
the partitions. When you create a new partition, the new partition opens as a separate window and the
partition appears as a disk icon on the desktop.

Figure 10.18. Removable Drives and Media Preferences Dialogue Box
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14. When you no longer want to access the new partitions, you can unmount them by right-clicking the
disk icon on the desktop and selecting the Unmount Velume option from the short-cut menu.

Figure 10.19. RC.Local File
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Boot-up Options

Booting up is a process through which the operating system is loaded into the computer's main memory or
random access memory (RAM). The boot-up process starts when you turn on your computer. During this
process, the BIOS takes control of your computer and decides where to look for software on the computer
and in which order. Your computer's BIOS settings determine whether your computer will first check the
hard disk or a floppy disc, CD, DVD or flash memory to start the booting-up process. If you have multiple
operating systems installed on your computer, the BIOS configuration determines which operating system
will be loaded first at boot-up.

Only after all system files have been loaded into the main memory, is the operating system given control
of the computer. The operating system performs the requested initial commands and then waits for the
first interactive user input.

However, as a superuser or user with administrative privileges, it is possible for you to change the boot-
up configuration to define the computer's boot order, change the default operating system to boot-up or
make a system command run automatically at boot-up.

One way to change or check your BIOS setting is to restart your computer, and press a key to enter the
setup function before it starts to load any operating system. Generally, you can do this by pressing F1, F2,
ESC or DELETE. Once you are inside the BIOS setup, you can make the desired changes by following
the instructions for using the setup. However, you need to be very cautious when making any changes in
the BIOS settings because a wrong setting can prevent your computer from booting-up properly.

You can also perform these configuration changes by using a command line on your computer's terminal.

Running a System Command Automatically at Start-Up

At times, you may wish to add a custom command for the start-up process so that your computer executes
this command every time it boots up.

Procedure 10.3. To run a system command automatically at start-up:
1. On the Terminal, type the following command to open the rc.local file:

$ sudo nano
/etc/rc.local

Figure 10.20. Terminal Window
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The rc.local file contains a script that is executed after all the other initial scripts. You can insert your

own initialisation scripts in this file if you want some services to be executed automatically during
the start-up process.

The rc.]ocal file opens in the Terminal window. Type the command that you want to run at system
start-up before the line, exit 0.

$ date >
/home/oem/newbackup

Figure 10.21. Making Settings for rc.local File
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After you enter the command you want executed at system start-up, press CTRL+X to save and exit
the edited file.
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Figure 10.22. Services Window
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4. When you reboot the system, the rc.local file executes. If you want to display the output of the above
command, type the following command in the Terminal:

$ cat newbackup

The following image shows the output of the above command:

Changing the Default Operating System at Boot

When multiple operating systems are installed on a computer, this is referred to as a multi-boot
configuration. Typically, the operating system that is listed on top in the configuration file is loaded on
the computer. To choose the operating system that starts when you turn on your computer, edit the grub
configuration file.

1. Back up the configuration file, and open it in a text editor, as follows:

$ sudo cp
/boot/grub/menu.1lst /boot/grub/menu.lst_backup $ sudo
gedit /boot/grub/menu.lst

2. Find the line written below to change the default sequence:
default ©
Replace this line with the following line:
default X

Replace X with a number based on the order in which your operating systems appear in the
configuration file. You should start counting from 0. For example, if you wish the default operating
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system to be the first in the list, replace X with 0; and if you wish the default operating system to be
the second in the list, replace X with 1.

3. Point to saved and save default to reboot the last OS chosen.

Configuring Start-Up Services

When Ubuntu starts up, many services are started for your convenience. Some services are mandatory for
Ubuntu to work properly on your computer. Others are services that you'll probably never need, either
because you just do not want them (for example, ntpdate, which sets your system time from a time server)
or you simply don't have the device (for example, the HP printing and scanning system, which is of no
use if you don't own an HP device).

Although these services are harmless, they increase your computer's start-up time. By de-activating some
of these services, you should get a slightly faster start-up time.

Caution:

Read the service information before you disable any service because disabling some services may
stop your system from booting-up or running properly.

To configure the start-up services, you need to have administrative privileges. Then, perform the following
steps:

1. On the System menu, point to Administration and then click Services.
2.  Type your administrative password. The Services settings window opens.

3. Select the services you want running by selecting or clearing the respective check boxes and click OK.

Figure 10.23. Services Settings Window
o SErvice= Seting B

Select the services that you wish to activate:
/1 Actions scheduler (anacron)
ci] b '\ Executes scheduled actions

@ .@ Actions scheduler (atd)

7} Executes scheduled actions

\

O Audio settings management (alsa-
-

@ Automated crash reports support
9 Bluetooth device management (b.h_
@ Braille display management (britty

@ i ) Computer activity logger (klogd)

Keeps a log of your computer activity

i Computer activity logger (sysklog
—" i| Keeps a log of your computer activity

/)3; CPU Frequency manager (powernc

(]

Instructor Notes:

If you want greater control over the boot-up services, install Boot-up Manager (bum). You
can install bum from the Universe repository. You need to click the System menu, point to
Administration and click Boot-up Manager.
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Lesson Summary

In this lesson, you learned that:

Partitioning your hard disk is similar to splitting rooms with walls in a house.
You can run Ubuntu on a single or multiple partitions or drives.

Before partitioning the hard drive, you should make sure that there is no data on the hard drive. If the
hard drive on which you are creating a partition contains data and you wish to preserve it, it will be safer
to back up the data before proceeding.

You can create a partition by using both the partition editor and the command-line interface.

It is possible for you to change the boot-up configuration to define the computer's boot order, change
the default operating system to boot or make a system command run automatically at boot-up.

To run a set of commands each time the system boots up, you need to include the commands in the /etc/
rc.local file so that the computer executes them automatically at every boot-up.

You can change the default operating system at boot by making changes in the configuration file.

You must read the service information before disabling any service because disabling some services
may stop your system from booting-up or running properly.

Review EXxercise

Question: What are the advantages of partitioning?

Answer: The following are the advantages of partitioning:

Minimises data loss
Enhances security

Enhances performance

Question: Why do you need to use the sudo command?

Answer: In Unix-based operating systems, you need to use the sudo command to run programmes that
require administrative privileges.

Question: Which of these file systems does Ubuntu use by default?

Fat 32

NTFS

Ext3

Answer: c) Ext3

Question: If you want to run a system command automatically at start-up, where should you add the
command?

Answer: The command needs to be added to the /etc/rc.local file.

370



Partitioning and Booting

Question: Is it possible to disable all the start-up services? Why?

Answer: No, it is not possible to disable all start-up services because disabling some services will stop
your system from booting-up or running properly.

Lab Exercise

Exercise 1. As a previous Microsoft Windows user, you want to have a dual-boot configuration on your
computer and create a separate partition to run Microsoft Windows on it. To perform this task, you need
to create a 5-GB primary partition and format it with a Microsoft Windows-compatible file system.

Procedure 10.4. Option a: To create a Partition using Partition Editor:

1.

2.

On the System menu, point to Administration and then click Partition Editor.

In the drive drop-down box, select the hard drive you need to partition by specifying its logical name.
The window refreshes and shows you a representation of the drive.

Right-click the white bar and click New to create a new partition. The Create new Partition dialogue
box appears, in which you choose the specifications of the new partition.

In the New Size dialogue box, select the size of the new partition.

In the Create as box, select Primary Partition.

Next, specify the file system. Select ntfs.

Click Add to compute the partition. The graphical display updates to show a new partition on the disk.

If you are sure about the specification of the new partition, click Apply. The disk will be partitioned
and formatted.
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